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Overview

1  Overview

GENIUS TOOLS Starter is used to start locally installed applications (for example Creo

Parameteric) using a centrally managed configuration. All required data is synchronized

from a central storage location (Caddepot) to the local computer (Cadpool).

1.1  GENIUS TOOLS Starter philosophy

GENIUS TOOLS Starter lets you manage centrally configured operating environments.

Typically, a company uses one productive operating environment. This operating

environment can be synchronized to all application computers using GENIUS TOOLS

Starter. GENIUS TOOLS Starter also works with multiple operating environments, so that

test environments or environments with customer-specific configurations can be

configured with little effort.

An operating environment can contain any number of projects.

The Startup TOOLS software package includes pre-defined projects for a number of Creo

versions that can be adapted or extended as required by each company. GENIUS TOOLS

Starter also works with publicly available configurations for Creo.

Using synchronization between the administration computer and a number of client

computers, you can manage large and complex installations, distribute central

configuration settings to each Creo workstation and also distribute the required data.

Changes to the configuration are made centrally on the administration computer and are

automatically made available to all users. Different configuration settings can be defined

for user groups, computer groups or units. The software offers global administration

capabilities for heterogeneous IT landscapes and user-specific adaptation options.

1.2  Advantages

– project-oriented workflow

– support for different operating environments

– easy handling through graphical configuration interface for the Creo setup

– central configuration for distributed application computers

– database-driven management of Creo configuration settings

– licensing with FlexLM, fail-safe mode and license borrowing supported

– organization of resources into user groups, computer groups and units
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– role-based permission concept

– Windchill integration

– Creo configuration file management

– blocking or granting of access to projects based on project access groups

– support for multiple languages

– license management

– synchronization based on a configurable interval

– fastest possible Creo Parameteric startup, as all data is stored locally

– easy offline work using license borrowing

1.3  Component modules

GENIUS TOOLS Starter provides user-friendly graphical interfaces for managing the Creo

installation. It consists of three components with separate UIs:

– GENIUS TOOLS Environment Administrator for managing operating environments

– GENIUS TOOLS Project Configurator for configuring projects within an operating

environment

– GENIUS TOOLS Starter App for starting the configured projects

GENIUS TOOLS Environment Administrator
GENIUS TOOLS Environment Administrator provides functionality for managing operating

environments. Use GENIUS TOOLS Environment Administrator to

– create new operating environments

– change properties of an operating environment

– update GENIUS TOOLS Starter and GENIUS TOOLS for Creo in an operating

environment

– configure license servers and synchronization settings

GENIUS TOOLS Environment Administrator is a stand-alone administrative tool. The

executable file gtsa.exe is located in the Installdepot directory.

GENIUS TOOLS Project Configurator
GENIUS TOOLS Project Configurator provides functionality for configuring different Creo

projects with only a few mouse clicks. Projects are provided to the end users for starting

an application using specific configuration settings. Use GENIUS TOOLS Project

Configurator to
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– define adaptable configuration settings for homogeneous or heterogeneous Creo

landscapes

– define group-specific settings

– manage different projects

GENIUS TOOLS Project Configurator is started from the user menu of GENIUS TOOLS

Starter App. The administrator can bar users from accessing Project Configurator.

GENIUS TOOLS Starter App
The configured projects are listed in GENIUS TOOLS Starter App for the users to select and

start. The user interface also displays additional information, e.g., available Creo licenses,

working directory and error messages.

GENIUS TOOLS Starter App is a stand-alone tool. The executable file gts.exe is located in

the Caddepot directory under Software.

1.4  License-dependent features

Starting with GENIUS TOOLS Starter 6.0.1, the product functionality depends on the type

of license you are using. From the year 2020 onwards, GENIUS TOOLS Starter is only sold

with subscription licenses.

The following functions are available with a subscription license for GENIUS TOOLS Starter.

Release Subscription

function / module

Description

6.0.1.0 Dynamic access to

Windows user

management with

LDAP/Active

Directory

(lightweight

directory access

protocol)

Creates access to Windows user management and

enables live queries so that user assignment is always

up-to-date. Users thus do not have to be created and

maintained manually.

ð Less maintenance work

6.0.1.0 Configuring units Adds a group element (“unit”) that can easily reflect

complex configurations such as for company sites and

units. 

ð Easier configuration for companies with many sites

and/ or units 
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Release Subscription

function / module

Description

ð Allows for a reduction of projects 

6.0.1.0 Access to directory

“users” 

Adds a group element (“users”) that can easily reflect

complex configurations for many users.

ð Less maintenance work

7.0.0.0 Selecting Creo

startkey when

starting a project

Provides a project with a choice from several Creo

startkeys (start command that opens Creo with a

defined license package). Users can start a project with

a default startkey or select another one when opening

a project in GENIUS TOOLS Starter App. 

ð Allows the reduction of projects 

7.0.0.0 Apps projects Creates projects that run on any other program.

Assigning a project directory and batch files is possible.

ð GENIUS TOOLS Starter App can be made the central

access point for users.

7.0.1.0 Operating

satellites in

GENIUS TOOLS

Starter Service

Enables the connection of satellite servers to a main

server and their automatic synchronization.

ð Faster connection of user computers to a

synchronized satellite server

ð Reducing queries from network to main server

7.0.1.0 Edit and compare

config.pro blocks

Release-dependent config.pro editor and graphic

comparison tool 

ð Quick overview, comparison and editing of project-

related config.pro blocks (config_*.pro files)

7.0.2.0 Company-specific

project collections 

Start projects can be put together in defined project

groups by the administrator. 

ð In many projects, these can be structured according

to your own requirements.  
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Release Subscription

function / module

Description

8.0.0.0 Selectable project

options

Projects can be started with multiple, individually

defined config.pro blocks, e. g.for license extensions or

additional programs.

8.0.1.0 Reproducing

organization

structure with

units and subunits

Subordinate units (subunits) can be created to provide

additional configuration levels for project settings.

ð Better mapping for locations, subunits etc. and the

resulting complex project configurations

ð Allows for further reduction of projects

8.0.1.0 Combined project

options

Users can select a project option in GENIUS TOOLS

Starter App, which activates multiple configuration

options which are located in different directories and

configuration levels, e. g. for license extensions and

add-on applications.

ð Number of projects can be minimized

8.0.2.0 Edit config.pro

files in GENIUS

TOOLS Config

Editor

Creo configuration options can be edited faster with

auto-completion and color coding.

ð Easier comparison and editing of configuration

options, also in batch mode.

9.0.0.0 Auto projects Settings for auto projects (e. g. Keyshot) can be

specified for the configuration levels standard, unit,

project and user. 

ð Company-specific configurations possible

9.0.0.0 Create and

migrate Creo

Elements/Direct

Modeling projects 

For Creo Elements/Direct Modeling projects, settings

can be specified for the configuration levels standard,

unit, project and user, and project settings and data

packages can be added or migrated.

ð Projects for an additional application
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User can see whether projects include subscription functions  by consulting data base

mode in the footer of GENIUS TOOLS Starter App.

Warning: If you are using mixed licenses (perpetual and subscription) and configure

functionality that is limited to subscription licenses, the projects in GENIUS TOOLS

Starter App will no longer start if there is no subscription license available.

For information on managing PTC license packages, please refer to Assigning Creo

licenses to projects.

Falsely activating a subscription function
When activating a subscription function, a backup copy of the configuration database

sut.db is created. Use this backup copy, if you want to undo an activation of any of the

above functions so you can work again with permanent licenses.

Procedure: 

1. On the installation computer, go to the backup directory: ..

\caddepot\<operatingenvironmentname>\configuration\database\BackupBeforeUpgra

de  

2. Copy the backup file sut.db from the BackupBeforeUpgrade folder.

3. Paste this file into the database directory.

1.5  GENIUS TOOLS Starter: part of Startup TOOLS

With version 6.0, GENIUS TOOLS Starter has become a stand-alone application within the

product package GENIUS TOOLS Startup TOOLS.
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2  System architecture and terms

2.1  Important terms

The administration computer is a computer on which the administrative user has full

write access to the Caddepot directory in order to manage all data on the file system level.

It is the work station where

– GENIUS TOOLS Environment Administrator is used

– GENIUS TOOLS Project Configurator is used

– the configured projects can be run

Caddepot is a subdirectory of the installation directory. It is the source for the

synchronization of the local work environments on the application computers, that is, the

source for the local Cadpool directories.

The Caddepot directory is shared to be accessible for distributed work.

All work environments that are used locally, via network shares or via synchronization are

managed in the Caddepot.

An operating environment is a directory that contains all the data required for working

with the desktop application. This includes configuration data, libraries, templates and

additional applications. The operating environment also contains a database with all

configured projects. An operating environment can contain an arbitrary number of

projects.

If you work locally, the directory you use for your operating environment is the Caddepot.

If you work across a network, the directory for the operating environment is the Caddepot

on the administration computer and the Cadpool on the application computers.

The operating environments contains the software GENIUS TOOLS Starter App (GTS.exe) in

a defined version.

A project is a collection of application properties such as project directory, data directory

and license. Projects allow users to start an application with a specific set of configuration

settings. A project combines locally available data with a centrally managed configuration

settings.

Projects are opened by the users via GENIUS TOOLS Starter App, and edited by the

administrator using GENIUS TOOLS Project Configurator. Each project is saved in a work

environment under cadpool > configuration > projects, e.g., project_creo6p_en.

When a project is started, the configuration settings in the standard directory as well as in

the directories for the unit and for the user are considered.
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The central configuration file in Creo is the config.pro file. This file contains all user

configuration settings. 

By using GENIUS TOOLS Starter configuration options are defined in various separate

configuration files that are then assembled into a single config.pro file that is read by

Creo. The separate configuration files in GENIUS TOOLS Starter are called config.pro

blocks, for example, config_sut_de_c5p_mapkeys.pro or config_sut_de_c6p_dir_file.pro.

2.2  Workflow and synchronization

Standard workflow: Working locally with synchronization
With GENIUS TOOLS Starter, Creo users typically have all the data they need locally on

their workstation. This ensures the fastest possible data access and makes it possible to

work offline.

If the data is copied to the local workstation, it has to be kept up-to-date with data

synchronization. The local data is kept in the operating environment in the Cadpool

directory, which is synchronized with the Caddepot directory, meaning that the data is

copied from Caddepot to Cadpool at a configurable interval.

Data synchronization means that local configuration changes will be overwritten. Changes

to the operating environment, for example entries in a configuration file, have to be

copied manually to the Caddepot. Synchronization has to be paused during the time in

which changes are made. To pause synchronization, open GENIUS TOOLS Project

Configurator and select Pause synchronization from the user menu .

Please note: For data synchronization to work, the users need to have access to the

Caddepot directory. It is recommended to only grant read access if you do not want

users to change settings by themselves.

The setup for working locally with synchronization is created by GENIUS TOOLS Starter by

default. If you start the GTS.exe, it will open from the local Cadpool directory, or create the

Cadpool directory if it does not exist (initial synchronization).

Network mode: Working without synchronization
You can work locally with the data in the Caddepot and without synchronization within a

computer network. To do so, the standard behavior of GENIUS TOOLS Starter has to be

changed and set to network mode, meaning that the GTS.exe will be started in the

Caddepot directory.

To set access rights for network mode, open GENIUS TOOLS Project Configurator and set

Access rights > Function access > Select group > Function access > Prevent switch to local

installation: Yes.
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Way of synchronization from Caddepot to Cadpool in GENIUS TOOLS Starter.

2.3  Operating environments

You can manage any number of operating environments with GENIUS TOOLS Starter. This

means that you can have both a test and a production environment installed and manage

environments for different clients.

Each operating environment contains a set of projects, the required data and the GENIUS

TOOLS Starter software. Each operating environment is fully independent of the others.

The directory for the operating environment contains configuration data, libraries and

templates, additional applications as well as the database for project-specific

configuration settings.

Data in an operating environment cannot be changed by setup programs. Changes to an

operating environment and software updates are managed using GENIUS TOOLS
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Environment Administrator. This gives the IT administrator better control over which data

is actually being changed or updated in an operating environment, e.g., GENIUS TOOLS

Starter software, GENIUS TOOLS for Creo, configuration files, or standard parts.

2.4  Directory structure

With version 9.0.0. projects can, in addition to Creo Parametric, also be created with Creo

Elements/Direct Modeling. In order to be able to include data for other CAD systems in

the future, the entire directory structure has been changed. 

Warning: Due to these new features in GENIUS TOOLS Starter, the directory structure

and the software are no longer backward compatible, which means that after updating

an operating environment to version 9.0.0.0 or newer, it is no longer possible to revert

to an older version. Read the chapter Important information in the News document

before updating.

System directories of the first level
_Images contains an image or images for the operating environment as well as the start

icon. The image and the icon have to use the operating environment name as their file

name. The icon has to be in the icon format (ICO). See also Configuring the desktop link.

_Information contains messages to the users as text files. See also Sending messages to

the users.

application directory for applications of App projects, e.g. MOdel Processor.
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configuration contains images and icons for units and projects, and the sut.db database

which stores the configuration settings of an operating environment.

help contains the manuals and installation instructions for GENIUS TOOLS for Creo,

GENIUS TOOLS Starter and Startup TOOLS.

serveronly is only present in the Caddepot directory. It contains additional tools such as

GENIUS TOOLS Comma-to-dot or GENIUS TOOLS Purge. The subdirectory _ErrorLog

contains log files for errors.

software contains the GENIUS TOOLS Starter software.

tools contains the software component GENIUS TOOLS Config Editor and Requirement

Check, a tool which returns a log file with a list of all available applications.

userdata contains user-defined settings, e.g., mapkeys or user images. In contrast to the

directory in configuration/Users, this directory can be managed by the user themselves.

See also User-driven configuration.

The following application-specific directories are created for applications that configure

starter projects:

ced_drafting Creo Elements/Direct Drafting

creo_view Creo View

elements_direct Creo Elements/Direct Modeling

geomagic_design_x Geomagic Design X

key_vr KeyVR

keyshot beinhaltet alle Daten und Konfigurationen für Keyshot.

mathcad Mathcad

parametric contains data packages, standard projects and add-on applications for Creo

Parametric.

schematics Creo Schematics

Directories of the second level for the various applications
Each of the above listed application-specific directories has three sub-directories for data,

configuration settings and add-on applications.

apps contains all additional applications.

– For Creo Parametric: the GENIUS TOOLS for Creo products Library and/or Parameter

(gtfc) and the freeware tool GENIUS TOOLS UI File Loader (ui).

configuration contains configuration settings for system-wide standards, units, projects,

users as well as further directories.

–  For Creo Parametric: gt_resource_folder
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data contains all data directories available in a project, e.g., libraries, materials,

ModelCheck configuration files etc.

2.5  Configuration concept

As delivered by PTC, Creo does not support settings for different groups of users, for

example for different projects, business units or locations. Creo reads a number of

configuration files that determine the behavior of the application. The central

configuration file is the config.pro. It contains user settings such as appearance of objects

and of the graphics window, units and tolerances, or layers and mapkeys.

GENIUS TOOLS Starter assembles configuration files that can then be applied to project

groups, user groups, computer groups and units. It takes a number of configuration file

building blocks, called config_*.pro files, e.g., config_sut_de_c5p_mapkeys.pro, and

assembles them into a config.pro file that can be read by Creo.

If an option is not specified in the config.pro file, the default value will be used.

2.5.1  Creo configuration files

The behavior of Creo is largely determined by the configuration file config.pro. This is a

text file storing all settings that determine how Creo Parametric runs. 

Settings in config files are called configuration options – the calculation accuracy is, for

example, set by the command enable_absolute_accuracy yes.

The Config.pro file of Creo can be located in three different folders: 

– in the text directory (<installdir>\Common Files\text),

– in the home directory,

– in the user directory (start directory of the user).

In this order Creo copies the configuration options defined there to a single config.pro

file. If a configuration option is set more than once, the last entry is the valid option value,

i. e. the config.pro file is read from top to bottom.

Configuration options can also be specified in another configuration file, the config.sup

file. The options set there cannot be overridden by the options in the config.pro file. 

The following configuration files determine the settings for a Creo application.

Configuration file Function

config.pro crucial configuration file of Creo

contains settings for a user, e. g.

– appearance of objects and of the graphics window
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Configuration file Function

– behavior when creating, saving or opening objects

– units, tolerances, search paths and default directories

– printing, import and export settings

– settings for optional modules such as Pro/NC, Pro/Sheetmetal,

Pro/Mold

– layers and mapkeys

If a configuration option is not defined, the default value will apply

to Creo.

config.sup contains settings that the user may not modify, i.e., that cannot be

overwritten by the config.pro file, for example to ensure drawing

standards

config.val contains validation settings for data import

creo_parametric_cus

tomization.ui

contains UI customizations for a user

creo_parametric_ad

min_customization.u

i

Created by administrator, contains UI customizations

2.5.2  Config.pro blocks

By using GENIUS TOOLS Starter, configuration options are not written to the Config.pro

file of Creo, but to different fragmented configuration files of GENIUS TOOLS Starter,

called config.pro blocks.

A config.pro block

– is a text file that must start with "config_" and end with ".pro", e.g.

config_sut_de_c6p_dir_file.pro, config_c5p_mapkeys.pro.

– is one of many configuration files that are read by GENIUS TOOLS Starter and converted

into a config.pro file for starting Creo,

– can contain one or more multiple Creo configuration options, i. e. settings for users,

– is also called config_*.pro file,

– is not to be mistaken for the config.pro file of Creo, which exists only once.
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Config.pro blocks are created manually and distributed to the desired configuration levels:

standard, units, projects and user. Thus they provide company-wide settings as well as

settings for specific departments, projects or user groups, see next chapter.

There are two types of config.pro blocks: simple and conditional, see chapter Types of

config.pro blocks.

2.5.3  Types of config.pro blocks

Config.pro blocks are read in different ways. There are basic and conditional config.pro

blocks.

1. Basic config.pro blocks: without tag ID

The config.pro block (config_*.pro file) is given a meaningful name and stored in one of

the directories Standard, Unit, Project, User. If the directory is valid for the selected project,

the Config.pro module is read out. 

– Control: Call hierarchy of the directories determines which config.pro block is used for

the project, see Call hierarchy for configuration files. 

– Notation: config_*.pro, e.g.: config_1_lic_sim_live.pro

2. Conditional config.pro blocks: with tag ID

A tag ID is a textual identifier that is recognized by GENIUS TOOLS Starter. By adding a tag

ID to a config.pro block, its validity can be linked to conditions.

– Notation: config_*.TAGID.pro, e. g. config_mbd.europe.berlin.mbd.pro

GENIUS TOOLS Starter distinguishes between unit tag IDs and free tag IDs.

Unit tag ID
A unit tag ID is an additional textual marking in a config.pro block that defines a unit and

limits the validity of the block to it. This means a conditional config.pro blocks with a unit

tag ID is activated by the selection of a unit in GENIUS TOOLS Starter App.

Unit tag IDs can be used

– as name of the unit folder

– as name of an image file: to assign images to a unit

– in config.pro blocks: to restrict configuration options to a unit, see Using unit tag IDs.

Free tag ID 
A free tag ID is an additional textual marking in a config.pro block that defines a

combined project option and limits the validity of the block to it, e. g. config_lic.mbd.pro.
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That means users have to activate the project option – here: mbd – in GENIUS TOOLS

Starter App in order for the config.pro block to be read at project start. The first config.pro

block with the free tag ID creates a checkbox.

Free tag IDs can be choosen freely, but cannot be assigned to a unit.

2.5.4  Call hierarchy for configuration files

Many configuration options can be set only once in Creo. For such options, the value used

is the last value that is found when reading the config.pro file from top to bottom. If

multiple settings are defined for an option, only the last settings is relevant.

The configuration settings are copied into the config.pro file for Creo in the following

sequence by GENIUS TOOLS Starter.

The config.pro blocks of GENIUS TOOLS Starter can be located in four directories:

standard directory for global system settings, unit directories, project directories and user

directory for user-defined settings. 

GENIUS TOOLS Starter overwrites the config.pro file of Creo with the config.pro blocks

you have. They are copied in the following order. The last entry of a configuration option

is the valid value.

1. Standard (global directory)

2. Standard searchmode, if Windchill is active

3. Units (individual subdirectory)

4. Units searchmode, if Windchill is active

5. Projects (individual subdirectory)

6. Projects searchmode, if Windchill is active

7. Users (individual subdirectory, named by Windows user name)

8. Users searchmode, if Windchill is active

9. Userdata (configurable)

Please note: The directories units and users can only be used with a subscription

license.
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For more information on searchmode, please refer to Searchmode directory.

Project configuration: example
The following diagram explains the call hierarchy when user Meier of Unit Germany opens

Project 1. The value of the last called config.pro block is the valid value.
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2.5.5  Call hierarchy

Configuration files and batch files are subject to the same call hierarchy. Unlike

configuration files, batch files cannot be saved in the searchmode directory.

Call hierarchy for batch and configuration files in a

started project

The following search and call sequence applies to configuration files.

1. Standard (global directory)

2. Standard searchmode, if Windchill is active

3. Units (individual subdirectory)

4. Units searchmode, if Windchill is active

5. Projects (individual subdirectory)

6. Projects searchmode, if Windchill is active

7. Users (individual subdirectory, named by Windows user name)

8. Users searchmode, if Windchill is active

9. Userdata (configurable)

Please note: The directories units and users can only be used with a subscription

license.

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx, the

files in the projects directory, that is, the general configuration files, will be moved to a

new directory named standard. Project-specific configuration files located in

subdirectories under projects will not be moved.

Example project configuration
The following graphic illustrates the call hierarchy for user C Meier starting Project 1 in the

unit Deutschland.
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2.5.6  Searchmode directory

The searchmode directory is part of the calll hierarchy when you are working with

Windchill. It contains additional settings that are defined on starting Windchill, as well as

commented-out settings for Creo projects. Commenten-out settings are located in the file

exclude.txt.

As soon as Windchill is activated, the searchmode directories within all configuration

directories relevant to a project will also be included into the configuration call hierarchy.

All configuration files within the searchmode directories will be used.

Please note: It can be useful to add a special directory under a project directory. If you

create a special directory called SEARCHMODE within a project directory, this directory

will also be used in determining the configuration settings.

Searchmode directories are used according to the same hierarchy as configuration files:

1. in the standard directory

2. in the unit directory

3. in the project directories

4. in the user directory

2.5.7  Configuring an operating environment with batch files

If you want to execute additional instructions before Creo is started or when Creo is

stopped, you can place project-specific batch files in the directory ..

\configuration\projects\<PROJECT>. The batch files names have to start with one of the
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prefixes prestart_, start_ or stop_. You can use batch files to set additional

environment variables or copy additional data.

Warning: Starting with GENIUS TOOLS Starter 6.0.1, a new configuration mechanism is

in use. When you update from version 6.0.0.0 or migrate from Startup TOOLS 20xx,

verify references to configuration files in your batch files. References to 

..\configuration\projects\ have to be changed to ..\configuration\standard.

Batch files in the project-specific subdirectories under projects do not have to be

changed.

Types of batch files

Prefix Start time Comment

prestart_ Started before the Creo

Parametric configuration is

created.

When a project is started, GENIUS TOOLS

Starter calls the prestart_ batch files before

the config.pro files for the project are

assembled.

poststart_ Started after Creo

Parametric has been

started.

This type of batch file can be used for

accessing the running Creo session with the

help of additional programs.

start_ Started before Creo

Parametric is started.

When a project is started, GENIUS TOOLS

Starter assembles the config.pro files for the

project, then calls the start_ batch files.

stop_ Started after Creo

Parametric is closed.

Please note that Enable stop batches has to

be set to Yes in the Project Configurator

under Configuration > (Select group) > Creo

Settings > Startup Settings.

Warning: The batch file types runonce_ and env_ are not supported any longer. If you

want to keep using your batch files, rename them to start_, e.g., env_inneo.bat to

start_inneo.bat

2.5.8  User-driven configuration for Creo Parametric

Users may manage configuration files on their own and are thus able to overwrite or

append the settings established by the administrator. This is often done, for example,

when working with user-defined mapkeys.
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For a user to administer his or her own settings the configuration files have to be saved in

the userdata directory to which the user needs to be given write access. 

There are two ways to provide a user with a userdata directory.

1. Users can work in userdata that is a subdirectory of the Caddepot directory of the

adminstrator computer and which is synchronized to the Cadpool directory of the client

computer. 

2. A userdata directory can be set up on any location on the client computer where it does

not undergo data synchronization. 

Define the storage location in Configuration > Settings: Creo Parametric >  Select a group

> Tab: Application > User settings.

Path to the userdata directory

u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

Private config.pro

Name of a user-defined config.pro file. It is appended to the config_*.pro files in the users,

projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to

the userdata directory, as well as the access right Can save personal Config.pro file [to

userdata directory] on server.

See also Config tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file. It replaces any customization.ui file in the

users, projects, units and/or standard directories. See also UI tab in GENIUS TOOLS Starter

App.
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3  Allocating Creo licenses with GENIUS TOOLS
Starter

Companies that only have a few workstations may be able to maintain license files at each

workstation individually, but as corporate structures grow this will be a tedious task:

different workstations require different licenses, the expiration of licenses must be

monitored, but most importantly an efficient assignment of licenses and license extensions

to projects becomes difficult.

With GENIUS TOOLS Starter you can:

1. Specify license servers

You can assign one or more license servers to a project. 

2. Assign licenses and license extensions to a project

Creo licenses can be made available to users in various ways, especially to minimize the

number of projects and provide choices for users. See chapter Optimally assigning

licenses.

3. Distribute Creo startkeys (license keys, PSF keys) automatically

You can distribute Creo startkeys automatically to all user computers. GENIUS TOOLS

Starter copies all PSF files located in the configuration folder (Cadpool) of the user

computer to the bin directory of the Creo installation folder. Alternatively, only those PSF

keys that control a specific project can be copied. See chapter Start.

Automatic copying is greatly beneficial when changes are made to the PSF keys as the

maintenance effort is reduced significantly. 

4. Work offline by license borrowing

Borrowing licenses for a certain period of time is especially advantageous for mobile

working. Users who have the right to borrow licenses can see the button  in the

Licenses tab in GENIUS TOOLS Starter App and can use it to start the license borrowing

process of PTC. 

3.1  Basic information

This chapter introduces Creo licenses and Creo startkeys.
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3.1.1  Creo licenses

When purchasing Creo Parametric software from PTC, you receive a FlexNet license key

(license key for FlexNet). This consists of the name of the base license and – if available –

the numbers of the license extensions (modules), e.g. #116 for NC-SHEETMETAL, #339 for

Mold Analysis.

1. Creo Parametric base license, e. g. Creo Foundation (PROE_Foundation)

– is necessary to start Creo Parametric

– depending on the purchased product, a base license can contain a list of modules and

is then labeled base license package, e. g. Creo Advanced XE

2. Creo Parametric license extensions (also called license key features), e. g. Plastic

Advisor (134)

– extends a basic license (package) with functions

– can be purchased separately

– always requires a base license package

– a license extension package contains several license extensions, e. g. Creo Advanced

Assembly Extension (AAX)

Creo Parametric – together with the previous products Pro/ENGINEER and Wildfire – has

been on the market for over 30 years. During this time many modules have been created

and many products were sold by PTC and resellers. In addition, countless product

packages were created as part of sales initiatives. Thus, it is hardly possible to keep track

of all basic license packages and their diverse functionalities. As a result, all long-time

users of Creo Parametric have a different license key architecture.

The following table lists some examples of products and their license keys.

Produkt Beschreibung Lizenzschlüssel

Creo Foundation Base license PROE_Foundation

Creo Advanced SE Basic license package with

the additional modules

Surface, Design Animation,

Modelcheck, Mold Analysis

Lite and others

PROE_AdvSE

Creo Advanced XE with AAX Basic license package with

the additional modules

PROE_FAPAAX



29GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

Allocating Creo licenses with GENIUS TOOLS Starter

Produkt Beschreibung Lizenzschlüssel

Assembly/AAX and other

modules

Assembly License extension 6

Creo Advanced Assembly

Extension (AAX)

License extension package

with Notebook (0),

Assembly (6), Process for

Assemblies (97), WebLink

(108), Creo Layout 3D

Integration (292), Creo

Options Modeler Basic (329)

PROBUNDLE_10119

0,6,97,108,292,329

Administrators of Creo Parametric have the task of correctly assigning existing as well as

newly purchased licenses to users. In other words, administrator are faced with a license

structure and have to set up the Creo Parametric startup options, i.e. the Creo startkeys,

accordingly.

3.1.2  Creo startkeys (PSF keys)

A startkey is a configured start command that opens Creo with one or more specified

licenses or license extensions. 

Creo startkeys are created as PSF files and are located in the directory

<creoinstalldir>\Parametric\bin. Startkeys are generated during setup with the PTC

installation wizard or can be reconfiguared later

(<creoinstalldir>\Parametric\bin\reconfigure). Refer to the Creo manuals from PTC for

more information. 

When the program starts, Creo reads the startkey to determine which licenses and

extensions are to be searched for on which license server(s). This is defined in the

environment variables PTC_D_LICENSE_FILE- and CREOPMA_FEATURE_NAME.

GENIUS TOOLS Starter intervenes in this process and 

– replaces the PTC environment variables: 

when settings are made in GENIUS TOOLS Project Configurator, i. e. for license server

and base license specifications.

or

– adds additional information to the PTC environment variables: 

when settings are entered into config.pro blocks, i. e. for license extensions and other

project options, such as add-on programs.
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Assigning licenses to a startkey
Each startkey should contain information about the base license package and the license

extensions. One startkey can contain several license extensions, as well as several base

licenses.

Usually, multiple startkeys are created for Creo, since the same license structure is typically

not available for all workstations. The actual number of startkeys required and the license

information they contain depends on the procedure you choose to optimize license usage,

as described in the next chapter. 

Examples for license information in start keys:

Feature in der Datei found.psf: ENV=CREOPMA_FEATURE_NAME=PROE_FOUNDATION ()   

Feature in der Datei manikin.psf: ENV=CREOPMA_FEATURE_NAME=PROE_FOUNDATION (277 278)

Feature in der Datei AAX.psf: ENV=CREOPMA_FEATURE_NAME=PROE_AdvSE ()

3.2  Determining license servers

If multiple license servers exist in an organization, you can assign one or more license

servers to a specific project, unit or group. 

You can also assign multiple license servers to a project and define the order in which the

servers are accessed.

Example: For the unit United Kingdom the license server in the United Kingdom should

be searched first and the license server in Asia last.

1. In the Resources main page create the resource Creo license server with the name

ALLSERVERS, which contains all license servers, e. g.

7788@licserverUK;7788@licserverUS;7788@licserverAS

The order of the servers corresponds to the search query.  

2. Go to the unit United Kingdom and select the license server ALLSERVERS in the tab

Start in Creo Settings. 

3.3  Optimally assigning licenses

There are three ways to use GENIUS TOOLS Starter to assign licenses and extensions to

one or more projects.

– Method 1: Fixed assignment of a startkey to a project 

– Method 2: Assigning several startkeys to one project 

– Method 3: Assigning license extensions to a project
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Choose the method according to the license structure. 

The three methods can best be explained using an example.

Methods of license usage by example
The following example describes an optimal creation of Creo startkeys for different typical

situations.

Assumptions: The license server CADLICENSES is used. Creo startkeys (PSF keys) are

created by default with the PTC Setup or edited with "reconfigure". They are located in the

bin folder of PTC, e. g. PTC\Creo 8.0.0.0\Parametric\bin.

Initial scenario: One type of license 

A company employs 10 Creo users and has 10 "Creo Foundation" base license packages.

Solution / Method 1: You require one Creo startkey which is assigned to one project. 

– Content of the file parametric.psf:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation ()

– In GENIUS TOOLS Project Configurator, assign the startkey parametric.psf to the project

Creo Parametric. (Consult the chapter Assigning Creo licenses to projects for a step-by-

step guide).

Result: 10 users can start the project without any

options.

Scenario A: Several types of licenses

Two construction engineers join the team. The base license package "Creo Foundation" no

longer exists, so the base license package "Creo Advanced SE" is purchased. 

Situation: There are 10 Creo Foundation base license packages and 2 Creo Advanced SE

base license packages for 12 users.

Solution / Method 1: The existing PSF key is extended. 

– In the parametric.psf file the license specification for Creo Advanced SE has to be added:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation PROE_AdvSE ()

– No editing needed in GENIUS TOOLS Project Configurator for the 12 users to work.

Result: 12 users can start the project without any

options.
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Result: The project is started without any selections in the GENIUS TOOLS Starter App user

component.

Scenario B: One license type with license extension package

The top-down technology (skeleton models, reference control etc.) is to be used. For this

purpose, two license extension packages "Creo Advanced Assembly Extension" (AAX) are

purchased.

Situation: There are 10 Creo Foundation base license packages and 2 AAX license

extension packages for 10 users. Creo Parametric can be started without AAX and with

AAX (but only 2 times). 

Solution: You can use all three methods. For all of them users are given the option to start

a project with or without an AAX license extension. 

– Content of parametric.psf (as in initial scenario):

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation ()

– For methods 1 and 2, a second startkey is created with the content:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_AdvSE (0 6 97 108 292 329)

Method 1: Assigning a startkey permanently to a project.

– GENIUS TOOLS Project Configurator a new project is created with the second Creo

startkey aax.psf.

Result: Two projects can be started without any

options.

Hint:  Project permissions can be used to grant selected users only the right to see the

project with AAX.

Method 2: Assigning multiple startkeys to a project.

– The second startkey aax.psf is assigned to the project. (See Projects with several startkeys

to choose from).

Result: The project has an option for selecting the

Creo startkey.

Method 3: Assigning license extensions to a project
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– The aax.psf startkey is not used.

– Create a config.pro block in the project folder which contains information about the AAX

license extension package. (See chapter Single project options for details).

– Contents of the config_aax.pro file:

! gts_creo_lic = 0 6 97 108 292 329

Result: The project has an option for selecting the

AAX license extension (checkbox).

Tabular overview of license usage methods:

Method 1 Method 2 Method 3

Description Fixed assignment of

a startkey to a

project 

Assigning several

startkeys to one

project

Assigning license

extensions to a

project

Project options in

GENIUS TOOLS

Starter App

No options for

project

Selecting a startkey

from a list of

startkeys

Anklicken einer oder

mehrerer

Projektoption(en) am

Projekt

Settings Projects >

Application > Project

> Tab: Start > Creo

startkey

Projects >

Application > Project

> Tab: Start > Creo

startkey

configuration

Creating a

config.pro- block in

the project folder

Advantage Quick provision of a

simple configuration

Number of projects

is minimized

Number of projects

is minimized

significantly

3.4  Automatic distribution of Creo startkeys

You can automatically distribute Creo startkeys (PSF keys) to all user computers. GENIUS

TOOLS Starter copies all PSF files located in the configuration directory (Cadpool) of the

user computer to the bin directory of the Creo installation directory of the user computer.

The files are copied to the bin directory of the Creo version that is assigned to the project.
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Automatic copying is useful when PSF keys were edited. The maintenance effort is

significantly reduced.

The function to copy startkeys is activated in GENIUS TOOLS Project Configurator in the

menu item Configuration under Creo Settings > Tab: Start > Dialog: Creo startkey. There

you can choose:

– whether all Creo startkeys are copied to the bin directory or

– whether only project-relevant startkeys are copied to the bin directory oder

– whether the bin directory is cleaned up before, i. e. all startkeys are deleted before

copying. (This is only possible for startkeys in the units and users directories).

The startkey used for the project depends on the call hierarchy for config.pro blocks.
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4  GENIUS TOOLS Environment Administrator

GENIUS TOOLS Environment Administrator is an administrative tool for managing

operating environments. Use GENIUS TOOLS Environment Administrator to handle the

following tasks.

1. Create operating environments

2. Add components to an existing operating environment

– project directories (directories with config.pro and other project-specific files)

– data directories

– additional applications

3. Update operating environments (Software update for GENIUS TOOLS Starter App and

GENIUS TOOLS for Creo)

4. Modify settings for an operating environment for

– license servers

– synchronization servers (Caddepot, Cadpool)

5. Migrate Power Extension environments (Creo Elements/Direct Modeling) into a GENIUS

TOOLS Starter operating environment

The next chapters describe each function in detail.

4.1  User interface

GENIUS TOOLS Environment Administrator must be started with write access to the

caddepot directory.

If you open the software from an administration computer that does not have an AppData

directory, you must start GENIUS TOOLS Environment Administrator with the command -

gts:appdata=%TEMP%.
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When you select a function on the GENIUS TOOLS Environment Administrator start page,

a wizard with one or more dialog pages is displayed. The inline help on the right side

supports each task of the workflow.

Dialog for completing three tasks and integrated help

First, you always need to select the Caddepot. Then, the option list shows the operating

environments that are available for selection. 

All changes in Caddepot are stored in a database that cannot be edited by multiple users

at the same time. The following hint message means that another user is working either in

GENIUS TOOLS Project Configurator or in GENIUS TOOLS Environment Administrator.
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Notification that the selected operating

environment is currently modified by another user

User menu
To access general settings for GENIUS TOOLS Environment Administrator, click on the

gear symbol  in the header.

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

Help (F1)

Opens the software help for GENIUS TOOLS Starter. The help corresponds to this

document.

Reference card

Opens a reference card for a quick overview of all functions.

Info (F12)

Shows the current GENIUS TOOLS Starter version. 

Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.
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4.2  Creating an operating environment

GENIUS TOOLS Environment Administrator lets you create different operating

environments with just a few mouse clicks. 

The function Create creates an empty, new operating environment. This consists of the

directory structure, the GENIUS TOOLS Starter software and an empty sut.db database. All

settings defined in GENIUS TOOLS Project Configurator are stored in this database file,

which is located in the <GTSWorkingEnvironment>\configuration\database directory.

If you have purchased the Startup TOOLS product package, the add-on application

GENIUS TOOLS for Creo is automatically installed in the

<GTSWorkingEnvironment>\parametric\apps directory when you create a new operating

environment. This provides you with an operating environment with standardized

templates (start object templates, project-specific libraries, drawing frames, ModelCheck

configurations), interface and function configurations for Creo (config.pro, config.sup

config.ui) and many additional functions for Creo (toolkit applications). 

You can add data packages and standard projects at any time thereafter via the Add

Components function.

Creating a new operating environment

Click the Create symbol on the start page to start create a new operating environment.

Step 1: Define operating environment
GENIUS TOOLS Environment Administrator will find the Caddepot and Installdepot

directories automatically if the software is started from a default installation setup. 
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Verify the paths for the Caddepot (1) and

Installdepot (3) directories.

Enter a name for the operating environment

(2). The name is used to create a directory of

the same name in the Caddepot and setting

up the directory structure there.

Select a software version (4) from the

Installdepot.

Click Next.

Creating an operating

environment: Step 1

Please note: You can change the name of an operating environment any time by

renaming its directory.

Step 2: Configuring license and synchronization server
The users need to connect to GENIUS TOOLS License Manager in order to use a full

version of GENIUS TOOLS Starter App.

Please note: If you do not configure the synchronization settings, Environment

Administrator will create a local operating environment without synchronization.

Under Source (1), enter the name of the

server that GENIUS TOOLS Starter App

should access to get licenses.

Under Synchronization server settings, define

the synchronization to keep data current on

the local application computers and give the

users fast access to any changes.

The synchronization process is adapted to

Creo in that it will not update toolkit

applications as long as Creo is running. For

this, the toolkit applications, such as GENIUS

TOOLS for Creo, have to be located in the

apps directory of Creo Parametric.

Enter a descriptive server name (2).

Enter the synchronization server path (3) down to the Caddepot directory. GENIUS TOOLS

Starter App will add the name of the current operating environment automatically. This
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makes it possible to copy operating environments, for example to create test

environments quickly without having to change the settings. Also, operating environments

can be renamed without having to change the settings.

Under Target directory (4) enter the location where the Cadpool directory should be

located on the application computers. If the Cadpool directory is not present yet, GENIUS

TOOLS Starter will try to create it. It will also create a subdirectory named for the operating

environment. You can use absolute paths or environment variables that are available on

the application computers.

Enter the synchronization interval (5) in minutes. The synchronization interval defines how

often GENIUS TOOLS Starter App should synchronize the data from the central Caddepot.

A synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is

changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If

there are many changes to the data, the interval should be shorter. If many users are

accessing the Caddepot, the interval could be longer to avoid too much network load due

to frequent synchronizations.

Click on Create.

4.3  Adding components to an operating environment

With this function you can add the following components from the installdepot to an

existing operating environment.

For Creo Parametric:

– project data directory

– project configuration directory 

– Toolkit applications (GENIUS TOOLS for Creo, UI)

For Creo Elements/Direct Modeling:

– TSPRO-Umgebung

– SOLIDPOWERPARTS

Please note: In order to add components, you first have to install them into the

Installdepot directory from the data setups.
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Adding components to an operating environment

Click the Add Components symbol on the start page to start the installation assistant.

Step 1: Select operating environment
First select the operating

environment (2) you want to

configure from the Caddepot (1).

Then select the software version (4)

to use from the Installdepot (3).

Select a software version that has

the required components installed.
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Step 2: Add CAD applications
Select the CAD application to which

you wish to add components. 

For Creo Elements/Direct:

– TSPRO-Umgebung

– SOLIDPOWERPARTS

For Creo Parametric: 

1. data packages

2. projects (directories for

standard projects)

3. toolkit applications (gtfc, ui)

Components for Creo Parametric
Data packages and toolkit applications are added separately.

Projects can be created together with the data package to be added as well is in their own.

1. Add data packages and create standard projects

All data directories for Creo Parametric from the previously selected software version in

the installdepot are displayed here, e.g. D:

\GTSTARTER\installdepot\9.0.0\parametric\data.

Select a data package. Data packages in gray are directories that have already been

copied to the caddepot once. 

Enter a target name under which it should be copied in the directory data in the

caddepot. (Caddepot\<operatingenvironment>\parametric\data.) 

The target name can be overwritten. 

When selecting a data package, you can in the second step  create standard projects

whose settings should be adjusted afterwards in the GENIUS TOOLS Project

Configurator. Here, the supplied standard projects – one standard project per Creo

version with and without Windchill – are copied from the project directory
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(Caddepot\<Arbeitsumgebung>\parametric\configuration\projects) under a new name

(target project name). 

If a project is grayed out, it means that it has already been copied once. It can be copied

again under new name.

The target project name is the name of the folder in the project directory and at the

same time the name of the project in GENIUS TOOLS Project Configurator. The display

name is the name that appears in GENIUS TOOLS Starter App. It can be changed in

GENIUS TOOLS Project Configurator. 

2. Create standard projects

If the data packages have already been installed, standard projects can be created here as

in the previous point.

3. Toolkit applications

Select the toolkit application you wish to add. 

– GENIUS TOOLS for Creo: Additional functions for Creo Parametric included in the

products GENIUS TOOLS Library and GENIUS TOOLS Parameter.

– ui: Application that allows reloading multiple Customization.ui files.

If it is not possible to tick an application, it means that it already exists in the

application-specific apps directory. The application cannot be created again.
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Please note: The toolkit application GENIUS TOOLS for Creo will be automatically

installed to the parametric\apps directory when creating a new operating

environment, if you have purchased the Startup TOOLS product package.

After clicking Add all specified components are added to the operating environment.

4.4  Updating software

All software setups in GENIUS TOOLS Starter unpack their data to the Installdepot

directory. You can use the Update function of GENIUS TOOLS Environment Administrator

to update the software for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App in the

operating environments. This two-step process allows you to make targeted adjustments

to individual operating environments. You can upgrade or downgrade to any version that

is available in the Installdepot.

If you have configured synchronization, the configuration for the software update will be

made in the background without the users having to stop Creo or GENIUS TOOLS Starter

App. The new software version will then be used on the application computer after the

next synchronization.

If you update GENIUS TOOLS for Creo, the synchronization on the application computers

will only be run after Creo has been closed.

Warning: If you are using network mode, make sure that all users have closed GENIUS

TOOLS Starter App and Creo, as the software cannot be updated otherwise.

Updating an operating environment

In GENIUS TOOLS Environment Administrator click the Update button to start the

installation assistant.
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Software update 
First, select from the Caddepot (1) the

operating environment (2) you want to

configure (1).

Then select from the Installdepot (3) the

new software version (4) you want to

install.

Under Update settings (5) you can select the components to update: 

– the software GENIUS TOOLS Starter (module of Startup TOOLS),

– the software components GENIUS TOOLS for Creo (contained in the modules GENIUS

TOOLS Parameter and GENIUS TOOLS Library),

– the tools folder, which contains GENIUS TOOLS Config Editor and Requirement Check.

The update process writes a new software directory for GENIUS TOOLS Starter and

updates the database. For GENIUS TOOLS for Creo, the gtfc directory under apps is re-

written. The main.cfg file remains untouched. The tools directory is copied from the

Installdepot to the Caddepot.
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4.5  Modifying settings

Some settings for operating environments can only be changed using the Modify wizard in

GENIUS TOOLS Environment Administrator. The most important one of these setting is the

Caddepot path. You can also edit synchronization and licensing settings.

Please note: GENIUS TOOLS Environment Administrator only changes the standard

settings, that is, the settings for the group Standard. If you have made individual settings

for a user group or computer group, you have to change these settings using GENIUS

TOOLS Project Configurator (Configuration > (select group) > Synchronization)

In GENIUS TOOLS Environment Administrator click the Modify button to start the

installation assistant.

Step 1: Change license server settings
First, select from the Caddepot (1) the operating environment (2) you want to modify. 

Then enter the license server settings (3).

You can also deactivate the license

server (4). 

An inactive license server will not be

used by GENIUS TOOLS Starter App. This

means that you can only use home-use

or educational Creo licenses.
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Step 2: Change synchronization settings
The server path is always given down to

the Caddepot directory (1).

When Checksum verification (2) is active,

a checksum for each copied file is

calculated and compared to the

checksum of the file on the server. If the

checksum differs, the server is queried

for the file again. If checksum verification

is not active, the files will just be copied.

Warning: Activating checksum verification often allows significantly shorter

synchronization times.

If you have moved your synchronization server, proceed as follows:

1. Create a new Caddepot and adapt the synchronization server settings in the new

operating environment there.

2. Test the new operating environment to make sure that the configuration settings are

correct and the synchronization works.

3. In the old operating environment, switch the synchronization server to the new

Caddepot

When GENIUS TOOLS Starter App is restarted, it switches to the new Caddepot and

synchronizes the data from there.

Warning: Please be extremely careful when changing the Caddepot directory in an

operating environment that is already in use on multiple application computers. Wrong

settings can lead to the application computers not synchronizing. However, it is still

possible to change the Caddepot directory when you move a server. Create a new

Caddepot, then set the synchronization path in the old operating environment to the

new Caddepot. The application computers will switch over accordingly.

Step 3: Edit settings for the application computers
You can activate or deactivate synchronization between the central Caddepot and the

application computer Cadpool directories (1).
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Warning: If you deactivate synchronization, you permanently separate the application

computers from the Caddepot. Any changes you make to the central synchronization

settings or the operating environment will not be transferred to the application

computers!

Under Target directory (2), specify the

location of the Cadpool directories on

the application computers, where the

local copy of the operating environment

is stored. If the Cadpool directory cannot

be found, GENIUS TOOLS Starter will try

to create it. A subdirectory named after

the operating environment will also be

created. You can use absolute paths such

as C:\Cadpool, or environment variables

that are available on the application

computers, e.g., %

GTS_SYNC_DESTINATION%.

Under Synchronization interval (3), specify an interval in minutes. The synchronization

interval determines how often GENIUS TOOLS Starter App will synchronize the data. A

synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is

changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If

there are many changes to the data, the interval should be shorter. If many users are

accessing the Caddepot, the interval could be longer to avoid too much network load due

to frequent synchronizations.

If Start client with Windows (4) is activated, GENIUS TOOLS Starter App will be started

automatically when the operating system is started on the application computers.

4.6  Migrating Power Extensions environments

With  GENIUS TOOLS Environment Administrator 9.0.0.0 you can transfer environments for

Creo Elements/Direct Modeling which are started with the Power Extensions add-on

application into an existing GENIUS TOOLS Starter operating environment. This allows you
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to configure projects in the same way as Creo projects, i. e. define settings for different

configuration levels (standard, units, projects and users).

During migration, a directory named elements_direct is created in an existing operating

environment, as well as the subdirectories apps, configuration and data. The existing

configuration files and data packages are transferred to this folder structure. 

Step 1: Select operating environment
First select from the Caddepot (1) the

working environment (2) to which you

want to migrate an existing Power

Extensions environment.

Then you can select the software version

(4) from the installdepot (3) that contains

the software setup or the components

needed.

Step 2: Select power extension environment
You can migrate environments for Creo Elements/Direct Modeling projects which were

configured with the add-on applications Power Extensions, which uses Solidpower

software.
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Select the existing Power Extensions

directories that contain company-specific

(1) and site-specific customizations (2).

If you have data packages in a

Solidpower environment (3), specify the

directories that contain the software (4)

and the data for standard parts (5).

Step 3: Create project
Here you can create a project that users can open with GENIUS TOOLS Starter App.

Select whether a project should be

created (1) and the version of Creo

Elements/Direct Modeling (2) with which

the project should start.

Specify the name for the project (3). 

Result: 

In the selected operating environment, the directory elements_direct is created with the

subdirectories apps, configuration, data (i. e. the directory structure of GENIUS TOOLS

Starter). The project is created under elements_direct/configuration/projects and hence

visible

– in GENIUS TOOLS Project Configurator under Projects > Application types > Projects and
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– in GENIUS TOOLS Starter App.



52GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

5  GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator is the central application for configuring operating

environments. Use GENIUS TOOLS Project Configurator for managing all project and

operating environment settings.

A project is a collection of application properties such as project directory, data directory

and license. Projects allow users to start an application with a specific set of configuration

settings. A project combines locally available data with a centrally managed configuration

settings.

Projects are opened by the users via GENIUS TOOLS Starter App, and edited by the

administrator using GENIUS TOOLS Project Configurator. Each project is saved in a work

environment under cadpool > configuration > projects, e.g., project_creo6p_en.

When a project is started, the configuration settings in the standard directory as well as in

the directories for the unit and for the user are considered.

Project Configurator manages project information by modifying the central sut.db

database. The project configuration for each operating environment can be synchronized

to the Creo application computers.

Please note: Make sure that Project Configurator has write access to the central

database in the Caddepot so that it can store configuration settings.

Project Configurator is not synchronized immediately. When you make changes in Project

Configurator, you have to save them to the database before they become available to

GENIUS TOOLS Starter App. After you have saved your changes, the configuration can be

updated in GENIUS TOOLS Starter App by manually refreshing the available projects or by

running the synchronization process.

5.1  Starting GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator can be started from the installation computer as well

as from any synchronized application computer. On the installation computer, Project

Configurator is located in the Caddepot directory, on the application computers it is

located in the Cadpool directory. In both cases, Project Configurator accesses the same

central database in the Caddepot.

Starting Project Configurator on the installation computer
There are two ways to start Project Configurator: 
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1. Open GENIUS TOOLS Starter App via <caddepot>\<environment>\software\GTS.exe. In

the user menu , select Project Configurator or press F8.

User menu in GENIUS TOOLS Starter App

2. Start Project Configurator directly using a start parameter:

<cadpool>\<environment>\software\GTS.exe -gts:admin 

Starting Project Configurator on an application computer
There are two ways to start Project Configurator: 

1. Open GENIUS TOOLS Starter app via <caddepot>\<environment>\software\GTS.exe. In

the user menu  select Project Configurator or press F8.

2. Start Project Configurator directly using a start parameter:

<cadpool>\<environment>\software\GTS.exe -gts:admin 

The item Project Configurator in the user menu can be hidden for the users (see Assigning

function access rights) so they cannot access Project Configurator from the user interface.

The start parameter -gts:admin cannot override any access restriction for the Project

Configurator.

Read-only mode
To avoid that several users can make changes to the database of GENIUS TOOLS Project

Configurator the application can now only be used by one person. All others receive a

note about the user who has accessed GENIUS TOOLS Project Configurator and can open

the application in read-only mode.

When opening GENIUS TOOLS Project Configurator, a lock file is written to the database

directory (Caddepot\<operatingenvironment name>\configuration\database), which is

deleted again when closing the application.

Please note: Make sure to close GENIUS TOOLS Project Configurator with the exit

function to delete the lock file.

If you cannot open GENIUS TOOLS Project Configurator in write mode when no other user

is working with it, delete the LOCK file.
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5.2  User interface and navigation

GENIUS TOOLS Project Configurator opens on the Configuration page of the main menu.

Here, you can manage global settings or settings specific to units and groups. 

The main menu (1) is located on the left side of the Project Configurator window and can

be extended to show descriptions by clicking the menu symbol . It gives access to the

pages:

   Organizations

   Configuration

   Projects 

   Project collections

   Resources

When entering the settings, you will find a help section (4) on the right side of the

window, which guides you through the individual input steps. This can be opened and

collapsed with the arrow symbol. 

The user interface can be displayed in a light and a dark color variant.

User interface of GENIUS TOOLS Project Configurator in light color theme

Please note: Note that GENIUS TOOLS Project Configurator, in contrast to previous

Startup TOOLS versions, does not save changes immediately. To save any changes, click

Save button in the sidebar (2). Until you save, any changes can be undone by selecting

Revert changes in the user menu.
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The Project Configurator window also has a footer (3). The following sections contain

information on the main menu pages and the other control elements.

5.2.1  Main menu

5.2.1.1  Organization

The dialog Organization  allows you map your organization with unit of different levels

and sublevels and make project settings at those levels. Read the Organizational structure

chapter for detailed information on working with units.

Organization dialog window

Please note: Working with units is only poss bile with a subscription license.

5.2.1.2  Configuration

Use the Configuration page to manage global settings as well as settings specific to units,

computer groups and user groups. The Settings list contains several buttons which open

the settings pane and the corresponding help page.

Dialog window Configuration  

Select a group or unit to show the settings applicable to this type of group. The Standard

group is used for managing global settings and cannot be deleted. In a newly created

database, only the Standard group will be available.

While new user and computer groups are created on this page, units are crated in the

Organization page where they define the structure of an organization.

For more information on the individual settings, please refer to Configuring global

environments and Configuring heterogeneous environments.
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5.2.1.3  Projects

In the Projects page you can create and configure projects for the applications Creo

Parametric and Creo Elements/Direct Modeling, as well as projects of other applications,

which have simplified settings options (apps projects).

In the project area you can view and create projects. Click on a project to open the

settings pane for this project with the tabs Creo, Start, Windchill and Environment. For

information on how to create projects and define their settings, please refer to Creating

projects.

Projects page

Projects can either be made accessible to all users of the operating environment or be

managed by using project groups, see Restrict project access.

Projects without an available license can either be hidden from the user's view in GENIUS

TOOLS Starter App or can be marked with a warning color, see chapter GENIUS TOOLS

Starter App.

5.2.1.4  Project collections

In the main menu item Project Collections  you

can organize individual projects into project

collections, which are displayed to users in GENIUS

TOOLS Starter App. 

There are company-specific project collections, which

can contain any projects, as well as application-

specific project collections, which contain all projects

of an application. Consult the chapter Project

collections.

In addition, the display of auto projects can be

modified here. 

Auto projects are Starter projects of an application

for which only one project can be created. This

project will be automatically created by GENIUS

TOOLS Starter App with the latest available software version on the user computer and will

be displayed with an icon of the application. 
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Auto projects are generated from the following applications: Creo Elements/Direct

Drafting, Creo Illustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and

MathCad.

Please note: Auto projects are only available with a subscription license.

5.2.1.5  Resources

In the Resources page  different types of resource are created in order to work efficiently

with GENIUS TOOLS Project Configurator. Resources are roles, entries for users and

computers, startkeys and license servers for Creo applications as well as synchronization

servers (satellites).

Please read the chapter Creating Resources.

5.2.2  User menu

To access the user menu, click on the gear symbol  in the side bar.

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

XML Import

You can import users and computers from an XML file. If the users or computers are

assigned to a group that has not yet be configured, the group will also be created during

the XML import. When you click XML Import in the user menu, a dialog for selecting the

XML file is displayed.

XML Export

You can export users and computers into an XML file, for example in order to make batch

changes quickly, then re-import the file.
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Revert changes

Project Configurator does not save changes immediately, so you can revert any unsaved

changes. If you do so, Project Configurator reloads the database and re-initializes all input

fields.

To revert changes, select Revert changes. A warning dialog is displayed. Confirm the

warning (Reload database. Changes will be deleted.) with Yes.

To save changes, click Save  in the sidebar.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the

header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Help

Help (F1): Software help for GENIUS TOOLS Starter, which corresponds to this document.

Support: Contact details for the technical support of INNEO or a company-specific link

which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be

reached by email, telephone and with Teamviewer. 

Info (F12): Current GENIUS TOOLS Starter version. 

Reference card: Quick overview of the functions in GENIUS TOOLS Project Configurator.

Parameter variable: List of start parameters and environment varibles.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can

be adjusted to all sizes. 
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Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.

Starter App

Switch to the GENIUS TOOLS Starter App.

5.2.3  Save database

The sidebar contains the function Save Database . Any settings you make in GENIUS

TOOLS Project Configurator will only become active after you save them. Any changes are

saved to the database sut.db on the installation computer (path:

\caddepot\<arbeitsumgebungsname>\configuration\database)

As long as you have not saved your changes to the database, you can revert them by

selecting Revert changes in the user menu .

5.2.4  Footer

The footer in Project Configurator contains the following information.

Data base mode

The state of the database is displayed in the footer:

 Database requires a subscription license. Projects cannot be started when working

with a permanent license.

 Database has been created with a permanent license. It can be accessed by both

permanent and subscription license.

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization.

 Synchronization is active 
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Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

 Synchronization inactive

The synchronization of toolkit applications is paused as long as Creo is running 

 Local operating environment

There is no synchronization; you work on a local directory 

Running applications

If a supported desktop application is running, the application icon will be displayed in the

footer.

 Creo Parametric

 Creo Elements/Direct Modeling

Messages

– Red = Error message. Please troubleshoot.

– Yellow = Warning message. Please decide whether you want to keep on working

regardless.

– Green = Last synchronization run was completed without errors.

– Green / Creating shortcuts: This message shows that the desktop link for GENIUS TOOLS

Starter App has been updated.

5.3  Creating resources

The Resources page  is used to manage the following resources.

– Roles are groups of users and/or computers that are granted access rights to functions

and certain projects. A role can consist of variable entries from the Windows user

administration or permanent entries of 

– Users and 

– Computers.

– Creo startkeys and Creo license servers are created for Creo Parametric projects.

– Synchronization servers are mirror servers that are used for data synchronization with

GENIUS TOOLS Starter Service. 

A unit is not considered a resource but a group and is created in the Organization menu

item. See chapter Working with units.
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5.3.1  Roles

GENIUS TOOLS Starter is based on a role-based authorization concept. This allows

different groups of users to be granted different access rights to projects and functions.

Working with roles has the advantage that the users belonging to the role can be added

dynamically by accessing the Windows user administration. Users and computers can also

be assigned to a role permanently, i. e. changes to user or computer entries must be

maintained manually. 

In the first step, users or computers are assigned to a role, such as Manchester, United

Kingdom or Key Users, and the access rights for these users are defined. The access rights

are on the one hand, access to the various Starter projects, and on the other hand, to

functions in GENIUS TOOLS Starter App, see chapter Access Rights.

In the second step, the role is then assigned to a unit. In a unit, various settings can be

defined for the Creo applications. 

Roles are managed in the main menu item Resources, see Creating roles.

5.3.1.1  Default roles

There are two pre-configured roles Everyone and Administrator. Both contain in the

default settings all Windows user names known to the system. 

Hence, every user is a member of the role Administrator. When you first use GENIUS

TOOLS Project Configurator, you should adjust the role by removing the user entry

Everyone and by assigning some individual users to it.

Hint: The user entry Everyone in the Members is accessible to all roles and can be used

if you do not want to manage each user manually.

Standard role Administrator with user entry Everyone
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5.3.1.2  Creating roles

To create a new role, click the plus icon (1).

In the Details tab (2), under General (5), enter the name of the role and an optional

comment.

In the Members section (6), you can assign users and computers to a role statically or

dynamically using an LDAP query. Computers can only be assigned individually. 

Fill out the Function access (3) and Project access (4) tabs, which are described in the

chapter Access rights.  

Creating a new role

5.3.1.3  Add users and computers to a role

You can add users and computers statically, which means the entries you assign to a role

do not change automatically as is the case with an LDAP query.

To assign a user or computer to a role, you have to first create an entry as a Resource. You

can create users and computers manually or import a list, see the chapters Creating users

and computers or import from Excel.

A user/ computer can be assigned to several roles.

Procedure: Add users to a role 

1. Select the role you wish to add users to in the Resources page .

2. In the Members section (6), choose the User tab (7) and click on the plus button (8). 
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3. In the new dialog box that opens, select the users you wish to add to the role.

You can select the entry Everyone that contains all users.

4. Finish the dialog box by clicking on either:

– Ok: Add selected users and close dialog box,

– Cancel: Close dialog box without adding selected users,

– Apply: Add selected users without closing dialog box.

The member list – see screenshot Creating a new role above – shows all users (or

computers) of the role. 

A checked box means that a user is blocked (9), i. e. for this user neither any role nor any

group configuration is applied. To change the blocked status, go to Resources > Users >

Edit user. 

You can search for users (10) and delete user with the recycle bin icon (11) to the right of

the user name.

5.3.1.4  Accessing Windows user management

If you are using a subscription license, you can access the Windows user management.

This means that you can assign permissions to users and user groups that have been

defined by your company's central IT management. GENIUS TOOLS Starter App uses live

queries to make sure that user assignment is up-to-date. Thus, you do not have to create

users locally. 

Windows user management is accessed using LDAP queries. LDAP (lightweight directory

access protocol) is a standard network protocol for accessing a distributed directory

service.

Please note: An LDAP query is only available with a subscriptions license. When using a

permanent license, the LDAP tab is not visible.
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Defining an LDAP query
To define an LDAP query, go to the Resources page, select the role that you want to assign

a query to, and go to the LDAP tab.

In GENIUS TOOLS Starter App live queries to Active Directory are executed at the start of

project validation. The LDAP groups are cached for fallback functionality. 

The LDAP fields Description, DisplayName, Initials and Enabled are queried and the entries

are transferred to the following fields. The administrator can overwrite the content of a

field, but not the mapping.

Defining an LDAP query

 

u LDAP

Blocked (1)

Use this to block the LDAP query.

LDAP query (2)

Enter the name of the LDAP group you want to use.

Comment (3)

Enter an optional comment for the LDAP query.

Delete (recycle bin icon,4)

Deletes the LDAP query from the configuration.

u Modify user

Please note: Changes you make here will not be written back to LDAP.
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Search (5)

Camera column (6)

Double-click the upload icon in the camera column to add a user image.

Windows user (7)

Displays the Windows user name.

GTS Alias (8)

Enter a GENIUS TOOLS Starter alias for use in additonal applications. The alias is available

in Creo via the environment variable %GTS_USER%. If you do not specify an alias, the

Windows user name will be set

GTS Alias Long (9)

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

LDAP query

Displays the LDAP group.

Comment

Displays the staff position.

Email

Displays the e-mail address.

5.3.2  Users

To manage users, go to the Resources page  and select Users. Each user is identified by

their Windows user name.

You can switch between the card view (default) (1) and the list view (2), using the list

symbols to the right of the search input box.

Project Configurator saves the active view. User images and assignment to a user group

can only be edited in the list view.
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u Creating users

To create a user click the Add symbol (7) or click on the blank card (+).

u Searching for users

To find existing users, enter a search term in the search input field (6). A search term has

to be at least three characters long.

u Card view: Check user access rights

The color codes (3)  let you check which access groups each user is assigned to. Click on

the project symbol (4) to see a list of the projects visible for the user. Click on the access

rights symbol  (5) to see the function access rights assigned to the user.
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u Blocking users

Blocked (5)

You can block a user, which means that user group settings or role assignment will not be

used.

Yes/set: User group settings or role assignment for this user will not be considered.

No/not set: User group settings and role assignment will be used.

u Editing users

To edit a user, double-click on a visiting card or use the list view if you wish to make

several changes. You need to use the list view for defining a user image and for displaying

and editing user group assignment.

List view

Camera column (6)

The camera column is only available in list view. Double-click on the upload symbol in the

camera column to add a user image.
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Windows user (7)

Enter the Windows user name. If you are in the list view, you can get the Windows user

name for the currently logged-in user by clicking on the person icon in the Windows user

column. Instead of entering a user name you can also use regular expressions. See Section

below.

GTS Alias (8)

Enter a GENIUS TOOLS Starter alias for the user, for use in additional applications. For

example, the GTS alias is used in GENIUS TOOLS Parameter. If you do not specify an alias,

the Windows user name will be set. If you are in the list view, you can get the Windows

user name for the currently logged-in user by clicking on the person icon in the Windows

user column.  The GTS alias is available as an environment variable (%GTS_USER%) in Creo.

GTS Alias Long (9)

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short (10)

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

Group column (11)

The group column is only available in list view. It shows the user group the user is

assigned to. You can edit the user group assignment. Alternatively, to assign a user to a

user group, go to Configuration > (Select group) > Name / members. (See also Assigning

users to user groups.)

Hint: You can change the configuration for a user by assigning them to a user group.

Comment (12)

Enter an optional comment.

Email (13)

Enter the user e-mail address.

Delete (15)

Click Delete in the card view or the recycle bin icon in the list view to delete the user data.

Creating users and computers with regular expressions
User as well as computer names can be specified either directly (so that only the

corresponding user is legitimized) or with regular expressions (a group of users is

legitimized by a definition). When using regular expressions in the fields Windows user and

computer name the entries are extended by ^ and $, i. e. to ^INPUT$. Longer user names

can thus be legitimized by shorter and partial spellings,  e. g. efoster legitimizes both

efoster and ethanfoster. 

Find a list of regular expressions in the appendix.
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5.3.3  Computers

To manage users, go to the Resources page  and select Computers. Each computer is

identified by its Windows computer name.

u Adding computers

To add new computers, click on the Add symbol (1) or write in the last input field of the

list.

u Searching computers

To find existing computers, enter a search term in the search input field (2).

u Editing computers

Blocked (3)

You can block a computer, which means that computer group settings or role assignment

will not be used.

Yes/set: Computer group settings or role assignment for this computer will not be

considered.

No/not set: Computer group settings and role assignment will be used.

Computer name (4)

Enter the Windows computer name. You can get the Windows user name for the current

computer by clicking on the computer icon in the Computer name column. Instead of

entering a user name you can also use regular expressions. See section in Creating users.

Group (5)

The group column shows the computer group the computer is assigned to. To assign a

computer to a computer group, go to Configuration > (Select group) > Name / members.

(See also Assigning computers to computer groups.)

Hint: You can change the configuration for a computer by assigning it to a computer

group.

Comment (6)

Enter an optional comment on the computer.

Delete (7)

Click the recycle bin icon to the right of the Comment column to delete a computer.
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5.3.4  Importing from Excel

GENIUS TOOLS Starter comes with an XML interface to import a large number of users

into the GENIUS TOOLS Starter database in one step. If you want to import users or

computers, please follow the procedure described below.

Format of the Excel table for importing users or computer
The directory caddepot\serveronly\tools\XML-Import contains two Excel tables –

computer.xls and user.xls – that serve as templates for creating XML files for import into

the GENIUS TOOLS Starter database.

Please note: The first line in the Excel table is the header line. The header line must not

be removed and has to be formatted in all capital letters.

Example Excel table for importing computers

Example Excel table for importing users

Enter the name of the computer or user in the first column.

You can use the following columns.

For computers:

– COMPUTERNAME (mandatory)

– DESCRIPTION

– COMPUTERGROUP

For users:

– USERNAME (mandatory)

– ALIAS
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– ALIASLONG

– ALIASSHORT

– USERGROUP

– DESCRIPTION

– EMAIL

Please note: A USERGROUP or COMPUTERGROUP that does not yet exist will be

created on import.

Creating an XML file from the Excel table
After filling in the Excel table, export it from Excel as CSV (comma-separated value) file.

Beispiel: Content of a CSV file with a computer list:

COMPUTERNAME;DESCRIPTION;COMPUTERGROUP

CAD12;TB1;CREO on C:

CAD13;TB1;CREO on C:

CAD14;TB1;CREO on C:

CAD15;TB2;CREO on E:

Please note: The separator character used by Excel depends on your locale. GENIUS

TOOLS Starter supports comma or semicolon as the separator character. You cannot

use either commas or semicolons in the contents of the columns! Please also refer to

Changing the separator for XML conversion.

The directory caddepot\serveronly\tools\XML-Import contains two batch scripts for

converting the CSV files into the XML import format. Use computer.bat for converting

computer lists and user.bat for converting user lists. The CSV file has to be called

computer.csv or user.csv and be located in the same directory as the batch script. When

you run the batch script, the XML import file will be written out as computer.xml or

user.xml in the same directory.

The XML files created by the batch scripts can now be imported into GENIUS TOOLS

Project Configurator. Open Project Configurator, go to the user menu  and select XML

import. Select an XML import file. You will be asked whether you want to delete existing

users or computers. Make your decision. Confirm the import with Yes.

The imported users and computers are now available on the Resources page under Users

or Computers. If the import has created one or more user or computer groups, the groups

are available on the Configuration page in the groups list.
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Changing the separator for XML conversion
The separator character used by Excel for CSV export depends on your locale. You can

define the separator character in the batch scripts for CSV-to-XML conversion

(computer.bat or user.bat) as follows. Comma and semicolon are supported as separator

characters (sep) by default.

csv2xml -v -s:computer.csv -t:computer.xml -sep:;,

-m:1 -xsl:./extend/mode1-stylesheet.xsl 

-alias:eRoot=ROOT,eRecord=RECORD >>result.log

5.3.5  Creo startkeys

A startkey is a configured start command that opens Creo with one or several defined

licenses or license extensions. Startkeys are created in PTC's installation assistant when

setting up or reconfiguring Creo, see Creo startkeys (PSF keys).

An administrator can provide user with a choice of several Creo startkeys per project so

that the quantity of projects can be minimized.

Warning: Using Creo startkeys as a resource is a new feature in GENIUS TOOLS Starter

from version 6.0.1, which means that you need a subscription license to use it. Once

you have configured startkeys in this section, you cannot go back to using perpetual

licenses. See also License-dependent features.

In the main menu item Resources  enter a display name and a comment for a Creo

startkey which users view in GENIUS TOOLS Starter App.

Managing Creo startkeys in main menu Resources

If several start keys have been created, users can select a key when starting a project in

GENIUS TOOLS Starter App. The order of the start keys in the user selection field is that of

the order in the dialog window and can be changed by using drag-and-drop.

Display name (1)

Enter a name for the license key for display in GENIUS TOOLS Starter App.
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Comment (2)

Enter a comment for the license key for display in GENIUS TOOLS Starter App. 

Creo startkey (3)

Enter the name of the  license key. This is the name of the PSF file in the bin directory of

PTC (e. g. parametric.psf).

Blocked (4) 

Yes: The Startkey can neither be used nor selected by users.

No: The Startkey can be either directly used or selected by users in GENIUS TOOLS

Starter App.

Startkeys can now be 

– directly assigned to a project (see chapter Assigning Creo licenses to projects),

– assigned to groups or units which have access rights to particular projects (see chapter

Group specific license packages) and/or

– entered as a global standard (see Configuring global environments > Creo settings).

5.3.6  Creo license servers

In the main menu Resources  you can group one or several Creo license servers into

one resource and then assign this resource Creo License Server to a project, unit or group.

u Creo license servers

Display name (1)

Enter the name for display of the Creo license server(s).

Comment (2)

Enter an optional comment for the Creo license server.

Creo license server (3)

Enter one or more license servers in the notation Port@Servername (e.g.

7788@<licenseservername>). Separate a series of license servers with semicolons.

Blocked (4)

Yes:  The Creo license server cannot be accessed.

Warning: If you block the Creo license server here, the information from the Creo

startkey (PSF file) will be used. Check whether these information are correct. 

No: The Creo license server can be used.

The Creo license server(s) can now be assigned:

– directly to a project in Projects > Tab: Creo > Section: Creo license server (See chapter

Settings for Creo projects)
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– to groups or units, which in turn can be granted access to specific projects (See chapter

Settings for Creo projects)

– to the global settings or a group or a unit in Configuration > Creo settings > Tab:

Application > Section: Creo license server (See chapter Application)

5.3.7  Synchronization servers (satellites)

A satellite (also: synchronization or mirror server) is a computer or a sector of a computer

onto which the state of one or more operating environments of a central main server is

mirrored by data synchronization.

In the Resources page  you can add satellite servers that have been installed by using

GENIUS TOOL Starter Service. (For information on how to set up satellites consult the

document GENIUS TOOLS Starter Installation.pdf > chapter GENIUS TOOLS Starter

Service.) The action Create (6) links GENIUS TOOLS Starter to GENIUS TOOL Starter Service

and displays all satellites.

Linking satellites to GENIUS TOOLS Starter

u Main Server
Display name (1), comment (2) and path (3) to the caddepot of the main server (i. e. the

source of synchronization) are taken from the settings entered in GENIUS TOOLS

Environment Administrator. You can change the entries there with the Modify module.

Web URL (4)

Enter the URL in the notation http://<mainservername>:<portnummer>. The entries are

defined in the configuration file of GENIUS TOOLS Starter Service. Path: \

\<mainserver>\gtstarter\installdepot\gts-service-

latest\conf\gt_service_<mainservername>.cfg

Use satellites (5)

Yes: The satellites listed below are used.
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No: The satellites listed below are deactivated. 

u Satellite Server  - Subscription -

Satellite servers are servers that have been defined by the separate program GENIUS

TOOLS Starter Service.

Click Create (6) to be able to use these satellite servers in GENIUS TOOLS Starter. An up-

to-date list will be opened in a separate browser window if you click on the link (7).

5.4  Working with units

The purpose of a unit is to group users into one configuration level and apply unit-specific

settings. Units are typically used to reflect an organization's structure such as company

departments or sites.

A unit is part of the role-based authorization system, i. e. users are first assigned to a role

and the role is assigned to one or more units. Thus, a user can belong to more than one

unit. In this case, display and settings of projects depend on the unit selection, see next

chapter Displaying units in GENIUS TOOLS Starter App.

In contrast to computer groups or user groups, the affiliation of users to a unit can be

dynamical. In this way, units always reflect the current staff list and company

organizational structure as configured for Windows user management. If a user quits a

company department, their Windows user account is configured accordingly, and the user

is automatically removed from the corresponding unit. User assignment does not have to

be updated manually. See chapter Accessing Windows user management.

Please note: To allow a transition phase between managing users and computers

individually and managing them via LDAP queries, users and computers can still be

manually assigned to a unit. However, this is not the recommended procedure for using

units.

The advantages of units over computer and user groups are:

1. Units can contain sub-units and thus reflect the organizational structure of a company.  

2. A user can be assigned to several units.

3. The affiliation to a unit does not have to be maintained manually.

Units are created in the Organization page, while computer and user groups are created in

the Configuration page under Groups.
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5.4.1  Displaying units in GENIUS TOOLS Starter App

Once users belongs to multiple units, they have to select a unit in the user interface of

GENIUS TOOLS Starter App.

Standard selection
If there are only units in one organization level, the selection field lists all units in

alphabetical order.

Hint: If you wish to place a unit at the top of the list, put a space character in front of

the unit name, e. g. " United Kingdom".

Changes to unit names are adapted after restarting Starter App.

Selection of subunits
If there are subordinated units (subunits) to choose from, a separate dialog box opens.
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Displaying units with a picture
You can add a picture to the display of a unit by storing a PNG file in the _Images

subdirectory of the units directory in the Caddepot. The name of the file has to be

identical to that of the unit folder, e.g. United Kingdom.png, or – if you are working

without a unit folder – to that of the unit tag ID.

_Images directory

5.4.2  Creating units

Units are created in the Organization  page. In contrast to user groups and computer

groups, a unit always has to have a role assigned.

When creating a unit there will be a warning if this is the first functionality that you are

using with a subscription license after a license upgrade.

Warning: The use of units requires a subscription license. Once you have configured a

unit, you cannot go back to using perpetual licenses. 

Create

Click the Plus button (1) in the Selection column.
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In the following dialog fill in the input fields.

Name

Enter a name for the unit. This is the name displayed to users in GENIUS TOOLS Starter

App.

Please note: The name of a unit does not have to correspond to the name of the unit

folder. Naming a unit folder differently from a unit can be useful for a better folder

structure of files. 

Tag ID

Define the tag ID for the unit, see chapterUsing unit tag IDs. 

Autofulfillment: The tag ID is identical to the unit name. (Small letters.)

Individually created tag ID: The unit tag ID is freely choosen. Tag IDs must not contain

symbols not allowed in file names, such as ~ " # % & * : < > ? / \ { | }.

Empty: The unit does not have a tag ID. This is not recommended, since no Creo

configuration options can be set up for units without a tag ID.

Unit type 

The unit type is used for better clarity in GENIUS TOOLS Project Configurator, see

arranging units. Select a type or write in the field to create a new type.

Role

Select the role that is assigned to the unit. If the role is not listed here, you have to first

create it in the Resources page.

A unit is part of the role-based system of granting access rights. This means, to first assign

a group of users to a role, and then assign the role to the unit. A user can be assigned to

different units by being a member of different roles.

You can edit the role for a unit at a later point in time in the Definition section. The

corresponding LDAP queries are listed for information purposes only.

Comment

Entering a comment is optional.

Result: The newly created unit appears as a new item in the Selection column with the

default unit icon . You can replace this icon with your own images, such as flags, see

Displaying units in GENIUS TOOLS Starter App..
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You can now place the unit in several configuration levels in the organization tree, if you

wish to map your organizational structures with units and subunits.

5.4.3  Deactivating units

Blocking a unit in the Project Configurator is useful if you wish to disregard the

configuration for this unit without deleting the unit, e. g. during tests. 

To do this, go to the Name/Members area and activate the radio button Blocked. The

name of the unit will be crossed through.

You can also block individual users or computers without locking the entire unit, see the

section Blocking individual users or computers.

5.4.4  Assigning unit folders

A unit can be used with or without a unit directory. 

Working with unit directories offers extensive possibilities for configuration, as a unit

directory can contain the following files:

– config.pro blocks

– PSF files (Creo startkeys)

– batch files

Creating unit directory
A unit directory is created manually as a subdirectory in the system directory unit. 

The name of the unit directory does not have to correspond with the name of the unit that

is created in GENIUS TOOLS Project Configurator. Different names for a unit and a unit

directory can be advantageous when working with subunits, i. e. for a better overview of

the call hierarchy of settings.
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Selecting a unit directory
Specify the unit folder for a unit under Settings > Name/Members in the segment

Definition > Tag ID / directory.

When a directory is selected, its name becomes the unit tag ID. 

Please note: When creating a unit in the Create dialog a unit tag ID is assigned, which

can also be used without a unit directory, see example in chapter Using unit tag IDs. 

5.4.5  Organizational structure

Units offer a wide range of options for mapping the structure of a company, since the

settings for a unit can be made at several configuration levels. The configuration levels for

units are created in the standard group in the menu item Organizational Structure.

Basic structure 
If all units are organized in one level, no adjustments are needed in the organization tree.

Arranging units

Units are ordered alphabetically. Within a configuration level, you can place a unit in the

first position by inserting a space at the beginning of the unit name, e. g. " Switzerland".

This will also be applied to the display in the GENIUS TOOLS Starter App selection field.

Subunits for complex organization structures
Units can represent multiple configuration levels, e. g. they can be arranged by region,

country, location, city etc. A subordinated unit is called subunit.
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For example: You want to make settings for the Construction team, which is split between

three locations. The organizational structure could look like this.

All units are displayed on the right of the dialog Organization. You can select a unit there

and drag it to the desired position in the organization tree. The following applies: 

– Dropping a unit under a unit automatically creates a subunit.

– A unit can be used several times in different levels.

– A unit cannot be subordinated to a unit with an identical name.

Unit "Development" of type "Team"

Remove (1)

Does not delete the unit, only removes its entry in the organization tree. Click first on the

unit in the organization tree and then on the paper bin icon.

Display all subunits (2)

Shows the organization tree with all subunits.
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Hide all subunits (3)

Closes the organization tree.

Search 

Enter at least three letters to search through units and subunits in the organization tree (4)

or the selection list (5). The respective paths will open.

Unit paths (5)

All parent folders in which a unit is located are listed in the unit under Cross Reference.

Categorize units by types
For having a better overview of all units in GENIUS TOOLS Project Configurator it is useful

to arrange units into subdivision in the left Selection column.

Unit type (6)

Unit types are free generic terms, e.g. country or city, which are used for clarity in a

complex organizational structure. 

You can select an existing unit type or create a new one by writing into the field.

The entered name will immediately appear in the left group column and will line up

alphabetically in the existing unit type entries. Without an entry, the unit is created under

the type Unit.

Please note: The arrangement of the units in types has no influence on the

organizational structure, i.e. the configuration hierarchy of the project settings.

5.4.6  Call hierarchy for subunits

The more subunits you have, the more difficult it becomes to track at which configuration

levels settings are made and possibly overwritten. You can see this in two locations:

1. in the Config tab of GENIUS TOOLS Starter App: config.pro blocks are listed by

directory.

2. in the project report under "config.pro": config.pro  blocks are listed with path

information.

Directory structure for files
In the units system directory all directories are located on one level, i. e. it is not visible

whether a directory contains settings for a unit or a subunit. For an easier overview at file

level, it may therefore be useful to adjust the unit directory names to reflect the call
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hierarchy. You can do this by giving the unit directory a different name to the unit you

create in GENIUS TOOLS Project Configurator.

Please note: The name of the unit directory becomes the unit tag ID when assigning

the directory to a unit. 

Examples for an easy overview of call hierarchy:

Unit directories by

country and city Unit directories by

country

5.4.7  Using unit tag IDs

A unit tag ID is an additional textual marking in a config.pro block that defines a unit and

limits the validity of the block to it. Unlike config.pro blocks that are located in a specific

Unit folder, config.pro blocks with a unit tag ID can be stored in all folders. They are

activated by the selection of the unit in GENIUS TOOLS Starter App.

This allows settings to be made for a unit even without assigning a unit folder to the unit. 

Creating units without a unit folder
When creating a unit in GENIUS TOOLS Project Configurator, a unit tag ID is suggested.

You can change the name of the unit tag ID thereafter in the Definition area. Do not select

a unit folder.
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Unit tag ID / folder name

Defines the tag ID for the unit. If you select a unit folder, its name will also be the name of

the unit tag ID. Unit folders are created manually in configuration\units.

The tag ID preset in the input field can be:

Retained/ overwritten: Defines the unit tag ID. Tag IDs must not contain characters

that are invalid for file names, such as ~ " # % & * : < > ? / \ { | }.

The unit directory preset in the input field can be:

Retained / replaced: Assigns an existing unit folder to the unit; the name of the folder

becomes the unit tag ID (case-insensitive). 

Please note: The name of the unit which users can choose in GENIUS TOOLS Starter

App can be freely set by the administrator and does not necessarily have to correspond

to the name of the unit folder. 

Use case
In a company two sub-departments (Amsterdam, Berlin) of the Europe division are to work

together on five projects. In two projects (C, D) of the five different license extensions

should be used: Amsterdam should work with AAX, Berlin with BMX.

Initial situation: A unit folder with the name Europe is located in the units system folder

and contains the Creo configuration options (config.pro blocks) for the unit Europe.

Procedure: 

In GENIUS TOOLS Project Configurator

1. In the main page Organization main page go to the Select section and click the Plus

button, see Creating units. 

2. Create a unit with the name “Amsterdam” and the tag ID "amsterdam".

3. Create a unit with the name “Berlin” and the tag ID "berlin".

4. Do not assign any unit folders to these units.

5. Add the two units in the organization tree under the unit Europe. 

At file level

6. Create a config.pro block named config_lic.amsterdam.pro.

7. Enter the license extensions for AAX.

8. Create a config.pro block named config_aax.berlin.pro.

9. Enter the license extensions for BMX.

10.Place the two files in the project folder for project C.

11.Place the two files in the project folder for project D. 
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Result: The license extensions AAX and BMX can be restricted to units for projects C and D

without having to create new projects. 

Advantage: Without tag ID four projects would be necessary: Project C with AAX/ with

BMX and Project D with AAX / with BMX.

5.4.7.1  Project options with several unit tag IDs

A config.pro block with a unit tag ID can be used as a project option in one or more

projects. A project option can be limited to one unit by adding a single unit tag ID, but it

can also contain multiple tag IDs.

Validity
When using multiple unit tag IDs, all conditions set by the tag IDs must be met. 

Example: Validity of a config.pro block

A company has the units Construction and Hamburg, but no unit MBD. This means the

config.pro block config_lic.hamburg.construction.mbd.pro is valid if the unit Construction

and the unit Hamburg and the combined project option MBD is selected.

Usage
Using multiple unit tag IDs is useful when you have subunits in different configuration

levels.

Example: Config.pro block in multiple levels.

For project A, the team Construction in Manchester, but not in Hamburg, is to be given

NC as an option on the project. 

Solution: 1. The units Manchester and Construction are created in GENIUS TOOLS

Project Configurator. 

2. A config.pro block with the name config_lic_nc.manchester.construction.nc.pro is

created in the project folder of project A.

3. The project option NC is defined according to requirements (e.g. license extensions),

see Single project options.
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Result: The construction team in Manchester can activate the project option NC on

project A. 

Advantage: The project option NC is not available to all members of the Construction

unit, as would be the case if the Config.pro block were located in the Construction unit

directory.

5.5  Configuring global environments

The next sections explain the potential of the GENIUS TOOLS Starter configuration option.

This section describes the basic general configuration that is required for each system. This

general configuration is represented by the standard group in the Configuration page.

The Standard  group for global settings is always present on the Configuration 

 page.

Please note: The group Standard contains global, system-wide configuration settings.

This group does not have any members, you cannot assign users or computers to it.

The following settings can be specified for all groups:

– GENIUS TOOLS Starter App

– Additional Environmental Settings

– Synchronization

– GENIUS TOOLS License Manager

– Network Connections

– Creo ParametricCreo Elements/Direct Modeling

– Windchill Settings

Settings that deviate from the global configuration can be defined for computer groups,

user groups and units. For information on how to configure such groups, please refer to

Configuring heterogeneous environments. Additionally, you can define specific settings

for projects, see Creating projects.

For more information on how to configure deviations from this global configuration,

please refer to Deviations from the default configuration.

Please note: In order to work with data for other CAD systems in the future, the entire

directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult

the comparison of the old and new directory structure. The adjustment of the paths is

done automatically during an update. 
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5.5.1  GENIUS TOOLS Starter App

For information on settings for GENIUS TOOLS Starter App, please refer to Settings for

GENIUS TOOLS Starter App.

5.5.2  Additional environment variables

You can define environment variables that are assigned to the client workstation in a Creo

session under Additional Environment Settings. This allows you to define additional,

company-specific variables that are available after starting Creo without having to use

batch files. For a list of the environment variables created or modified, please refer to the

installation document (GENIUS TOOLS Starter Installation.pdf). The table in the installation

document also lists the corresponding deprecated environment variables, which are still

being generated for compatibility purposes.

Name

Enter the name of the environment variable here.

Value

Enter the value of the environment variable here.

Delete

Click the recycle bin icon to the right of the value input field to delete the line.

5.5.3  Synchronization

Synchronization allows for having all important files available locally on the local

workstation. This ensures the fastest possible access to these files. 

No toolkit applications will be synchronized while Creo is running.

Please note: Options that cannot be selected in this dialog box can be changed in

GENIUS TOOLS Environment Administrator.

u General

Activate synchronization

Shows whether synchronization from the Caddepot to the Cadpool directory is active. If

synchronization is deactivated, all computers will only operate locally. Synchronization is

activated/deactivated with the Modify function of GENIUS TOOLS Environment

Administrator (Step 3 > Client settings).

Target directory

Defines the Cadpool directory on the client workstation.
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Please note: Changing this entry leads to an initial installation of GENIUS TOOLS Starter

App on the client.

Synchronization interval (minutes)

Specifies the interval at which synchronization is performed in minutes.

Please note: For modifications of the synchronization interval to take effect, GENIUS

TOOLS Starter App has to be restarted.

Start client with windows

Determines whether GENIUS TOOLS Starter App should be started automatically with

Windows. 

Save result to Caddepot directory

Determines whether the result of the synchronization should be transferred to the server.

This includes the end time of the last synchronization, the number of copied files,

warnings and errors. The user needs write access in the Serveronly folder. 

Yes: The result of the synchronization is saved as <hostname>.log in

caddepot\serveronly\_SyncResults.

No: The result is not transferred to the server.

u Server

Checksum validation

Shows whether the checksum of a synchronized file is matched with that of the file on the

server. The settings for validating checksums are entered in GENIUS TOOLS Environment

Administrator with the Modify function (Step 2 > Synchronization server settings).

Yes: A checksum is determined for each transferred file and matched with the checksum

from the server. If these differ, the file will be requested again.

No: Files are only copied.

Warning: Activating checksum verification can significantly slow data transfer.

Server name

Displays the name of the synchronization server.

Comment

Displays the description for the server.

Synchronization type

File system: Each file is copied when synchronized.

Service: GENIUS TOOLS Starter Service checks all files for changes and updates only

these changes during synchronization. 

Server path

The UNC path to the synchronization server.
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5.5.4  GENIUS TOOLS License Manager

In order to use the full version of GENIUS TOOLS Starter, you will need a connection to

GENIUS TOOLS License Manager. You can define the server from which GENIUS TOOLS

Starter App should obtain licenses. The specifications for license servers are possible for

the system-wide settings as well as for groups and units.

Please note: If no license server is registered or if it is deactivated, only Creo projects

that have an academic or home-use license can be started.

u GENIUS TOOLS License Manager

Active

Activate/deactivate the license server(s).

License server(s)

Enter one or more license servers in the notation Port@Servername (e.g.

7766@<licenseservername>). Separate a series of license servers with semicolons.

Comment

An optional comment on the license server(s).

Hint: The used license server can be found in GT_LIC_SERVER in Creo. You can use this

variable, for example, in GENIUS TOOLS for Creo.

5.5.5  Network connections

u Network drive

Here you can connect a shared network folder that will not be synchronized.

Connect

Specify whether to map the network drive.

Yes: The network drive is mapped when GENIUS TOOLS Starter App is started. If a

drive with the specified drive letter already exists, this drive will be disconnected and

then re-connected according to the configuration, but only if it is not already the drive

to be mapped. This connection will remain active after you stop Creo.

No: Network drive is not mapped. Use this option if the drive mapping is already

established by other means, such as a Windows login script.

UNC path

Specifies the path to any folder on the server.

Usually given as a UNC path: \\COMPUTER\CreoData.

Drive letter

Assigns a drive letter that the drive is mapped to.
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Remap drive

Comparable to the Windows function map network drive.

Yes: After restarting the computer the drive will connect automatically.

No: The drive will not be remapped after a restart.

u User drive

Here you can map an additional user-defined drive.

5.5.6  Creo settings

In Creo settings you can define the behavior of Creo. Click on Application, Start, Cleanup

or Write to switch between tabs.

You can set the behavior here as a default for all settings (standard) as well as for groups

and units. You can also specify settings directly for individual projects, which will overwrite

all data specified here for a unit or group. (Projects > Creo Parametric > Select project >

Creo tab.)

The tabs Application, Start, Cleanup and Write in the Creo Parametric settings dialog.

5.5.6.1  Application

u Startup settings

Creo install path

Enter a directory on the workstation that has Creo installed, e.g. D:\PTC\Creo6.0.

Creo startkey

Specify the startkey (PSF file) of the respective Creo installation in the directory defined

above. You can either give a file name (parametric.psf) or a complete path 

(D:\PTC\Creo 6.0.2.0\Parametric\bin\parametric1.psf).
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Warning: If several keys are permitted for a project (in the Licences tab), the startkey

will become the default setting for the selection field in GENIUS TOOLS Starter App, i. e.

users will be able to choose another startkey.  

Startup directory

Enter the working directory of Creo.

Data directory

Enter the data directory to be used. The data directory is the main directory of an

operating environment containing Creo-related data.

The following data is stored in the data directory:

– Libraries: all library parts and their directories with MNU file

– Configuration: bend table, search.pro, hole chart, DTL file for drawing

representation, DMT file for colors in Creo, FMT file for displaying parts lists in the

browser

– Materials: material files for Creo in the MAT format

– ModelCheck: configuration files for ModelCheck

– NC:  templates and configurations for NC machining.

– Drawings: files for drawing frames, notes and symbols

Please note: The files config_*.pro, config_*.sup and customization.ui can be stored

separately from the data structure due to their potential multiple use. If you want to use

project-specific configuration files, set the folder for them as the project folder in

GENIUS TOOLS Project Configurator > Projects > Creo.

Language

The language in which Creo should run can be specified. If no setting is selected, Creo

Parametric will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer, will be set to that language.

Enable stop batches

Yes: Additional batch files can be executed after Creo has been stopped.

No: No stop batch files can be executed after Creo has been stopped.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens.

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the following directories in the configuration directory:

plot, standard, units, projects and users.



92GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

u Creo Parametric directories

The input fields are described in the chapter Workspace for Windchill.

u Plot configuration

Trail folder

Creo trail files, recording all production steps, are written to this directory, e.g. %TEMP%

\Proe.

Plot configuration folder

This directory contains the configuration files (PCF and PNT) for the plotters, e.g. %

GTS_ROOT_DIR%\parametric\configuration\plot.

Plot file folder

Directory on the workstation in which Creo stores the plot files. e.g: C:\Temp.

u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

Private config.pro

Name of a user-defined config.pro file. It is appended to the config_*.pro files in the users,

projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to

the userdata directory, as well as the access right Can save personal Config.pro file [to

userdata directory] on server.

See also Config tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file. It replaces any customization.ui file in the

users, projects, units and/or standard directories. See also UI tab in GENIUS TOOLS Starter

App.

5.5.6.2  Start

In this tab you can define the start behavior of all Creo Parametric projects.

For managing the behavior of a single project, go to the Start tab in Projects main menu.

u Startup Settings

Creo startkey

Specify the license key (PSF file) of the respective Creo installation. The query for license

keys corresponds to the general query sequence: Standard > Unit > Computer group >

User group > Project.

You can either enter a file name (e. g. parametric.psf) or a complete path (e. g. D:



93GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

\PTC\Creo 9.0.0.0\Parametric\bin\parametric.psf). If a Creo startkey has not been

synchronized to the user computer, this startkey cannot be displayed to the user for

selection. Make sure that the settings in the groups and the display behavior in the

licenses tab (add versus overwrite) are correct.

Warning: The behavior of the startkey will change, if multiple keys are permitted for a

project in the Creo Startkey Konfiguration section below.

– If the entry is left empty, users must actively select a startkey in GENIUS TOOLS Starter

App before being able to open a project.

– If a startkey is entered here, it will become the default setting for the selection field in

GENIUS TOOLS Starter App and users will be able to choose another startkey.  

Startup folder

Enter the working directory of Creo.

Language

The language in which Creo should run can be specified. If no setting is selected, Creo

Parametric will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: <language>: This language is used, and the language variable (LANG,

if defined on the application computer, will be set to that language.

Show only installed languages

By default only languages of the installed Creo versions are displayed in the drop-down

menu (see above setting). This input overwrites any groups settings.

Yes: Menu contains only installed Creo languages.

No (default): Menu contains all languages supported by Creo.

Enable stop batches

Yes: Additional batch files can be executed after Creo has been stopped.

No: No stop batch files can be executed after Creo has been stopped.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the following directories in the configuration directory:

plot, standard, units, projects and users.

u License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,

the maximum borrow duration is determined by the environment variable

LM_BORROW_DURATION. Project Configurator does not check whether the value you enter is
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valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.

u Creo startkey

Synchronize Creo startkey

You can add Creo startkeys (PSF files) for each project in the project directory under

configuration. For each PSF file, a matching BAT file will be created automatically. If you

only want to copy startkeys required for a specific project to the application computers,

set Copy project-related startkey only to Yes.

Yes: Creo startkeys and any startkeys stored in the project directory are copied to the

BIN directory of the Creo installation before project selection.

Yes, cleanup before: All startkeys in the bin directory of the specified Creo version are

deleted before synchronization, except cocreatesim.psf und gts.psf. This option can

only be set for groups and units, not for projects.

Warning: Setting this option may lead to invalid projects, if no other Creo startkey(s)

are synchronized.  

No: Creo startkeys will not be synchronized to application computers.

Please note: The key synchronization setting is a general settings which will only be

used for a project if the project does not have its own specific key synchronization

setting.

Copy project-related startkey only

Only the startkey required for a project is copied. This option can only be used if the

above option Synchronize Creo startkey is set to Yes. 

Yes: Only the startkey relevant to a project is copied.

No: All PSF files stored in the project folder will be copied as startkeys.

u Creo License Server

Creo license server 

Select the Creo license servers to be used for the group, unit or standard. The list is

created in Resources > Creo license servers. 

No selection (default): The license server, which is specified in the Creo startkey (PSF

file), is used.

All: The corresponding license server is used.

u Licenses

Show licenses

Specifies whether the licenses specified in a project are displayed in the licenses tab of
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GENIUS TOOLS Starter App.

Yes: Creo licenses are listed. The license status is not obtained; validation is possible

by using the Analyze Licenses function.

No: Creo licenses are displayed. The settings Get extensions, Calculate licenses by

extension and Identify license users can not be utilized.

PTC license reusable per host

State whether your PTC licenses can be used several times.

Yes: Use this option if you have DUP_GROUP in your PTC license file. The license

validation will calculate the free PTC licenses in a way that PTC licenses that are

already in use by another session on the same application computer will show an

amount of at least one, making the project valid.

No: Use this option if you are unsure or cannot find DUP_GROUP in your PTC license

file.

Please note: For this option to produce the correct result, the PTC license must contain

the keyword DUP_GROUP according to CS234779. This information cannot be

determined by GENIUS TOOLS Starter App.

Get extensions

Define whether extensions should be queried. To use this setting, Show licenses has to be

set to Yes.

Yes: In addition to the basic license, extensions are also queried on the license server.

No: Only the basic license is queried.

Calculate licenses by extensions

Define whether a free license is calculated based on the basic license or on extensions. To

use this setting, Get extensions has to be set to Yes.

Yes: Extensions are also used for license calculation.

No: Licenses are calculated on the basic license.

Identify license users 

Define whether users of a license are identified.

Yes: User names are displayed on the client as a tooltip of the corresponding license

name. The Windows user name is replaced by the GENIUS TOOLS Starter alias.

No: No user names are obtained or displayed.

Please note: If the alias should be displayed, the users have to be configured under

Resources > Users. Otherwise, the Windows user name will be displayed.

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The license servers are pinged

before the license query is started. If the server does not respond to the ping, the query

will still be executed.
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The duration you enter is also used as a maximum time for the license query. 

If you expect licenses to be unavailable form time to time, set the timeout to 0, which

means that there is no timeout specified.

Default: 0 (no timeout specified)

u Creo startkey

Synchronize Creo startkey

You can add Creo startkeys (PSF files) for each project in the project directory under

configuration. For each PSF file, a matching BAT file will be created automatically. If you

only want to copy startkeys required for a specific project to the application computers,

set Copy project-related startkey only to Yes.

Yes: Creo startkeys and any startkeys stored in the project directory are copied to the

BIN directory of the Creo installation before project selection.

Yes, cleanup before: All startkeys in the bin directory of the specified Creo version are

deleted before synchronization, except cocreatesim.psf und gts.psf. This option can

only be set for groups and units, not for projects.

Warning: Setting this option may lead to invalid projects, if no other Creo startkey(s)

are synchronized.  

No: Creo startkeys will not be synchronized to application computers.

Please note: The key synchronization setting is a general settings which will only be

used for a project if the project does not have its own specific key synchronization

setting.

Copy project-related startkey only

Only the startkey required for a project is copied. This option can only be used if the

above option Synchronize Creo startkey is set to Yes. 

Yes: Only the startkey relevant to a project is copied.

No: All PSF files stored in the project folder will be copied as startkeys.

5.5.6.3  Cleanup

Configuration files of Creo Parametric are not overwritten by default. If a new file is to be

created, a previous deletion of the old configuration file is necessary. Here, you can

manage the cleanup settings of GENIUS TOOLS Starter App for Creo projects. 

u Text directory

Define whether following configuration files are deleted or retained in the text directory of

a Creo installation: config.pro, config.sup, customization.ui.

Yes: Delete
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No: Retain

Please note: Make sure the user has access rights to delete files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in Programs.

u Home directory

Config.pro

Determines whether a config.pro file in the user's home directory is deleted or retained.

Yes: Delete

No: Retain

Customization.ui

Determines whether a customization.ui file in the Settings directory in PTC_WF_ROOT is

deleted or retained.

Yes: Delete

No: Retain

u Startup directory

Define whether following old configuration files are deleted or retained in the text

directory of a Creo installation: config.pro, customization.ui, config.val.

Yes: Delete

No: Retain

5.5.6.4  Write

Configuration files for Creo can be located in three different places, which can affect the

configuration of Creo. Here, you can influence the copy settings of GENIUS TOOLS Starter

and define target directories.

Warning: A new configuration file will only be written if no configuration file is yet

stored at the location. Use the settings in the Cleanup tab to avoid difficulties.

u Target directories

Config.pro 

Select the directory to which the config.pro file will be copied. If no directory is selected,

the file will be copied to the home directory.

Text: The config.pro file is copied to the text directory of the Creo installation.

Home (Default): The config.pro file is copied to the home directory of the user.

Start: The config.pro file is copied to the startup directory.

Please note: Make sure the user has access rights to create files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in the Programs

directory.
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Customization.ui

Select the directory to which the customization.ui file will be copied. If no directory is

selected, the file will be copied to PTC_WF_ROOT.

PTC_WF_ROOT: When existing, the creo_parametric__admin_customization.ui file is

copied to the text directory. The creo_parametric_customization.ui file is copied to the

Settings directory in PTC_WF_ROOT.

Start: When existing, the creo_parametric__admin_customization.ui file is copied to the

text directory. The creo_parametric_customization.ui file is copied to the Creo startup

directory.

Please note: If Creo is to read the customization.ui file from the startup directory, the

following option must be set in the config.pro file: load_ui_customization_run_dir
yes.

u Config Handling

Specify whether the following configuration files should be written.

Please note: To copy current configuration files, the corresponding files in the target

directory have to be deleted first (see Cleanup tab). This makes sure that the config.pro

settings defined by the administrator will always be used.

Config.pro

Yes: A config.pro is compiled and copied to the target directory unless a config.pro file

exists there already.

No: Writing config.pro is skipped.

Config.sup

Yes: If a config.sup is found in the project folder, it will be copied to the target directory

unless a config.sup file exists there already.

No: Writing config.sup is skipped.

Customization.ui

Yes: If a customization.ui is found in the project folder, it will be copied to the target

directory unless a customization.ui file exists there already.

No: Writing customization.ui is skipped.

Config.val

Yes: If a config.val is found in the project folder, it will be copied to the target directory

unless a config.val file exists there already.

No: Writing config.val is skipped.

5.5.7  Creo Elements/Direct Modeling

Under Creo Elements/Direct Modeling you can define the behavior of this application.

Click Application, Start and Delete to switch between tabs.
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You can specify the standard settings here, as well as settings for units and groups. Direct

project settings are also possible, under Projects > Creo Elements/Direct Modeling > Select

Project > Modeling tab.

5.5.7.1  Application

u Application

Creo Elements/Direct install path

Enter a directory on the user computer which has Creo Elements/Direct Modeling

installed.

Allow interactive customization

Defines whether interactive customization are allowed.

Yes:  Interactive customization are allowed.

No:  Interactive customization are not allowed. The variable

SDDISALLOWINTERACTIVECUSTOMIZATION is set.

Store UI layout files

Defines whether user specific files (*_fluentui_layout.def) are saved. 

Yes: Files are saved.

No: Files are not saved. The variable SDDONTSTOREUILAYOUTFILES is set.

u Plot configuration
HPGL plotting

Specify whether the plot settings from Power Extensions (PowerX_Styles\plotdefs) are used.

u User settings

Configuration directory

You can store customized configuration files of users in the userdata directory.

5.5.7.2  Start

u  Startup settings

Startup directory

Enter the working directory of Creo Elements/Direct Modeling.

Language

The language in which Creo Elements/Direct Modeling starts can be specified. If no setting

is selected, the application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer
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Synchronize with project start

Defines whether project data is to be synchronized before a project opens.

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

elements_direct\configuration directory.

u Creo Elements/Direct license server

Creo Elements/Direct license server

Enter the license server that should be used for the selected group or unit. 

No input (default): 

u Licenses

Show licenses

Specifies whether the licenses specified in a project are displayed in the licenses tab of

GENIUS TOOLS Starter App.

Yes: Creo licenses are listed. The license status is not obtained; validation is possible

by using the Analyze Licenses function.

No: Creo licenses are displayed. The settings Get extensions, Calculate licenses by

extension and Identify license users can not be utilized.

Identify license users 

Define whether users of a license are identified.

Yes: User names are displayed on the client as a tooltip of the corresponding license

name. The Windows user name is replaced by the GENIUS TOOLS Starter alias.

No: No user names are obtained or displayed.

Please note: If the alias should be displayed, the users have to be configured under

Resources > Users. Otherwise, the Windows user name will be displayed.

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The license servers are pinged

before the license query is started. If the server does not respond to the ping, the query

will still be executed.

The duration you enter is also used as a maximum time for the license query. 

If you expect licenses to be unavailable form time to time, set the timeout to 0, which

means that there is no timeout specified.

Default: 0 (no timeout specified)

5.5.7.3  Cleanup

Configuration files of Creo Elements/Direct Modeling are not overwritten by default. If a

new file is to be created, a previous deletion of the old configuration file is necessary.
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Here, you can manage the cleanup settings of GENIUS TOOLS Starter App for projects. 

u User directory

SolidPower directory

Determines whether the SolidPower settings directory in the user directory is deleted

before project start.

Yes: Delete

No: Retain

Default settings (LSP files)

Determines whether all LSP-files are deleted from the Default_Settings directory.

Yes: Delete

No: Retain

Further files or directories

Specify additional files or directories with user settings shall be deleted. The specification

is relative to the user directory, e. g. ANNOTATION\am_fluentui_layout.def

Yes: Delete

No: Retain

5.5.8  Windchill settings

For filling out this tab, read the chapter Automatic Windchill server registration. 

5.6  Configuring heterogeneous environments: groups and
units

IT landscapes very seldom have a homogeneous structure. There are different hardware

setups and different user requirements, so that Creo configuration differences arise

automatically and heterogeneous environments are created. GENIUS TOOLS Starter has

been designed to meet these requirements and makes it possible, to organize similar

configurations into groups or units. In this way, you can define group-specific

configurations for Creo and PTC data management software (e.g., PDM Windchill), as well

as make settings for GENIUS TOOLS Starter App and for data synchronization. Please refer

to Deviations from the default configuration for an example of how to set a different UI

language for Creo users.

Differences from the standard configuration, that is, from the system-wide settings in the

Standard group, can be defined for the following groups in the Configuration  page:

–  units (1)

–  user groups (2)

–  computer groups (3)
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Unlike the Standard group, groups and units have members that can be entered

individually or dynamically. Use Units to assign users dynamically through an LDAP

connection. This is done through a role-based assignment, see chapter Accessing

Windows user management.

Settings in GENIUS TOOLS Project Configurator are made there for the different

configuration levels. Select a unit or group to view the group specific Settings. You may

not make any specification, i. e. the selection field remains empty. The following applies: 

– If the setting remains empty, the settings of the higher configuration level are applied. 

– If all settings remain empty, i. e. the configuration level Standard (global) and all

subordinate levels, the default setting of the software applies.

Empty selection field

Inherited settings are displayed in gray.

Please note: If you do not specify a setting for a group or unit, the group or unit will

inherit the setting according to the configuration hierarchy for project settings.
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5.6.1  Configuration hierarchy of settings

For units and groups, the Creo configuration options set by Config.pro blocks as well as

batch files located in the respective directory apply, and the settings made in GENIUS

TOOLS Project Configurator, such as the use of Creo startkey and license server.

Please note: The configuration logic has been changed with the introduction of Units

as of version 6.0.1, see Configuration Hierarchy.

The following sequence for settings in GENIUS TOOLS Project Configurator applies: 

1. System directory Standard / Group Standard: Global settings, no subfolders.

2. System directory units and subfolders: One subfolder per unit. The selection of different

subfolders is possible by creating subordinate units (subunits).

Warning: If you work with subunits, the configuration order depends on the structure

you create in GENIUS TOOLS Project Configurator. See chapter Creating organizational

structures with units.

3. Settings for user groups

4. Settings for computer groups

5. System folder projects and subfolders: One subfolder per project.

6. System folder users: One subfolder per user.

Configuration sequence of the settings for a Starter project

5.6.2  User and computer groups

By assigning a user or computer to a group, you can configure for this user/computer

using the settings of its group.

The assignment of users and computers to a group is permanent and can only be done

once, i. e. an element can only ever be assigned to exactly one group. For more flexible

work, use units.

 User groups
In a concept similar to computer groups, users can be organized into user groups. User

groups are typically used to define function access in GENIUS TOOLS Starter for a certain
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number of users, or to define the UI language independently of the hardware used. A user

group should contain all settings for this group that deviate from the general default

configuration.

Users are permanently assigned to a user group. If a user has to be added to or removed

from a user group, you have to change the assignment manually in the group's settings

under Members. (See also Assigning users to user groups.)

Each user can be assigned to only one user group.

 Computer groups
Computer groups organize similar hardware setups into groups to allow creating general

configuration settings for this hardware in GENIUS TOOLS Starter. A computer group

should contain all settings for this group that deviate from the general default

configuration.

Computers are permanently assigned to a computer group. If a computer has to be added

to or removed from a computer group, you have to change the assignment manually in

the group's settings under Members. (See also Assigning computers to computer groups.)

Each computer can be assigned to only one computer group.

The following sections explain how to work with groups and units and how to add items

(users or computers) to them.

5.6.2.1  Creating groups

To create new user group or computer groups, go to the Configuration page.
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Step 1: In the type of group (user or computer) you want to create and click on the Plus

button (1).

Step 2: In the new dialog, enter a name for the group.

Step 3: The input of a comment is optional.

Step 4: Click Create. 

The new group is displayed as button in the section for user groups    or computer

groups . You can now assign computers or users to the group, see chapter Defining

group members.

5.6.2.2  Deactivate user and computer groups

You may want to deactivate a user or computer group if you want to keep the group

configuration, but temporarily do not want to apply its settings, e. g. when testing.

To do so, activate the button Blocked (7) which is available in the Edit dialog as well as in

the User group section.  

Yes: The configuration will be disregarded for this user group.

No: The configuration will be applied.

5.6.2.3  Defining group members

When you assign a user or a computer to a group, the configuration settings for the

group will apply to the individual user or computer.

Select the group to which you want to add users or computers and open the edit dialog

with the button  (3).

Assigning users to a user group
To assign a user to a user group, a user entry must exist in the Ressourcen page under

Users. (See Users.) 

Please note: Each user can only be assigned to one user group.

In the Members section, select the Plus button (8). 

In the dialog that follows, select the users you want to add to the group.
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Finish the dialog box by clicking on either:

– Ok: Add selected users and close dialog box,

– Cancel: Close dialog box without adding selected users,

– Apply: Add selected users without closing dialog box.

Assigning computers to a computer group
To assign a computer a computer group, an entry must exist in the Resources page under

Computer. (See Computers.) 

Each computer is identified by its Windows computer name. 

Please note: Each computer can only be assigned to one computer group.

Open the Edit dialog in the computer group with the  button and proceed as with user

groups, see section above.

Removing users and computers from a group
To remove a user/computer from a group click the recycle bin icon (11) in the Members

section. There is a search funtion (10) for individual members.

Blocking users or computers
The Members section displays, whether a group member is blocked (12), which means that

GENIUS TOOLS Project Configurator will not apply any settings. This is useful, for example,

if a computer or user should remain assigned to a group, but the settings of the group

shall not apply temporarily to the computer/user, e. g. during tests.

Locking individual users or computer is done in the Resources area under Users or

Computers and is only possible in the List view.
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Blocking users in the Resources page

5.7  Deviations from the default configuration

This sections explains how to define a UI language as a user-defined setting as an example

for configuration deviations.

5.7.1  User-defined language

Before Creo starts, the Creo UI language can be set to one of the following: English,

German, Italian, French, Spanish, Japanese, Chinese (Simplified), Chinese (Traditional),

Korean, Russian, Brazilian Portuguese. The languages are provided for Creo by PTC.

Please note: GENIUS TOOLS Starter does not influence the way different locale settings

interact. For information on supported settings, please refer to the PTC website or the

product documentation.

The UI language for Creo can be defined on four different levels in GENIUS TOOLS Project

Configurator. The language can be set on four configuration levels. If you make settings

on several levels, the last specification is valid, i.e. specifications in a project overwrite the

specifications of groups, units, see Configuration hierarchy of settings.

– System-wide

Main menu Configuration > Creo Parametric > Organization tree: Standard > Tab: Start >

Startup settings

– Unit

Main menu Configuration > Creo Parametric > Organization tree: Select unit > Tab: Start

> Startup settings

– Group

Main menu Configuration > Creo Parametric > Select user or computer group > Tab: Start

> Startup 

– Project

Main menu Projects > Select project > Creo tab > Startup settings
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The following example procedure refers to group settings.

Example: Setting the UI language for a guest via a user group
Starting situation:

– A company is located in Germany.

– A British designer is tasked with working on a project with the company in Germany

for several weeks.

Procedure:

1. The system-wide setting for the Creo language is German. This is defined in the

default group Standard under Configuration > Creo Parametric in the tab Start >

Startup settings in the Language drop-down menu. 

2. Go to the Resources page, select Users and configure a new user with the Windows

user name for the British colleague.

3. Go to the Configuration page and create a new user group by clicking on the Plus

button, calling it, for example, Guests.

4. Select the new user group and open the Edit dialog with the pen icon. In the

members area click on the plus icon and add the user you have configured to the

new group.

5. Go in the Settings column to Creo Parametric and, under Startup settings > Language,

select English for the new user group,

5.8  Creating projects

Use GENIUS TOOLS Project Configurator to define configuration settings for Creo projects

with only a few clicks. You can distribute a company-specific or commercially available

environment to all workstations where it is needed. The projects you define are listed for

the Creo users in GENIUS TOOLS Starter app. The user can select and start a project from

the list.

With the help of GENIUS TOOLS Project Configurator, you can configure projects with just

a few mouse clicks  – so-called Starter projects – which are created in an individual or

readily available operating environment and which are then distributed to each user

computer.
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A Starter project can have an individual directory structure in which company-specific data

is stored as well as supporting additional applications or scripts. The configuration of a

Starter project is determined by the organizational structure, i. e. the settings are made in

the levels Standard, Unit, Project and User, see the chapter Configuration concept.

Creo Parametric-Projects can also be used to assign licenses to specific computers or

users, see Assigning Creo licenses to projects.

5.8.1  Types of projects

You can create Starter projects for all applications and assign project and data directories

to them, if available. Batch files can be stored in the respective project directories for all

projects. 

For the applications Creo Parametric and Creo Elements/Direct Modeling you can also

define the startup behavior, license servers and environment variables. The settings for

these applications are correspondingly more in-depth and are described in the

corresponding chapters.

All other applications can be created as Apps projects with simplified setting options.

The created Starter projects are displayed to the users in GENIUS TOOLS Starter App.

Access for defined user groups can be restricted to certain projects, see chapter

Restricting project access.

GENIUS TOOLS Starter App also automatically generates a project from applications, such

as KeyShot, that are installed on the user computer, see auto projects. Auto projects can,

like all projects, be configured in Standard, Unit, Project and User levels. For each Auto

Project, a new folder structure is created for this purpose, as well as a project directory. 

5.8.2  Creating a new project

To create a new project, go to the Projects page  and click Create (1). A new project (3)

is shown in the list with the name New Project and a number if there already is a project of

the same name. The new project becomes visible to the users as soon as you save your

changes to the database.

You can create projects for all applications listed under Application type. Applications are:

Creo Parametric, Creo Direct, Creo Simulate, Creo Layout and Creo Options Modeler. In

Apps you can create projects that run with other programs. (See chapter App-Projects:

Creating projects of other applications.)

Click on a project in the projects list to edit the project details in the right pane. Note that

there are three tabs with project details: Creo (4), Windchill (5), Licences (6) and

Environment (7).
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Some input fields are preset, others come with a browse button to define directory paths.

Optional fields are given in brackets in the following description. If you do not specify the

optional settings, the general settings (standard) or the settings you may have made for

the unit, computer group, or user group, will be inherited by the project.

5.8.3  Displaying projects to users

Projects are displayed to users in GENIUS TOOLS Starter App as follow:

Display of projects in GENIUS TOOLS Starter App

Settings for project display (display name, project image and info text) are entered in

Projects > Application types > Tab: Creo > General.

For the display of project options, see Defining project options.

Project name (6)

A unique name without space characters that identifies a project, e.g. project_vers8_en.

The default setting New Project can be overwritten. The project name can be changed at

any time.

Display name (7)

A unique name that is displayed for the users in GENIUS TOOLS Starter App. In GENIUS

TOOLS Starter App, the projects will be listed alphabetically according to their display

name.

Information (8, optional)

A short text describing the project can be entered which will be shown below the display

name.

Project image (9, optional)

A picture can be uploaded that is displayed for the project in GENIUS TOOLS Starter App.

Use PNG or JPEG files.
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Sort projects
The order of projects displayed in GENIUS TOOLS Starter App can be defined here by

dragging and dropping projects in the Projects list or by sorting the projects alphabetically

with the Change sorting button (5) in the Projects column. 

Restrict project access
Projects can be restricted to users who belong to a defined role with specific access rights.

Members of this role can only view in GENIUS TOOLS Starter App the projects they have

access to. See chapter Restricting project access.

Restrict project access (10)

Projects can be restricted to users who are members of a role that has access to this

project. (Resources > Roles > Project access)

No (Default): The project is available to all users.

Yes: The project access is used as defined in a role.

Please note: If you set this option to Yes without assigning the project to a role, the

project will not be visible for any user.

5.8.4  Hiding and blocking projects

Projects that shall not be displayed to the user in GENIUS TOOLS Starter App can be

hidden in Projects > Application Type > Projects > Tab: Creo > Section: General.

Blocked projects are displayed in gray in GENIUS TOOLS Project Configurator. Hidden

projects are stroked through.

When you set Hide project to Yes, the project is not listed in GENIUS TOOLS Starter App,

but can still be started using a start parameter. This can be a useful option for Windchill

projects, for example.

Hide project

No (default): The project is listed in the UI.

Yes: The project is not displayed on the user interface in GENIUS TOOLS Starter App, but
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can be selected using the -gts:p:<project name> start parameter.

A blocked project, by contrast, cannot be started using a start parameter.

Block project 

No (default): The project can be accessed.

Yes: The project is not displayed and cannot be accessed on the application computer.

5.8.5  Copying a project

You can copy existing projects with the Copy button. If you want to take over the access

rights which are defined in the different roles, set the Restrict project access switch to Yes

before copying and answer in the following dialog the question about taking over the

accesses with Yes. (See also chapter Restricting project access.) 

Enter a new name and the remaining settings as in the previous chapter.

5.8.6  Projects for Creo Parametric

A configured Creo Parametric project consists of the following components:

– a defined Creo release or weekly version

– the licenses to be used (Creo-Startkeys)

– configuration files for settings of 

– functions and behavior of Creo Parametric (config.pro blocks) 

– user interface ((config.ui)

– additional applications, toolkit applications (GENIUS TOOLS for Creo)

– settings and link-ups for additional applications (batch files)

– Windchill availability in the Creo Parametric session

– start object templates, drawing frames

– project libraries

– plot settings

– ModelCheck configurations

– and many other settings relevant to working with Creo, such as 

– data referenced in the configuration files (colors, materials, templates etc. in the

data directory)

– data for other tasks (information documents, additional tools)
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Defining Creo project configurations
A project configuration consists of Creo object data – filed in the data directoy – and Creo

configuration files, which can be stored in any of the project-relevant directories standard,

units, projects and users. Separating the Creo object data from the Creo configuration data

and the additional applications ensures that Creo objects in an operating environment can

be used in multiple projects.

Both Creo object data and project-specific configuration files are included in the Startup

TOOLS data packages.

Settings for a project environment come from the following directories standard, units,

projects and users. (See also chapter on the call sequence of configuration files.)

1. Data directory:

<GTS-operatingenvironment>\parametric\data

2. Project directory:

<GTS-operatingenvironment>\parametric\configuration\projects\%GTS_PROJECT_DIR%

3. Unit directory:

<GTS-operatingenvironment>\parametric\configuration\units\%GTS_UNIT_DIR_NAME%

4. User directory: 

<GTS-operatingenvironment>\parametric\configuration\user\%USERNAME%

Please note: In order to work with data for other CAD systems in the future, the entire

directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult

the comparison of the old and new directory structure. The adjustment of the paths is

done automatically during an update. 

Data directory
The data directory is the main directory for data specific to an operating environment. All

Creo object data is stored in subdirectories for each operating environment, for example

<GTS_ROOT_DIR>\parametric\data\sut_int_de_creo9.

The Creo data is stored in the following directory structure within the data directory:

– config: bend table, search.pro, hole chart, DTL file for drawing representation, DMT

file for colors in Creo, FMT file for displaying parts lists in the browser

– library_dir: all library parts and their directories with MNU file.

– material_dir: material files for Creo in the MAT format
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– modelcheck_dir: configuration files for ModelCheck

– nc_dir: templates and configurations for NC machining

– Drawings (texture): files for drawing frames, notes and symbols

All references to data in the data directory are defined in project configuration files, i.e. in

a config.pro block (config_*.pro file) in the projects directory. If there are no project-

specific references, the general configuration files in the standard directory will be used,

i. e., the config_*.pro files under <GTS-OperatingEnv>\parametric\configuration\standard.

It is recommended to consistently use variables in your references. For example, a

reference to a data directory from a config_*.pro uses the variable $GTS_DATA.

Example: A reference in the configuration file config_sut_de_c9p_dir_file.pro in the

project directory project_creo9p_de reads

pro_library_dir $GTS_DATA\library_dir

This reference points to the directory library_dir within the data directory.

Hint: It is recommended to use variables where possible.

Please note: Many configuration options can be set only once in Creo. In this case, the

value of the latest entry is used, that is, the value from the file that is copied last. There

is a defined call hierarchy for the files, see Call hierarchy.

Project directory
The project directory defines which Creo operating environment is loaded. The project

directory houses all relevant Creo configuration files, i.e., config_*.pro, config_*.sup,

customization_*_.ui and config_*.val.

The configuration files can be placed in the standard directory for all projects (<GTS-

OperatingEnv>\parametric\configuration\standard), or in the project-specific directories

that are created automatically with each new project, e.g., <GTS-

OperatingEnv>\parametric\configuration\projects\project_creo5p_en. When you configure a

project, you can point to a project-specific directory for the configuration files. If you do

not configure a project-specific directory, the global configuration settings from the

standard directory will be used.

You can also place batch files both in the standard directory and in the project-specific

directory. The batch files will be run before starting the software. For more information on

batch files, please refer to Configuring an operating environment with batch files.

Unit directory
The unit directory defines which Creo operating environment is loaded. The unit directory

houses all relevant Creo configuration files, i.e., config_*.pro, config_*.sup,

customization_*_.ui and config_*.val.
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You can place batch files in the unit-specific directory. The batch files will be run before

starting the software. For more information on batch files, please refer to Configuring an

operating environment with batch files.

Specifying the Creo installation directory
There are three different ways of configuring the Creo installation directory and start

command:

1. On the Project Configurator Configuration page for the standard group or another

group or unit: Configuration > Select group > Creo settings > Creo install path

2. In the GENIUS TOOLS Starter project: Projects > Select project > Creo > Release > Given

path

3. Via the local Windows registry on the application computer: Projects > Select project >

Creo > Release > Select Creo version

Depending on your requirements, each way of defining the installation directory can make

sense.

Please note: In general, it is recommenden to determine the installation path via the

local Windows registry.

Consider the following criteria:

1. If you want to make sure that each application computer throughout your company

uses the same Creo version, configure the Creo installation directory via the

Configuration page. In this way, you will not have to specify it for each project.

2. If a variety of versions or weekly versions is in use, for example because you are

providing services for different customers, configure the Creo installation directory in

each project.

3. If local installations are inconsistent or not known in detail, fall back on the local

Windows registry to determine the Creo installation directory. You can specify which

Creo version to look for, the highest weekly version for which will be used.

5.8.6.1  Settings for Creo projects

After having created a new project, specify the following settings in the Creo tab.

u Creo Parametric

Release

Defines the Creo Parametric version to be used. A path can be configured, or determined

automatically from the registry of the application computer.

Fixed path: Select the Creo directory from the drop-down menu. This may differ from

the Creo directory for the standard settings. Without a directory defined here, the
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settings for the standard group will be used. (See Configuration > Creo Parametric >

Group: Standard > Application > General > Startup settings > Creo install path).

Creo versions: Select a Creo version. If you select Creo 9, for example, the installation

directory for the latest Creo 9 release on the application computer will be determined

from the registry.

Please note: Creo has to be installed locally on the application computer in order to

have registry entries available. The user has to have read permission in HKLM.

Lowest shipcode (optional)

Lowest usable weekly version. There is a dropdown list for versions up to Creo 4. Starting

with Creo 5, enter the required version manually in a four-digit format like 8.0.1.0.

Highest shipcode (optional)

Highest usable weekly version. There is a dropdown list for versions up to Creo 4. Starting

with Creo 5, enter the required version manually in a four-digit format like 8.0.1.0.

Project folder (optional)

Folder in configuration\projects. The files config.pro, config.sup, customization.ui and

config.val are copied as templates from this directory to the application computer.

Data folder (optional)

Main directory of an operating environment to which Creo-related data is saved.

Please note: The files config.pro, config.sup and customization.ui should be stored

separately from the data structure due to their potential multiple use. These

configuration files should be managed in the specific subdirectories of the configuration

directories Units, Projects, or Users, or in the Standard directory for global settings.

The next section Creo directories is explained in the chapter Workspace for Windchill.

5.8.6.2  Defining start behavior for a project

In the Start tab specify the start behavior of an individual project. These specifications

overwrite the specifications for the start behavior set for groups or the default settings

(main menu item Configuration > Group (select) > Creo Settings > Tab: Application > Area:

Startup behavior). For more information consult Configuration concept.

u Startup settings

Starting behaviour 

Select the application which will open the project.

Creo (default): The project is started with Creo.

External: The project is started with another application (e.g. SAP). For more information

got to chapter Linking projects with SAP.

If External is selected two additional fields open: 

External start command: Enter the path to the executable file that is to start the
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project.

Command arguments for external start: Enter commands that specify how the

executable file is started. Set the commands in quotation marks.

Creo startkey

The start command (PSF file) of the respective Creo installation. The directory of the Creo

installation is defined above under Release. You can also overwrite the default setting (e.g.

parametric.psf) and specify a path here, such as D:\PTC\Creo6\bin\proel.psf

Warning: If several keys are permitted for a project (in the Licences tab), the startkey

will become the default setting for the selection field in GENIUS TOOLS Starter App, i. e.

users will be able to choose another startkey.  

Please note: If a defined startkey is not available on the client computer, you can

choose to display the project in GENIUS TOOLS Starter App as follow (Go to

Configuration > Groups > GENIUS TOOLS Starter App > Projects > Display invalid

projects):

– Display with error warning: Project without a valid license is displayed with a red

background and cannot be started. (Select Yes, as error)

– Project is not displayed. (Select No)

Synchronize Creo startkey

Yes: The start key (PSF file) is copied from the project folder to the Creo BIN directory.

No: The start key is not copied, even if system-wide synchronization has been set up.

Please note: For this option, write permissions are required on the application

computer in the Creo BIN directory.

Please note: Take care when synchronizing startkeys. A configuration error may lead

to erroneous distribution of startkeys to application computers that should not have

defined licenses available.

Language /Show only installed languages

See chapter Language of a Creo project.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the following directories in the configuration directory:

plot, standard, units, projects and users.
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5.8.6.3  Language of a Creo project

The language of the user interface of Creo can be set in the Projects main page under Creo

Parametric > Select projects > Tab: Start > Startup settings. 

The following languages are available: English, German, Italian, French, Spanish, Japanese,

Chinese (simplified), Chinese (traditional), Korean, Russian, Brazilian Portuguese. Choose

one of the following setting:

Language

The language in which Creo should run can be specified. If no setting is selected, Creo

Parametric will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: <language>: This language is used, and the language variable (LANG,

if defined on the application computer, will be set to that language.

Show only installed languages

By default only languages of the installed Creo versions are displayed in the drop-down

menu (see above setting). This input overwrites any groups settings.

Yes: Menu contains only installed Creo languages.

No (default): Menu contains all languages supported by Creo.

Creo language as project option
Administrators can also grant users the possibility to select a language, see language

selection field.

5.8.6.4  Default settings for license borrowing

You can define the maximum duration of borrowing PTC and GENIUS TOOLS licences in

Creo Parametric > Projects > Tab: Start. This information overwrites the group and unit

specific settings.

u License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,

the maximum borrow duration is determined by the environment variable

LM_BORROW_DURATION. Project Configurator does not check whether the value you enter is

valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.
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u Creo License Server

Creo license server 

Select the Creo license servers to be used for the group, unit or standard. The list is

created in Resources > Creo license servers. 

No selection (default): The license server, which is specified in the Creo startkey (PSF

file), is used.

All: The corresponding license server is used.

5.8.6.5  Assigning Creo licenses to projects

A project can be started with a Creo license packages by assigning one or several Creo

startkey to it. A startkey is a configured start command that opens Creo with one or

several defined licenses or license extensions. Startkeys are PSF files located in PTC's bin

directory.

In the section Creo startkey configuration (Creo Parametric > Projects > Tab: Start) all

startkeys that have been created as a resource are listed. (See chapter Creating Creo

startkeys.) Startkeys checked in this dialog will be those that users can select in GENIUS

TOOLS Starter App. If users are provided with several keys to choose from, the number of

projects can be minimized. 

Individual startkeys can be locked independently of the assigned options to select for

users under Resources > Creo startkeys > Block: Yes/No. 

Administrators can create projects that either have 

1. one startkey or 

2. several startkeys that users can choose from in GENIUS TOOLS Starter App.

Projects with several startkeys can either 

2.1. have a startkey set as default or

2.2. use the startkey last selected by the user.

1. Projects with one startkey
In the Start tab select a startkey from the list in Creo Startkey Configuration.
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Projects > Start tab

You can specifically enter a startkey for a project in the above section Startup Settings, but

it is not necessary. (Tab: Start > Section: Startup Settings)

If you do, take care to enter the same PSF file. If the two entries are not identical, users

have to first chose one startkey in the selection dialog before being able to start a project.

Licenses tab > Startup Settings

2. Projects with several startkeys to choose from
If several startkeys are permitted for a project in the Licenses tab, users can select one of

them in GENIUS TOOLS Starter App:

Mehrere Startkeys in

der Registerkarte

Lizenzen

Auswahl eines Startkeys im Info-Bereich von

GENIUS TOOLS Starter App

1. Tick the Creo startkeys that are to be permitted for the project in Tab: Start>  Section:

Creo-Startkey Konfiguration.

2. Decide whether or not to fill in the field Creo startkey in the section Startup Settings (see

Figure 1). This gives you the following possibilities:
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2.1. Projects with several startkeys and a default startkey 
In the Startup Settings enter the Creo startkey that should be the standard in the selection

field in GENIUS TOOLS Starter App. Users then do not have to select a startkey before

being able to start a project. If users need another startkey, they have to activate it in t he

selection dialog.

If this field is left empty and there are multiple startkeys permitted for a project, there is no

default startkey set for selection.

2.2. Projects with several startkeys and without a default startkey 
If there is no startkey inputted in the section Startup Settings, GENIUS TOOLS Starter App

will start Creo with the startkey that was last selected by the user for this project. 

5.8.6.6  Assigning Creo license extensions to projects

In addition to selectable Creo start keys, you can create the option for license extensions

to be selected individually, i.e. independently of the start key for a project. Users see this

as a checkbox in a project.

Project options in GENIUS TOOLS Starter App: checkboxes for license extensions

Advantages: 

Assigning selectable license extensions to a project can reduce the number of Creo

startkeys created, and therefore reduce the number of projects available to users in

GENIUS TOOLS Starter App. If the license conditions allow it, you can, for example,

dispense with the selection of a Creo start key altogether by creating all license extensions

as project options

These project options are not created in GENIUS TOOLS Project Configurator, but with

config.pro blocks. The procedure is explained in the chapter Using project options. 
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5.8.6.7  Workspace for Windchill

Set workspace directories for Windchill and Creo in the dialog Creo Parametric directoires

in the Creo tab. 

You can also define these entries on a group-specific basis in the Configuration menu item

under Creo Parametric > Tab: Application.

u  Creo Parametric directories 

Windchill user root folder

Specify the PTC WF Root directory in which the workspace and user-specific Windchill

data are stored. The directory corresponds to the Creo favorites folder.

Please note: If you want to specify separate Windchill directories for various Creo

versions you can use variables like %GTS_PROERELEASE%, which will resolve to the

Creo version, e.g. Creo6, or %GTS_PROJECT_NAME% in building your path.

Windchill cache directory

Cache directory for caching of Windchill data. To use automatic server registration, the

Windchill cache directory must be located below the Windchill user root folder, see

chapter Automatic Windchill Server Registration.

Please note: Try not to modify this option. To change the storage location of the

cache, rather change the setting Windchill user root directory.

Creo Agent home directory 

Directory in which data relevant for Creo Agent, such as server information, is saved. We

recommend setting Creo Agent Home to %PTC_WF_ROOT%.

Please note: If you want to specify separate Windchill directories for various Creo

versions you can use variables like %GTS_PROERELEASE%, which will resolve to the

Creo version, e. g. Creo9 or %GTS_PROJECT_NAME% in building your path.

Use the Windchill tab is to register the servers. Detailed information about the procedure

are in the chapter Automatic Windchill server registration. 

Dynamic server settings for different Creo versions
When you change the Creo version, the local cache directories should be deleted from the

disk and re-created with the current Creo version. This means that when you use different

Creo versions, you also need to create different cache directories. Also, the storage

location for Windchill server registration information should be different.

There are two ways to ensure separate cache and server registration storage for different

projects:
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1. Configure independent Windchill user root directories for different projects.

2. Use variables in configuring the Windchill user root directory.

The following variables can typically be used:

Variable Description

%GTS_PROERELEASE% Returns the Creo version as Creo3, Creo4 etc.

%GTS_PROJECT_NAME% Returns the project name

%username% Returns the name of the Windows user

%computername% Returns the computer name

These variables can be used in the setting the path for the Windchill user root directory.

Example: D:\ptc\workspaces\%username%\

%GTS_PROERELEASE%\%GTS_PROJECT_NAME%

The Creo Agent home directory, where server registration information is saved, schould

also depend on the Windchill user root directory. To set this up, you can define a variable

for the Windchill user root directory under Configuration > Standard > Additional

Environment Settings.

Name Value

Creo Agent Home %PTC_WF_ROOT%

Making the Windchill user root directory dependent on the Creo version by using %

GTS_PROERELEASE% and making the Creo Agent home directory dependent on that via %

PTC_WF_ROOT% will lead to all server information and data being stored separately per

version.

If you also make the Windchill user root directory dependent on the project name using %

GTS_PROJECT_NAME%, the storage location will be project-dependent and will change with a

new Creo version.

Do not use %GTS_PROJECT_NAME% if you use GENIUS TOOLS Starter projects to manage

different Creo license packages, because you cannot use local workspaces for multiple

projects in this way.

5.8.7  Projects for Creo Elements/Direct Modeling

A Creo Elements/Direct Modeling project consists of configuration files, an operating

environment and data packages for standard parts.
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Please note:  The work with projects for Creo Elements/Direct Modeling is a feature

that requires a subscription license.

After having created a new project, specify the following settings in the Modeling and Start

tab.

These specifications overwrite the specifications for the start behavior set for groups or

the default settings (Configuration > Group (select) > Creo Settings > Tab: Application >

Area: Startup behavior). For more information consult Configuration concept.

Settings
In the Modeling tab, you define the settings for Creo Elements/Direct Modeling. The input

options correspond to those of the configuration settings for groups and units and are

described in Configuration > Creo Elements/Direct Modeling > Tab: Application.

Define startup behavior
In the Start tab specify the start behavior of a single project. The input options correspond

to those of the configuration settings for groups and units and are described in chapter

Configuration > Creo Elements/Direct Modeling > Tab: Start.

5.8.8  App-Projects: Creating projects of other applications

GENIUS TOOLS Starter allows you to also create projects that run on any other program.

An administrator can set up all needed programs and files and thus make GENIUS TOOLS

Starter App the central access point for users.

Projects that run on other programs are created and managed in the Projects menu item

in the Apps section This opens a dialog with the following, simplified settings: 

– general project settings

– complete start command

– startup directory

– project and data directory

The project directory can contain project-specific batch files which are executed at

program start or after the program ends. The call sequence for batch files for Apps project

is the same as for all projects. See chapter on Configuring an operating environment with

batch files for more information.

Setting up Apps projects
To set up projects that run on other applications, go to the Projects menu item in the

application type Apps and click the Plus button. 
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Dialog box for Apps projects

The general specifications are those for creating any new project and its display to users.

The order of projects displayed in GENIUS TOOLS Starter App can be defined here by

dragging and dropping projects in the Projects list or by sorting the projects alphabetically

with the Change sorting button (5) in the Projects column. 

Specify the required project and data directories (3) as well as the startup behavior (4)´

u App

Project directory (optional)

Directory below application\configuration\projects. Batch files are copied from this

directory to the  user computer and executed at project start.

Data directory (optional)

Directory below application\data. From this directory data packages are copied to the user

computer and applied at project start.

u Startup settings

Executable file

Enter the file that is to be started. It can either be an executable file (such as *.exe, *.bat) or

a file for which a standard application is available on the computer (such as *.docx, *.html).

Command line arguments

Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

Startup folder

Select the startup directory. 

5.8.9  Auto projects

Auto projects are Starter projects of an application for which only one project can be
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created. This project will be automatically created by GENIUS TOOLS Starter App with the

latest available software version on the user computer and will be displayed with an icon

of the application. 

Auto projects are generated from the following applications: Creo Elements/Direct

Drafting, Creo Illustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and

MathCad.

Please note: Auto projects are only available with a subscription license.

The applications are automatically searched on the user computer. If several versions are

installed, the latest version will be used. If the application is not installed on the user's

computer, the Auto project will not be displayed. 

In the main menu item Project collections you can set the display of the Auto projects in

GENIUS TOOLS Starter App, i. e. name (1), comment (2), icon (3) and color (4), as well as

their order via drag-and-drop (6). 

Individual Auto projects can be hidden in the user interface of GENIUS TOOLS Starter (5).

You can also hide all Auto projects for specific user groups in the user rights.

5.9  Making use of project options

Administrators can grant users the ability to select the following project options before

starting a project:



127GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

– Creo language (1)

– Creo startkey (2)

– company-specific project options for:

– license extensions, such as Simulation Live or Manikin,

– additional programs, such as Keyshot or Model Processor User,

– any configuration option defined in a Config.pro block.

The drop-down menus for languages and startkeys are defined in GENIUS TOOLS Project

Configurator, see chapter Defining project options.

This chapter explains how to create the checkboxes for project options. There are two

types of project options: single (3) and combined (4). 

Single project options

– available for selection in one or more projects

– created with basic config.pro blocks and are valid according to the call hierarchy for

config.pro blocks

Combined project options

– available for selection in one or more projects 

– combine configuration options from different directories and configuration levels

– useful for companies with complex organization structure

– created with conditional config.pro blocks and valid according to call hierarchy for

config.pro blocks if condition(s) are met.



128GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Creating single and combined project options: Overview
Administrators can create project options by placing a config.pro block in the required

configuration level (single project option) or by creating a conditional config.pro block

(combined project option). The following chapters explain the procedure step-by-step.

Basic config.pro block Conditional config.pro block 

without

GTS

config.pro

variables

with GTS

config.pro

variables

without GTS

config.pro

variables

with GTS

config.pro

variables

Validity according to call hierarchy according to call hierarchy and when

conditions are (set by tag ID) are met

Result

1) User

interface of

GENIUS

TOOLS

Starter App

no

checkbox

single project

option

grouped project

option

combined project

options are

always displayed;

single project

options appear

after selecting a

combined project

option

2)

configuratio

n options

are set

always after selection after selection after selection
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5.9.1  Single project options

The project options can be selected in checkboxes below the project name and in the

Options tab. The tab can be opened with the arrow symbol, which becomes visible if some

checkboxes cannot be displayed below the project. 

The order and display of the checkboxes can be defined, see below.

Creating single project options
A single project option can contain multiple configuration options, license extensions

and/or add-on programs.

Configuration files can be located in four subdirectories of the configuration directory: 

standard directory for global system settings, unit directory, project directory for individual

projects, and user directory for user-defined settings. 

Procedure:

– Decide to whom the project options should be available to. Settings can apply to all

("standard") or to individual units, projects or users. The settings are processed

according to the Call hierarchy for configuration files.

– Go the the corresponding directory, e.g.

<operatingenvironmentname>\configuration\projects\project_creo7p.

– Create a text file in this directory for each project option. The name must begin with

config and end with .pro, for example, config_1_lic_sim_live.pro.

– Enter the following necessary command:  ! gts_is_selectable = true.

– Specify further GTS config.pro variables in the file as required. The table below lists all

variables.



130GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Variables for displaying a project option (numbering see table)

GTS config.pro variable Specificat

ion/

Example

Description

1 ! gts_is_selectable = true/false Defines if the project option appears as

a checkbox (in the Options tab as well

as below the project name)

2 ! gts_selection_default = true/false Defines whether the project option is

selected by default or not, i. e. whether

the box is checked. Default: false.

3 ! gts_creo_lic = 379 385 License number(s) of the extension(s)

to be added. Multiple numbers must

be separated with empty space.

– if this entry is set, an icon key

appears next to the checkbox in the

project

– license numbers can be read from

the license.dat file in the licensing

folder under PTC/FLEXnet Admin

License Server

4 ! gts_display_name = Simulation

Live

display name in the Config tab

– if not specified, the file name is used
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GTS config.pro variable Specificat

ion/

Example

Description

(Real-time

simulation

)

5 ! gts_selection_name = Simulation

Live

display name in selected project and in

the Options tab

– if not specified, gts_display_name is

used

6 ! gts_selectable_pos = 1 specifies the position in the list of

project options. This does not change

the order in which the configuration

file is processed.

– if this command is not specified, the

project option will be placed after the

options with position and ordered

alphabetically

7 !
gts_creo_lic_display_name
=

Simulation

Lives

Tooltip text for license symbol (key)  

– if not specified, the line under License

name is empty

8 ! gts_description = Tooltip text for name of project option

– if not specified, the file name is used

9 ! gts_requires_base_lic = PROE_Fou

ndation

Defines condition: if the base license is

not available, the project option will be

deactivated, i. e. no checkbox is

displayed. 

– Multiple licenses must be separated

with empty space. The project option

will be deactivated, unless all of the

listed licenses are available.

10 !
gts_auto_activate_base_lic
=

PROE_Fou

ndation

Defines condition: If the base license is

available, the project option will be

preselected, i. e. the box is checked.
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GTS config.pro variable Specificat

ion/

Example

Description

– Multiple licenses must be separated

with empty space. The project option

will be deactivated, unless all of the

listed licenses are available.

– Take care not to simultaneously set

the variable !

gts_selection_default to true. 

If the file is to control an auxiliary application, specify the corresponding

configuration option, such as a protkdat entry. (Example: protkdat

$GTS_ROOT_DIR\configuration\application\protk_keyshot.dat). These entries do not

create icons next to the checkbox.

Example: Configuration for the "Simulation Live" project option in GENIUS TOOLS

Starter App

1. Choose the directory which controls the settings for the project (standard, units,

projects, users), here:

<nameofworkingenvironment>\configuration\projects\project_creo7p.  

2. Create a textfile with the name config_1_lic_sim_live.pro.

3. Enter the following specifications in the configuration file:

! gts_is_selectable = true

! gts_selection_default = true

! gts_creo_lic = 379

! gts_display_name = Simulation Live (Echtzeitsimulation)

! gts_selection_name = Simulation Live

! gts_selectable_pos = 3 

Result: Display in of a checkbox for the

"Simulation Live" project option in the

project Creo Parametric 7.0

gtpc_settingsApp_example.png

Arranging the checkboxes for single project options
The display of the checkboxes can be controlled in the selected project:
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1. To do this, select a group in the main menu item Configuration (or Standard for all

settings). 

2. In the item GENIUS TOOLS Starter App > Area: Options specify the number columns. 

Settings in GENIUS TOOLS Project

Configurator

Display in GENIUS TOOLS Starter App

5.9.2  Combined project options

Combined project options can contain configuration options, license extensions and/or

add-on programs. Combined project options offer possibilities that single project options

cannot, as they are created with conditional config.pro blocks.

– With one click, several configuration options can be activated that are located in

different directories and levels. (Use case 1)

– Combined project options can be stored in directories other than the project directories.

(Use case 2) 

–  After selection of a combined project option additional single project options can be

made available. (Use case 3 and 4)

 

Users must activate the checkbox of the project option in GENIUS TOOLS Starter App. The

underlying config.pro block is then read at project start.

1. Basics: Creating a combined project option
A combined project option appears as a selectable checkbox in GENIUS TOOL Starter App

after having created at least one conditional config.pro block with a free tag ID. 

A free tag ID is an additional textual marking on a config.pro block that defines a

combined project option and limits the validity of the block to it. The tag ID must not be

assigned to a unit, otherwise it can be freely choosen.

Example: config_lic.mbd.pro  – "mbd" is the free tag ID, if there is no unit called "mbd".

The functionality of a combined project option only comes into its own when you create

multiple config.pro blocks with identical tag IDs. These are read across folders and levels,
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i. e. the content of all config.pro blocks with identical tag IDs is combined (added). The

following rules apply:

– The configuration options specified in the combined project option are read at project

start if all conditions set by tag IDs are met. 

– If configuration options conflict, the option is applied according to the Call hierarchy

for configuration files.

– The first config.pro block with the free tag ID creates the needed checkbox of the

same name (here: mbd).

Use case 1: Different contents added across folders

Procedure: For one combined project option, assign one free tag ID to multiple files. The

first free tag ID creates the checkbox to select. 

1. Decide on which projects the project options should be available. Settings can apply

to all ("Standard") or to individual units, groups, projects, or users. 

2. Go to a folder you selected in (1).

3. Create a text file with a meaningful free tag ID, e. g. mbd. The name must start with

config and end with .freetagid.pro, e. g. config_lic.mbd.pro.

4. Specify the required Creo configuration setting(s) in the file. 

5. Repeat this for all config.pro blocks in all required folders and settings, for example: 

– config_abc.mbd.pro in the unit folder 

– config_lic.mbd.pro in the project folder

– config_mapkeys.mbd.pro in the user folder

Result: The combined project option "mbd" has been created, which contains Creo

configuration options from config.pro blocks from three different configuration levels.

2. Further use cases for one combined project option

2.1. Creating a combined project option with restriction to one unit

Combined project options can be restricted to one unit by adding a unit tag ID to a

config.pro blocks with a free tag ID.

A unit tag ID is a textual marker that restricts the validity of a config.pro block to a unit.

The difference to a config.pro module that is located in a specific unit directory, project

options with a unit tag ID can be located in all directories and can be activated by

selecting the unit – independent of the storage location.

A unit tag ID is assigned when creating a unit in GENIUS TOOLS Project Configurator, see

Using unit tag IDs.
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Please note: A config.pro block with a unit tag ID but without a free tag ID does not

generate a project option.

Use case 2: A project should have two different project options depending on the

selection of the unit available for selection.

Consult the example in Using unit tag IDs.

2.2. Creating a combined project option with restriction to several unit

A combined project option can be activated by multiple units, see Project options in a

multi-unit environment.

2.3. Creating a combined project option and further project options

You can create a combined project option that generates further single project options

after selection.

Before selection of the combined project

option mbd

After selection of the combined project option

mbd

Use case 3: When the project option METAL is selected, three additional single

project options (X, Y, Z) are displayed

Procedure: For a combined project option, assign one free tag ID to multiple files and

write GTS Config.pro variables single project options in each of these files.

1. Decide the configuration levels for which the project option should be available, i.e.

system wide ("Standard"), individual units, projects or users. 

2. Go to a directory you selected in (1).

3. Create a config.pro block with a free tag ID, e. g. Metall. The name of the text file

must start with config and end with .freetagid.pro, e. g. config_lic.metal.pro.

4. Write into this file the GTS config.pro variables

! gts_is_selectable = true

! gts_display_name = Cabling – “Cabling”  is the display name for the first single

project option that will appear after selecting the project option Metal.

5. Specify further required GTS config.pro variables and/or further Creo configuration

setting(s), see table.
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3. Creating multiple combined project options
Each free tag ID creates a combined project option, hence, if two free tag IDs are used in a

file name, there are two combined project options to choose from, e. g.

config.mbd.plastad.pro. If there is no checkbox for selection yet, it will be created.  

The order of the free tag IDs does not affect the validity of the Config.pro block. 

This case is typically used in connection with further project options (use case 4) or with

further configuration options (use case 5). 

3.1 Creating two combined project options that allow further project options

only after joint selection

Use case 4: When selecting the project options MBD and PLASTAD together, an

additional project option NC shall be displayed.

Initial situation: The config.pro blocks config_lic.mbd.pro and config_lic.plast.pro already

exist.

Procedure: Write GTS config.pro variables to a config.pro block to create a single

project option, and add the free tag IDs that already exist to the file name. 

1. Decide on which projects the two project option selections should be available

(Standard, unit, project or User).

2. Place a config.pro blokc (text file) in a directory you selected in (1).

3. Name the file config_lic.mbd.plast.pro.

4. Write in the file the GTS-Config.pro variables

! gts_is_selectable = true

! gts_display_name = NC   – “NC”  is the display name for the checkbox that will appear after selecting the project options MBD and PLASTAD.

5. Specify further required GTS config.pro variables and/or further Creo configuration

setting(s), see table.

3.2 Creating several grouped project options that set a configuration option

after common selection without allowing further project options

It may be useful to apply a configuration setting when two grouped project options are

selected without allowing users to choose the setting.

Use case 5: When selecting the project options MBD and PLASTAD together, Creo is

to be started with the license extension NC.

Initial situation: The config.pro blocks config_lic.mbd.pro and config_lic.plast.pro already

exist.

Procedure: Add the two existing free tag IDs to the config.pro block that contains

information for the license extension.
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1. Proceed as in use case 4, steps 1-3.

2. In the file config_lic.mbd.plast.pro specify the corresponding license extension in the

GTS config.pro variables, e. g. for NC-SHEETMETAL:

! gts_creo_lic = 116

5.10  Linking projects with SAP

With GENIUS TOOLS Starter 7.0.1 you have the possibility to open a Creo project with a

user-defined command. You can use this option, for example, to link Creo projects with

SAP-ECTR (SAP Engineering Control Center interface to PTC Creo).

To use other applications that start a Creo project, proceed as follows. 

1. Check Creo versions and information for licenses and license servers (Creo

startkey) 

Check that the Creo version defined in the Creo project in GENIUS TOOLS Starter matches

the Creo version that is to be started by the external application. The correct

parametric.exe is available by the environment variable PROE_START. 

Check that licenses and license servers defined in the Creo project in GENIUS TOOLS

Starter match the entries in the external application. We recommend using the gts.psf file

as Creo startkey for the external application. This ensures that the correct licenses and

license servers are used.

2. Change startup behavior of the project

In  GENIUS TOOLS Project Configurator in the Projects page, go to the corresponding

project and in the Start tab, go to the Startup settings section. Change the startup behavior

of the project from Creo to External.  Two further input fields open.

3. Enter information about the external start behavior 

In the field External start command, enter the path to the application (executable file) with

which the project is to be opened.

In the field Command line arguments for external start field, enter the commands with

which the executable file should be opened.

All other information about a project does not change. (See chapter Settings for Creo

projects.)
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5.11  Project collections

In the main menu item Project Collections you can organize individual projects into

collections, which are displayed to users in GENIUS TOOLS Starter App. This is especially

helpful for companies that work with many projects. 

Warning: Creating collections for projects is a feature in GENIUS TOOLS Starter from

version 6.0.1, which means that you need a subscription license to use it. Once you

have configured a project collection, you cannot go back to using perpetual licenses.

See also License-dependent features.

The order of both collections and individual projects can be defined here by using drag

and drop.

Project collections are displayed to all user groups, but within a collection only those

projects a user has access to are displayed. If a user has no access to any of the projects,

the button for the collection will not be displayed. There are company-specific project

collections, which can include any projects, and application-specific project collections,

which are comprised of all projects of an application.

A distinction is made between company-specific and application-specific project

collections. You can create company-specific project collections and assign individual

projects. Application-specific project collections, on the other hand, already contain all

projects that have been assigned to the an applications in the menu item projects, i. e.

Creo Parametric, Creo Elements/Direct Modeling as well as Apps projects

Company-

specific project

collection

Application-specific project

collection

Collection can be created and

deleted

yes, see below no

Collection can include any project yes no, contains all projects of an

application, 

– Creo Parametric

– Creo Elements/Direct Modeling 

– or Apps projects

Individual projects can be added

and deleted

yes no
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In addition, this area lists all auto projects, which are displayed automatically. Hence, no

projects can be assigned.

Creating company-specific project collections

1. Create a new project collection: only possible for company-specific collections

Create a new project collection in the menu item Project collections > Project types > Add

(1). 

2. In the dialog on the right, fill in how the project collection should be displayed in

GENIUS TOOLS Starter App

Display name

Enter a name for the project collection.

Comment

Enter an optional comment.

Image

A collection can be fitted with an icon in JPG or PNG format. 

Color

A collection can be displayed with an individual color for better visualization.

3. Hide

No (default): The project collection is displayed in GENIUS TOOLS Starter App.

Yes: An project collection is not displayed.

4. Add/delete projects

You can add and delete projects only in company-specific collections.

Add 

Add projects that have been created in the Projects menu item.

Delete

Select a project to delete it.
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Search

Search a project by keywords.

5. Define order

Put projects in the order needed by using drag and drop.

5.12  Customizing Creo user interface

If you want to customize the user interface of Creo, go in Creo to File > Options >

Configuration editor. 

Changes made in Creo will by default be saved in the file creo_parametric_customization.ui

in the directory %PTC_WF_ROOT%\.Settings, e. g. %APPDATA%

\PTC\ProEngineer\creo4\.Settings.

Alternatively, you can have this file stored in the startup directory. To do so, select a group

in GENIUS TOOLS Project Configurator and in Creo Settings > Write > Target Directories >

Ui file location select Start.

5.12.1  creo_parametric_customization.ui

The file creo_parametric_customization.ui (short: customization.ui) contains the settings for

the graphical user interface (UI) of Creo. 

To customize the user interface specific to a user or a group of users, do as follows:

1. Modify the settings for the user interface in Creo in File > Options > Configuration

editor.

2. Copy the file creo_parametric_customization.ui that is saved in %PTC_WF_ROOT%

\.Settings by default. (The use of the startup directory as alternative storage location is

described in the previous chapter.)

3. Save the copied ui-file to one of these directories: userdata, users, projects, units or

standard. (See also Directory structure.) In a subdirectory of unit, the UI file would, for

example, determine the Creo user interface for the named unit.
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There is only one customization.ui file. Hence, GENIUS TOOLS Starter does not write

several separate files as it does for the config.pro-file (such as e. g. config_mapkey.pro

which would be written into one final config.pro-file). This is important because it means

that one customization.ui file cannot add configuration settings to an existing file, it can

only substitute another customization.ui.

The customization.ui file that is found first determines the Creo user interface. The call

hierarchy is as follows: 

1. userdata > 2. users > 3. projects > 4. units > 5. standard

Company-wide configuration with
creo_parametric_admin_customization.ui
The administrator can set up a configuration that is valid for the whole company or for

specific users, projects or units. To do so, change the name of the ui-file that is

automatically saved by Creo from creo_parametric_customization.ui to

creo_parametric_admin_customization and save it to one of these directories: userdata,

user, project, unit oder standard. 

The settings in the admin file creo_parametric_admin_customization are overwritten or

complemented by those in the individual  creo_parametric_customization.ui.

Executing the file creo_parametric_admin_customization.ui follows a hierarchical search in

these directories: 

1. users > 2. projects > 3. units > 4. standard

The administrator can thus set up a standardized graphical user interface for specific users,

projects and units, as well as a company-wide UI configuration.

Please note: A company standard, i. e. a UI file in the standard directory, can only be

implemented if there are no admin_customization.ui files in the directories users,

projects and units.

Individual customization.ui file
A user can manage his or her own customization.ui file by saving it to a directory userdata

to which the user needs write access. There are two possibilities. One, the user can access

the  userdata directory in the caddepot directory of the administration computer – from

where it will be synchronized to the client computer. Two, a directory can be created in

any location on the client computer. There, it does not undergo data synchronization. (See

also the chapter on User-driven configuration.)

The administrator can determine the storage location of the userdata directory in

Configuration > (select) group > Creo Settings > Application > User Settings >

Configuration folder. 
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u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

Private config.pro

Name of a user-defined config.pro file. It is appended to the config_*.pro files in the users,

projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to

the userdata directory, as well as the access right Can save personal Config.pro file [to

userdata directory] on server.

See also Config tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file. It replaces any customization.ui file in the

users, projects, units and/or standard directories. See also UI tab in GENIUS TOOLS Starter

App.

Backup mechanism with GENIUS TOOLS Starter App
You can create a backup file (BAK file) from creo_parametric_customization.ui in GENIUS

TOOLS Starter App. This can be useful for users who manage their own UI configuration

files, as well as for administrators who modify Creo UI settings for test purposes.

1. In the info pane of GENIUS TOOLS Starter App go to the Config tab and click backup

user customization.ui
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2. If a backup file already exists, confirm that it should be replaced.

3. In the following dialog box select whether creo_parametric_customization.ui should be

deleted.

Result: The file will be saved as creo_parametric_customization.ui.bak in the directory %

PTC_WF_ROOT%\.Settings. 

In order to restore the user-specific UI file:

5. Click on restore user customization.ui 

6. In the following dialog box select whether the backup file should be deleted. 

Result: The file creo_parametric_customization.ui.bak in the directory %PTC_WF_ROOT%

\.Settings is changed to creo_parametric_customization.ui.

5.13  Working with Windchill

GENIUS TOOLS Starter can be used in conjunction with Windchill. The following section

describes requirements and considerations for working with Windchill.

If you want GENIUS TOOLS Starter to look for Creo data in Windchill first, and in the

project directories in the second place, you should set your system settings to Using

Windchill. To do so, go to Configuration > Standard > Windchill settings > General > Using

Windchill > Yes.



144GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

You also need to set search paths for all library directories and load them when Windchill

is used, as long as not all Creo data has been transferred from disk storage to Windchill.

There is a template config_searchpath.pro file in the SEARCHMODE directory under the

project directory: 

<GTS-OperatingEnv>\configuration\projects\<ProjectDir>\SEARCHMODE. You can adapt

this template file to your setup.

5.13.1  Object search hierarchy in Creo

Creo looks for objects in the following order:

1. Creo session

2. Search or call directory in which the parent object has been found, or directory which is

specified in the Open dialog.

3. Active Windchill workspace.

4. Active Windchill commonspace

5. Local working directory

6. Search paths

(See http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190.)

5.13.2  Using a Windchill library

You can define dedicated directories for libraries, drawing frames, start objects and UDF in

Creo. When you are using Windchill, these directories can point to products or libraries in

the Windchill environment. The required syntax of the config.pro entry is as follows, using

the library directory of Windchill PDMLink as an example.

Pro_library_dir wtpub://<Windchill_server>/<Context>/<Directory>

– wtpub: refers to the Windchill commonspace

– <Windchill server>: name of the Windchill server as registered in Creo

http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190


145GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

– <Context>: context you want to refer to, e.g., SUT libraries

– <Directory>: directory within the context

Each user can define their own name for the Windchill server. This means that the general

config.pro entry cannot point unequivocally to a storage location, as maybe not all users

have used the same name when first registering the server. The following section

describes how GENIUS TOOLS Starter can be used to influence Windchill server naming.

5.13.3  Automatic Windchill server rename

In the general Windchill settings in GENIUS TOOLS Project Configurator, you can define a

Windchill server name that should be used system-wide (Configuration > Standard >

Windchill settings > General > Windchill server name). To link this name with an existing,

manually configured Windchill server, you also have to make two other settings:

1. Windchill server URL: address of the Windchill server

2. Server auto rename: Yes (under Register)

If a server is found under the URL you have specified for the Windchill server, this server

will be renamed to the specified name on the next Creo start.

5.13.4  Automatic Windchill server registration

The Windchill server registration enables the automatic registration of a Windchill server

under a given name in PTC Creo.

The concept of automatic server registration is that previously registered servers are

retained without changing the entire registration and that a newly registered server is set

to active. It is also part of the concept that server registration does not result in the

registered server reverting to active as soon as a project with the corresponding

configuration is selected. Usually the user wants Windchill settings of the previous Creo

session to be set again after restarting Creo.

Users who are to get access to a Windchill server via automatic server registration need to

have a valid Windchill account and have access to the defined workspace in the defined

Windchill context. It can be useful to create a context (product, library or project) that is

not otherwise used and that these users have access to.
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Please note: In order to use automatic server registration, the following requirements

must be met:

– Using Windchill must be activated.  (Configuration > Select group > Windchill Settings >

Section: General)

– The Windchill Context must be set and must exist.

– The default workspace must be located in the Windchill Context that is given.

– The Windchill cache directory must be a subdirectory of the Windchill user root folder.

Automatic server registration is configured under configuration > (Select group) >

Windchill settings. The Windchill settings are expanded once you set Use Windchill to Yes.

u General

Use Windchill

Activate/deactivate the Windchill server. To use Windchill automatic server registration,

this function must be set to Yes.

Yes: Activates Windchill-relevant settings such as automatic server registration.

No: Windchill settings will be disregarded.

No, don't register: The Creo session is started without an active Windchill server.

However, the Windchill server remains in the server registry without being selected.

Windchill server name

Specify the name with which the server will be registered in Creo.

Windchill server URL

Specify the URL under which the server can be reached.

u Register

Server auto register

Select whether the server should be registered automatically.

Yes: The above mentioned Windchill server is automatically registered and is then

available within Creo.

No: The server is not entered automatically.

Server auto rename

If a server already exists at Windchill server URL and has a different name than Windchill

server name, the server will be renamed when starting Creo next.

Set Windchill server online

Select whether the server should be put online.

Yes: A new server that was added by auto-registration will automatically be put online.

No: The server is registered offline.

u Windchill context

Default workspace name

Name of the workspace that is active during registration. The default workspace has to be
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present under the context given.

Windchill context type

Type of context: Product, Library, Project.

Windchill context

Context of the workspace.

Changing server path from HTTP to HTTPS
When changing the Windchill server path from HTTP to HTTPS, Creo Parametric may

encounter errors that interfere with the correct execution of Windchill auto-registration.

To avoid this, it is recommended to create a new cache directory and delete the old server

path – after a transition period, if necessary.

The entry for the Windchill cache directory is located in the main menu item Configuration

under Creo settings > Section: Startup settings.

5.13.5  Project-specific Windchill settings

You can also define a Windchill server to be used for a specific project. To do so, go to the

Projects page, select the desired project and make the project-specific Windchill settings in

the Windchill tab.

See also Workspace for Windchill.

5.13.6  Integration in Windchill Worker

If you want to open Creo with Windchill, you can use GENIUS TOOLS Starter to apply the

project settings and environment variables. In this case, you will neither get the GENIUS

TOOLS Starter user interface nor will Creo be opened. For this option, you must create an

extra project for access by the Windchill Worker. Proceed as follows.

Steps for integrating GENIUS TOOLS Starter into an existing Windchill Worker

Creating a project in GENIUS TOOLS Project Configurator

1. In the main page Projects  click the Create button. A new project is created with

the name "New Project". 

2. Rename the project. The default name is publish. 

3. If you want the project to be invisible to users, hide it in the Creo tab in the section

General with Hide Project. Alternatively, you can create a role which you grant access

to the project.

4. If necessary, assign a separate license to the project in a Creo startkey (PSF file). 

Including the call to the GENIUS TOOLS Starter App in the Worker batch file
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5. Open the batch file proeworker.bat in the Windchill Worker directory.

6. Enter the following line below the line set PVIEW_HOME=D:\ptc\object adapter:

call <cadpoolpath>\<nameofoperatingenvironment>\software\worker.bat <project
name>

The project name corresponds to the name selected in step 2.

Install Cadpool on user computer

7. Make sure that GENIUS TOOLS Starter is installed on the user computers that are to

access the project. To do so, perform an initial synchronization by opening the file

gts.exe from the operating environment of the Caddepot directory which is located

on the administration computer: <caddepotpath\<working environment

name>\software\gts.exe

This will install the Cadpool directory and synchronize it with the Caddepot directory.

5.14  Access rights

With the role-based permission concept of GENIUS TOOLS Starter users can be granted or

withdrawn the following access rights:

– for specific projects (“Project access”)

– for various functions in GENIUS TOOLS Starter App and GENIUS TOOLS for CREO

("Function access“)

5.14.1  Restricting project access

It is possible to restrict the access to one or more projects to certain users. To do this,

create a role with the desired user group in the Details tab (1). Then go to the Project

Access tab (3) and use the Plus button (4) to select the projects that the members of the

role are allowed to access.

As soon as the first project is assigned to a role, the restrictions for this project are set,

meaning that the button Restrict project access in the Creo tab of the Projects page is

automatically activated. 

If no project is added to the project access of a role, then all projects will be accessible for

this role.
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Defining projects that members of a role can access

Please note: Each user can only see the projects they are permitted to access. To verify

which projects are accessible for a certain user, go to the card view under Resources >

Users and click on the project symbol  on the user's card.

5.14.2  Granting function access rights

In the Function Access tab (2), select the rights you wish to grant to the members of a role

for using functions in GENIUS TOOLS Starter App. If an access right is not given to a user,

the corresponding button does not appear in GENIUS TOOLS Starter App. Also refer to

the chapter on GENIUS TOOLS Starter App User Interface.

These two functions concern the work with GENIUS TOOLS for CREO (GTFC):

– Is GTFC admin 

– Can use network mode

Please note: Not every functionality can be controlled using access rights. Standard

functions as well as starting GENIUS TOOLS Starter and opening  a project cannot be

changed.

u Administration

Can enter Project Configurator

The user may open GENIUS TOOLS Project Configurator. For users who do not have this

right, a message will be displayed, and the Project Configurator will be closed when the

user confirm the message.

Default for group Administrator: Yes

Default for group Everyone: No

Hint: When GENIUS TOOLS Starter is started locally from the Caddepot directory,

Project Configurator is always accessible. In this way, an administrator will always have

access to the configuration.
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Please note: If this right is not assigned to any user, GENIUS TOOLS Project

Configurator will revert to the default setting of granting the right to all uesers.

Is GTFC admin

The user can access the editors in the GENIUS TOOLS for Creo (GTFC).

Default for group Administrator: Yes

Default for group Everyone: No

Can see project information

Users can open the Info tab containing the project name, paths to the project, data and

working directory as well as the selected language and the startkey. The button  is

displayed in GENIUS TOOLS Starter App. 

Default for group Administrator: Yes

Default for group Everyone: No

Can analyze project 

Users are able to analyze and edit all configuration files of a project with GENIUS TOOLS

Config Analyzer. The button  is displayed.

Default for group Administrator: Yes

Default for group Everyone: No

Can create project report

The user can view all information about the project and user settings in a separate

document. The button  is displayed in GENIUS TOOLS Starter App. 

Default for group Administrator: Yes

Default for group Everyone: No

u Synchronization

Can pause synchronization

The user may pause the automatic data synchronization. Synchronization has to be

paused if you want to make changes to files in the Cadpool locally, otherwise local

changes would be overwritten as soon as the synchronization runs.

Default for group Administrator: Yes

Default for group Everyone: No

Warning: GENIUS TOOLS Starter App will keep the synchronization on pause even after

a restart of the software as long as the user still has this right. If this right is withdrawn

while the synchronization is paused, the synchronization will run automatically when

the software is restarted, which may result in data loss from the Cadpool directory.

Prevent switch to local installation

By default, if the GENIUS TOOLS Starter App is started from the Caddepot directory on the

administration computer, GENIUS TOOLS Starter App will switch automatically to the local

Cadpool. If Prevent switch to local installation is set to Yes, there is no automatic switch

and the user can work on the data in the Caddepot.
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Default for all groups: No

Warning: If this right is granted to a user before the initial synchronization, GENIUS

TOOLS Starter App will not be installed locally for this user, and the user will not be able

to start locally.

u Project

Can analyze licenses

Users can see the license statistics in GENIUS TOOLS Starter App. (See chapter Display

license details.) To use this option, you also have to set Show licenses under Configuration

> Creo settings > Tab: Start > Show licenses to Yes.

Default for group Administrator: No

Default for group Everyone: Yes

Can borrow licenses

Users can start the license borrowing process. The button  is displayed in GENIUS

TOOLS Starter App in the Licenses tab. GENIUS TOOLS Starter App will borrow the Startup

TOOLS license, then start the borrowing process for PTC. The PTC borrowing process will

borrow the Creo and GENIUS TOOLS for Creo licenses. 

Default for group Administrator: No

Default for group Everyone: Yes

Warning: To borrow the PTC licenses, the user has to complete the PTC borrowing

process.

Can disable Creo Parametric config files

The user can temporarily disable configuration files for a project. Disabled files will not be

used by GENIUS TOOLS Starter App when creating the configuration settings.

Default for group Administrator: No

Default for group Everyone: Yes

Warning: Disabled configuration files will become active again on the next project

validation or synchronization.

Hint: This right makes it possible to quickly disable configuration files on individual

computers without having to change company-wide configuration settings.

Can open Creo Parametric config files

Users can view and edit configuration files (Config.pro blocks). See Configuration files.

Default for group Administrator: No

Default for group Everyone: Yes. A double click opens the file in GENIUS TOOLS Config

Editor.

Can save private Creo Parametric config files

Users can edit their private configuration file and write it back to the userdata directory on
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the server. See Configuration files. Set the path to the userdata directory in the Creo

Parametric settings page under User settings in the Application tab.

Default for group Administrator: No

Default for group Everyone: Yes. The upload button  is displayed.

Sees auto projects

GENIUS TOOLS Starter will search for certain supported applications on the local

application computer, for example Keyshot or Mathcad , see auto projects., and will

display them in the last installed software version in GENIUS TOOLS Starter App. 

Default for group Administrator: No

Default for group Everyone: Yes

Please note: Licenses for auto projects cannot be checked by GENIUS TOOLS Starter.

Can see and save customization.ui file

Users can view, edit and make a backup copy of the file creo_parametric_customization.ui

(short: Customization.ui), which contains all user-specific settings for the graphical user

interface of Creo. 

Default for group Administrator: Yes. The button  is displayed in GENIUS TOOLS

Starter App in the UI tab.

Default for group Everyone: No

5.15  Settings for GENIUS TOOLS Starter App

This section explains how to configure GENIUS TOOLS Starter App for the users. Settings

for GENIUS TOOLS Starter App are made from Project Configurator. In addition, as an

administrator, you can send messages to the users that will be displayed via the message

symbol  in the GENIUS TOOLS Starter App sidebar.

5.15.1  Presenting projects

The display of projects in GENIUS TOOLS Starter App can be influenced as follows: 

– Projects can be displayed to specific groups only: see Restricting project access.

– Projects can be grouped into collections: see Project collections.

– The order of collections and the projects they contain can be defined via drag-and-

drop.

– Project collections and auto projects can be assigned a color and an icon.

– Projects can be provided with an icon and an additional info line: Projects > Application

> Projects > Tab: Application > General
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Marking invalid projects
You can control whether users can open projects for which they do not have a license or

the required license extensions.

The following actions and warning colors can be set in the menu item Configuration >

Group (select) > Settings: GENIUS TOOLS Starter App > Segment: Projects.  The warning

colors are only displayed after a project has been clicked upon or after activating the

Analyze licenses function in the Licenses tab of the GENIUS TOOLS Starter App.  

u Projects

Display invalid projects

Specifies how projects with missing licenses are displayed to the user. To use this setting,

Show licenses has to be set to Yes.

No: Projects without a valid license are hidden.

Yes, as warning: Projects without a valid license are displayed with a yellow

background and can be started regardless.

Yes, as error (default): Projects without a valid license are displayed with a red

background and cannot be started.

Yes, deactivated: Projects without a valid license are displayed with a gray

background and cannot be started or selected.

Please note: Projects for which no corresponding Creo version can be found are never

displayed. In case the Creo version is found, but no PSF key, you can choose between

not displaying the project and displaying it as warning, see Assigning Creo licenses to

projects.
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Warnings
Project settings can cause warnings other than missing licenses, e.g. if the project directory

cannot be found. The project bar will then be orange and a flag icon appears, which opens

the Warning tab.

5.15.2  Projects for Creo Parametric

5.15.2.1  Defining project options

Administrators can give users the option to select from the following project options.

– Creo language (1)

– Creo start key (2)

– company-specific project options for license extensions, add-on programs and

configuration settings:

– single project options (3)

– combined  project options (4)
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Selectable project options in GENIUS TOOLS Starter App

Like all Creo Parametric project settings project options can be defined for a specific

project as well as for units, groups or system-wide.

1. Language selection field
You can set whether users can select the language of the projects they have access to. The

right Creo language selectable is granted in Configuration > GENIUS TOOLS Starter App >

Select group >  Projects. If the right is not granted, neither selection field nor information

about the set language appears. If you want to provide users with information about this,

you can include this in the name of the project or in the subtitle, e.g. Creo Parametric 9.0.

DE.

Creo language selectable

Specify whether users are allowed to change the preset language, in which Creo is to start.

The language of a project can be preset in the Projects main page under Application type:

Creo Parametric > Projects > Tab: Start > Startup settings > Language. 

Please note: This option requires that the selectable language has to be available in

the Creo installation used. This is not checked by GENIUS TOOLS Starter.

Yes: Users have the right to change the language of a project. If this options is

activated, a drop down menu will be displayed in GENIUS TOOLS Starter App.

No (default): Users cannot change the language.  There is no information about the

language that Creo will start in.

Show only installed languages

By default only languages of the installed Creo versions are displayed in the drop-down

menu (see above setting).

Yes: Menu contains only installed Creo languages.

No (default): Menu contains all languages supported by Creo.
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2. Selection field for Creo startkey
A startkey is a configured start command that opens Creo with one or more specified

licenses or license extensions. Startkeys are PSF files in the bin directory. You can assign

multiple startkeys to a project. The procedure is described in chapter Assigning Creo

licenses to projects If users have multiple startkeys to choose from, a selection field

appears in the selected project in GENIUS TOOLS Starter App.

Users can be given start keys to select from:

– per project: select the startkeys in Projects > Creo Parametric > (select) Project > Tab:

Start > Segment: Creo Startkey Configuration. For more information, see the chapter

Assigning Creo licenses to projects. 

– for several projects that can be accessed by a group or unit: Select the startkeys in

Configuration > Settings: Creo Parametric > Select project > Tab: Start > Segment: Creo

Startkey Configuration

The administrator can set in GENIUS TOOLS Project Configurator whether a project should

have a default start command or whether the start command last selected by the user

should be used again. (See chapter Assigning Creo licenses to projects, 2.1. and 2.2..)

If the right to select is not assigned, neither selection field nor information about the used

start key appears. If you want to give users an information about the start key, you can

insert this in the name of the project or in the subtitle, e.g. Creo Parametric 7.0. AAX.

Checkboxes for company-specific options
Administrators can define further project options that are tailor-made to a company's

requirements, e. g. for starting Creo with:

– additional license extensions, such as Simulation Live or Manikin,  

– separate programs such as Keyshot or Model Processor User, or

– any other configuration setting as defined in a config.pro block.

There are two types of company-specific project options, single (3) and combined

project options (4).

These two types of project options are not created in GENIUS TOOLS Project Configurator,

but with Config.pro blocks. The chapter Making use of project options explains the

procedure.

5.15.2.2  Customizing the information pane

There are two areas displaying project information.

– the info area, which opens when a project is selected and contains the info icons (see

table).
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– the info tabs that open on the right side after selecting an info icon. These are tabs

Licenses, Config, Options and UI. The Error and Warning tabs are displayed when an

error or a project warning has occurred. (See also chapter GENIUS TOOLS Starter App >

User Interface). 

Some of the information can be configured or be completely hidden by the administrator. 

Function Description Funktion im Project

Configurator

konfigurierbar?

Warning warning icon appears only if project

settings trigger a warning

opens Warning tab

no

1 Information opens Info tab with:

– project name

– path to project, data and working

directories

– Creo language, Creo startkey

– Windchill

button and Info tab can

be disabled with Can

see project information

under Function access >

Administration

2 Licenses opens Licenses tab: 

– shows licenses and license servers

– button for analyzing licenses

– button for access to the license

borrowing process

button: no

Licenses tab: yes, see

Displaying license

details

3 Configuration

files

opens Config tab

– lists all used config.pro files and

additional applications (Toolkit

Application) in the selected project

– config.pro files can be opened by

right clicking 

button: no

Config tab: users can

edit and deactivate

configuration files, see

Editing config.pro
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Function Description Funktion im Project

Configurator

konfigurierbar?

blocks.

4 UI

(Customization

.ui file)

opens the UI tab: 

– displays the customization.ui file,

which contains the user-specific

settings for Creo's graphical user

interface (UI). 

– users can create a backup copy of

the customization.ui file, see Backup

mechanism in GENIUS TOOLS Starter

App.

button and UI tab can

be disabled with Can

see and save

Customization.ui file

under Function access >

Project of a role.

5 Project report opens PDF file containing all

information about the selected project

button: can be disabled

with Can create project

report under Function

access > Administration

6 GENIUS

TOOLS Starter

App Config

Analyzer

opens separate utility to view and edit

all configuration and batch files used

for the project and their location. You

can edit these files with an editor. 

button: can be

deactivated  able with

Can analyze project

under Function access >

Administration

5.15.2.3  Displaying license information

The Licenses tab contains information on the license servers (1) assigned to a project as

well as the two Symbols Analyze licenses  (2) and Borrow licenses (3) if the users have been

granted the following rights.
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1. Creo license server

All PTC license servers are listed to which a project has access to.

Settings: Together with Analyze licenses

2. Analyze licenses 

This function shows all available licenses and extensions as well as the time that has

passed since the last analysis.

Settings:  These two functions (1,2) belong together and can be switched on or off with

two settings in GENIUS TOOLS Project Configurator.

– Configuration > Creo Parametric Settings > Select group > Tab: Start > Section: Licenses

> Display Licenses to Yes/No.

– Resources > Select role > Tab: Function Access > Section: Projects > Can analyze

licenses. 

3. Borrow licenses 

The borrowing function can be turned off by the administrator in the GENIUS TOOLS

Project Configurator 

Settings: 

– Resources > Role > Tab: Function Access > Section: Projects > Can borrow licenses: Yes/

No. 

– The default and maximum borrowing duration can be preset in Projects > Creo

Parametric > Select project) > Tab: Start > License borrowing

5.15.2.4  Editing config.pro blocks

In the Config tab, users can view and may edit configuration files which configure the Creo

Parametric project – so-called config.pro blocks.
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1. Open and edit by double click

For this, the user must be granted the access right Can open configuration files from Starter

App, see chapter Granting function access rights. Double-clikcing will open GENIUS TOOLS

Config Editor.

2. Disable or enable (checkboxes).

For this, the user must be granted the access right Can disable Creo config files, see

chapter Granting function access rights.

3. Edit personal Config.pro file

Users have the ability to edit their local, personal config.pro file and write it back to the

administration computer in the userdata directory. Path specifications are made in the

user settings dialog of the Creo Parametric settings.

Read chapter Configuration files for more information.

5.15.3  Configuring the desktop link

By default, a desktop link for GENIUS TOOLS Starter App is created automatically on the

application computers. You can define the properties of this desktop link in Project

Configurator, including centrally-defined start parameters.

To configure the desktop link, go to the Configuration page , select a group, then

select the settings item GENIUS TOOLS Starter App. Set Create desktop link to Yes. This

setting determines that the desktop link is created or updated according to the

configuration with each program start or synchronization process.

You can define the following settings for the desktop link.

Name

You can define a name for the desktop link. Without an entry the desktop link will be

named GENIUS TOOLS Starter App - <operating environment name>.
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Execution path

Enter the path GENIUS TOOLS Starter App should be run in.

Commandline arguments

Enter any start parameters that should be used by GENIUS TOOLS Starter App.

Warning: If you used start parameters in version 6.0.0, take care to move them to this

setting in Project Configurator. If the start parameters are not specified here, start

parameters in local links will be deleted!

Warning: If the start icon is located in the users\public\desktop directory, it cannot be

changed with user access rights. This means that the central icon definition cannot be

applied!

Custom icon graphic
If you want to use a custom icon graphic, you have to place the image file in the _Images

directory of the operating environment using the file name

<operating_environment_name>.ico.

Example result

5.15.4  Support link and logging

In the GENIUS TOOLS Starter App settings under General you can define whether users

should have access to the online support function of INNEO (TeamViewer) or to a

company-specific link or document. You can also hide the Support menu item altogether. 

u General

Hide support

Hides the menu item Support in the user menu item Help of GENIUS TOOLS Starter App.

No selection (Default): Users are referred to the Hotline website of INNEO.

No: The user sees the Support item in the menu.

Yes: The Support item is not visible.



162GENIUS TOOLS Starter 
 
                                                                                                                                                                  © 2022 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Support

Enter the URL of a website or the path to a document. Set the above field Hide support to

No.

Log projects without permission

Projects to which a user has no access rights are by default not displayed in the log file.

Yes: Information about the projects is displayed in the log file.

No (Default): Projects are not included in the log file.

Write crash report to Caddepot directory

Unexpected errors are written to a log file by GENIUS TOOLS Starter App (gts_error.log).

The file can also be copied to the server and is saved there as

serveronly\_ErrorLog\<Computer_name>.log.

Yes: The client will copy its log file if an unexpected error occurs.

No (Default): The log file is only available on the client computer.

5.15.5  Operating environment clean-up

In the Cleanup of operating environment section of the GENIUS TOOLS Starter App settings

you can define whether an outdated operating environment should be deleted from the

application computers, that is, from the Cadpool directories. The operating environment in

the Caddepot is not affected. The user is asked to confirm before the deletion process is

started.

5.15.6  Sending messages to the users

GENIUS TOOLS Starter includes a functionality for administrators to send messages in

form of text files to users who can access them in the GENIUS TOOLS Starter App sidebar.

Creating a message
Step 1: Go to the operating environment's _Information directory in the caddepot

directory.

Step 2: Create a TXT or a PDF file with your message. The name of the text file has to start

with the prefix alert_, e.g., alert_message.txt.

After synchronization the existence of new messages is displayed to users by coloring the

message symbol red . After reading the document can be opened again.
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5.15.7  Freely configurable debug mode

GENIUS TOOLS Starter provides a freely configurable debug mode that allows you to use

the Windchill Workgroup Manager to interact with Windchill in debug mode.

The files logger.cfg.debug and logger.cfg.bat are used for this purpose according to the

call hierarchy for configuration files. Place both files in the standard directory <working

environment name>\configuration\standard. 

Hint: Information on how to use client log files for debugging with Windchill

Workgroup Manager can be found at PTC in article CS140107.

logger.cfg.debug

If the logger.cfg.debug file exists multiple times within the directory, it is copied together

like a config.pro file. File names are used in the following notation: logger.cfg*.debug 

After merging logger.cfg.debug the log output folder is always set to HOME\ANALYSEWF

by adding the line log_dir_path.

logger.cfg.bat

The batch file is used to define environment variables which should be additionally

defined in the Creo session if the debug mode is used. If more than one batch file exists,

all batch files matching the logger.cfg*.bat notation will be executed.

The debug mode is switched on in the user menu of GENIUS TOOLS Starter App with

Debug Creo/Windchill.

https://www.ptc.com/en/support/article/CS140107
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6  GENIUS TOOLS Starter App

GENIUS TOOLS Starter App lists the projects defined in GENIUS TOOLS Project

Configurator and lets the users start them.

If changes are made to the central configuration, these changes are taken up by GENIUS

TOOLS Starter App with the next synchronization.

Information on the configuration of the interface and the selection options can be found

in the chapter Settings for GENIUS TOOLS Starter App.

6.1  Starting GENIUS TOOLS Starter App

By default, GENIUS TOOLS Starter App is configured to start automatically with the

operating system. GENIUS TOOLS Starter App is displayed in the Windows task bar and

can be called up from there.

If GENIUS TOOLS Starter App is not started automatically, the app can be started via a

centrally configurable desktop link.

Please note: To close GENIUS TOOLS Starter App, select Exit in the user menu .

When you click Close, the window is minimized.

6.2  User interface

GENIUS TOOLS Starter App comes with a clearly structured user interface. Depending on

the configuration, for example, license information on the PTC products configured for

each project is listed in the user interface.

Start the desired project with a double-click. The desktop application is started with the

configuration defined for the project.

Auto projects are applications which cannot be configured and are automatically listed by

GENIUS TOOLS Starter. 
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User interface of GENIUS TOOLS Starter App

The user interface of GENIUS TOOLS Starter App is divided into three areas.

Left area for selection of a

1. unit and 

2. project collections: company-specific (e. g. My Projects, Project Archive) and

application-specific (e.g. Creo Parametric, Creo Elements/Direct Modeling), as well as

auto projects: applications that are be automatically listed by GENIUS TOOLS Starter

(e. g. MathCad, KeyShot). .

Central area with project list

3. Configurated project with project details and options

The  information area on the right side opens when clicking on a project details button in

a selected project. These are the corresponding  

4. information tabs: 

Info: shows the most important project (name, directories, Creo startkey, language of the

project)

Licences: displays all license servers and gives access to analyzing and borrowing

licenses if user has access rights.

Config: contains information on the configuration files and additional applications

(toolkit applications) for the selected project.

Options: shows all selectable configuration settings for license extensions, additional

programs etc. (Single project options).
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UI: displays the path to the customization.ui file containing the user-specific UI settings

for Creo.

Warning / Error: these tabs are only displayed if a project cannot be started or causes a

warning.

There are two bars for operating the Starter App

5. Sidebar with user menu 

6. Footer with information on licenses and synchronization

6.3  Selecting a unit

When you are using a subscription license, units can be defined as an additional

configuration layer to reflect different company branches or divisions. (See chapter

Configuring heterogeneous environments.)

If units are used in your environment, the current unit is displayed in the header of

GENIUS TOOLS Starter App.

If a user account is assigned to multiple units, the user can switch between units via the

header.

Unit selection

Units are displayed in alphabetical order unless a unit is defined to be the first on the list.

This can be specified in GENIUS TOOLS Project Configurator by inserting a space character

in front of the unit name. (See Displaying units in GENIUS TOOLS Starter App.)
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Selecting a subordinated unit (subunit)
If users can select from subordinate units (subunits), the selection field will open a

separate dialog for selecting all subunits. 

In this dialog box you can select a unit. Note that units can be selected from several levels.

If no selection is made, the first unit in the drop-down menu will be used. 

Confirm the selection with the Change button at the bottom right.

6.4  Display of projects

Information about a project is available in the area below the selected project, the info

tabs, and by the color of the bar to the left of the project name.

In the selection fields, users can set the language, the Creo start key and additional

programs and license extensions for a selected project if they have the rights to do so. 

Color coding: License check for projects
In GENIUS TOOLS Project Configurator, your administrator can define whether you can

check for available Creo licenses (this adds the Analyze licenses button in the Licenses tab)

and how projects should be displayed if there is no license available for them. The display

of projects without a license can be set by the adminsitrator as follows:

– The projects are not visible for the user. 

– The projects are marked with a red background and cannot be started. 

– The projects are marked with a gray background and cannot be started. 

– The projects are marked with a yellow background and can be started. 

The warning or error colors only appear when a project has been clicked or the Analyze

Licenses function in the Licenses tab. 
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6.5  Project details and options for Creo Parametric

Project details
When selecting a Creo Parametric project the following icons will appear in the area below

the project name, if users have the function access to do so.

Clicking a button will open the following information tabs.

Function Description Funktion im Project

Configurator

konfigurierbar?

Warning warning icon appears only if project

settings trigger a warning

opens Warning tab

no

1 Information opens Info tab with:

– project name

– path to project, data and working

directories

– Creo language, Creo startkey

– Windchill

button and Info tab can

be disabled with Can

see project information

under Function access >

Administration

2 Licenses opens Licenses tab: 

– shows licenses and license servers

– button for analyzing licenses

– button for access to the license

borrowing process

button: no

Licenses tab: yes, see

Displaying license

details

3 Configuration

files

opens Config tab

– lists all used config.pro files and

additional applications (Toolkit

Application) in the selected project

– config.pro files can be opened by

button: no

Config tab: users can

edit and deactivate

configuration files, see

Editing config.pro
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Function Description Funktion im Project

Configurator

konfigurierbar?

right clicking blocks.

4 UI

(Customization

.ui file)

opens the UI tab: 

– displays the customization.ui file,

which contains the user-specific

settings for Creo's graphical user

interface (UI). 

– users can create a backup copy of

the customization.ui file, see Backup

mechanism in GENIUS TOOLS Starter

App.

button and UI tab can

be disabled with Can

see and save

Customization.ui file

under Function access >

Project of a role.

5 Project report opens PDF file containing all

information about the selected project

button: can be disabled

with Can create project

report under Function

access > Administration

6 GENIUS

TOOLS Starter

App Config

Analyzer

opens separate utility to view and edit

all configuration and batch files used

for the project and their location. You

can edit these files with an editor. 

button: can be

deactivated  able with

Can analyze project

under Function access >

Administration

Project options (checkboxes)
In the drop-down fields of a project, users can select the following project options, if they

have been granted the right to do so: Language, Creo-Startkey, and additional programs

and license extensions.
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Function Beschreibung Funktion in Project

Configurator

konfigurierbar?

1 Language selects the language in which Creo

starts the project

yes, see Defining project

options: Language

2 Creo

startkey

selects the license key (PSF key) to start

the project with

yes, see Defining project

options: Creo startkey

3 Single

project

options

activates license extensions (key

symbol) and additional programs

create config.pro blocks,

see Defining project

options > Single project

options

– clicking on the right opens a menu to

deselect or select all options

– arrow will appear, if more options are

available and opens the Options tab

4 Grouped

project

options

activates combined configuration

options

– after selection further single project

options may become available

create config.pro blocks,

see Defining project

options > Grouped

project options

6.5.1  Information

The Info tab contains the following information on the selected project.
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– Project name

– Project directory

– Data directory

– Working directory

– Information on the application:

– Creo startkey (PSF file that contains startcommands). Users may have been granted the

right to select a startkey. (See project options)

– Application language. Users may have been granted the right to choose the start

language. (See project options)

– Windchill

6.5.2  Licenses

The Licenses tab contains information on the license servers assigned to a project as well

as the two Symbols Analyze licenses   and Borrow licenses  if the users have the

corresponding user rights.

The administrator defines which license functions users can use, see chapter Displaying

license information.

1. Creo license server
All license servers specified in the project are listed here without being checked for

availability. The dots turn green or red only after a license analysis (2) 

2. Analyzing licenses
After clicking Analyze licenses (2) all licenses and extensions needed for the project are

listed and their availability is displayed in the column Free. Also, the time passed since the

last analysis is shown.
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If you are working with borrowed licenses and without synchronization, the Licenses tab is

hidden. If you are working with borrowed licenses, empty information tables are hidden.

Please note: If you are running Creo Parametric on your local computer, using one

license, and there are no other licenses available on the license server, the number of

free licenses is given as 1, not 0. Also, the note Multiple usage is displayed. This is meant

to show that you can start additional instances of Creo because no additional license is

required.

3. Borrow licenses

If a user is permitted to borrow licenses, the Borrow button  is displayed.

1. In the Licenses tab, click Borrow (2). The

Borrow licenses dialog is displayed.

2. Select the number of days for which you

want to borrow the licenses and click

Borrow. GENIUS TOOLS Starter App

borrows the licenses for GENIUS TOOLS

Starter. The PTC license borrowing dialog

for Creo opens.

3. In PTC Creo license borrowing dialog,

select the correct startkey and the

duration of borrowing in days. The

correct startkey is the one that starts with

the selected project (see Info tab in

GENIUS TOOLS Starter App). Click Start.

Creo is started with the borrowed

licenses.
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4. Once Creo has been started completely, GENIUS TOOLS for Creo will automatically

borrow its licenses. If GENIUS TOOLS for Creo does not start, check in the PTC message

window whether the full startup of Creo is displayed.

Please note: If you click on Borrow (step 2) and then cancel the PTC borrow dialog

(step 3) you will have borrowed a GENIUS TOOLS license. 

Return licenses

To return borrowed Startup TOOLS licenses, select Return all borrowed GT licenses in the

user menu .

Display of borrowed licenses

For projects: projects with borrowed licenses can be recognized quickly in the main

window by the note on the right.

For applications: In the tooltip of the plane button in the footer you can see which GENIUS

TOOLS licenses have been borrowed and until when.

6.5.3  Configuration files

The Config tab shows the user which configuration files are used for configuring the

project (Config.pro blocks) and in which directories these files are stored as well the

additional applications (toolkit applications) used in the selected project. 

Configuration files can be 

– opened and edited by double clicking on them and 

– activated or deactivated for the selected project

if the user has been granted function access to do so. See Settings for GENIUS TOOLS

Starter App.

The tab opens by clicking on the  button.
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Your administrator defines whether users can deactivate the use of individual

configuration files, see chapter Granting function access rights.

Personal Config.pro file
Users have the option to edit their local, private Config.pro file and write it back to the

administration computer using the  upload button. 

The area Private Config.pros in the Config tab is visible if a file is located in the userdata

directory. Path specifications are made in the user settings dialog of the Creo Parametric

settings.

The Upload button is visible if the user has been given the function access right Can save

personal config file to server. 

Please note: Pause data synchronisation when editing a private config-pro file.
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6.5.4  Options

In the Options tab all single project options, e. g. for license extensions or additional

programs, can be activated , The tab can be opened with the arrow symbol, which will

become visible if some checkboxes cannot be displayed below the project. 

6.5.5  Customization.ui file

The file creo_parametric_customization.ui (short: customization.ui) contains the user-

specific settings for the graphical user interface of Creo. 

The UI tab  – which opens with the  button – displays the path to the customization.ui

file and allows for making a backup copy of it, if the user has the right to do so.

1. Graphical settings
Users can manage a UI configuration file on their own if it is stored in the userdata

directory and the user has write permissions for this directory. The userdata directory can
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be located in the caddepot of the administration computer, from where it is synchronized

to the user computer, or on the user computer, where it is not subject to synchronization.

(See also User-driven configuration).

2. Backing up user-specific UI settings
You can create a backup copy of the user-specific file customization.ui, which contains

settings for the user interface of Creo. To do so, click Backup customization.ui. To restore

the customization.ui from a backup copy, click Restore customization.ui . For more

information consult Backup mechanism with GENIUS TOOLS Starter App.

6.5.6  Project report

The project report – created by clicking on the  button –  is a separate file containing all

information about the selected project and the current user.

The information is grouped as follow: 

– General project details

– GENIUS TOOLS STARTER Network-settings

– GENIUS TOOLS Starter App

– Additional Environment Settings

– Synchronization

– Licensing

– Creo Settings

– Delete Creo configuration locally

– Write Creo configuration locally

– Windchill Settings

– Used Files

– Batch-files

– Config.sup

– Config.pro

– Customization.ui

– Dynamic Customization.ui

– Config.val

– Assigned rights

– Appendix

– All environment variables

– Generated config.sup

– Generated config.pro

– Generated config.val
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6.5.7  Warning and error tab

Warning 
The Warning tab will only be displayed if a project causes a warning. The application can

be started.

– Project folder not found: Check the project folder specification in GENIUS TOOLS

Project Configurator in the Projects menu item. 

Error
The error tab will only be displayed if a project cannot be started. It contains information

about the error. Errors can be: 

– Creo cannot be started

– No licenses are available

– Creo startkey is incorrect or does not exist

6.6  Projectdetails for Creo Elements/Direct Modeling

For projects in Creo Elements/Direct Modeling, you can select the language and open

three tabs.

– Info

– Licenses

– User Interface (UI)

Project details and language selection

6.7  Sidebar

The sidebar contains the following functions.
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 User

A picture can be displayed here. Store it in the format 100 x 130 px under the name of the

user in <caddepot>\<environment>\userdata\%USERNAME%\%USERNAME%.png.

 Refresh Projects (F5)

Refresh Projects reloads all project configurations from the administration computer in the

same way as when you restart the application.

 Message from Administrator (F4) 

There are new messages from your administrator when a red number is displayed on the

letter symbol. Messages that have been opened are displayed in gray color and can be

reread. Messages are saved as text files in the _Information directory, see also Sending

messages to the users.

 User menu

6.8  User menu

To access the user menu, click on the gear symbol  in the sidebar.

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the
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header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Debug Creo/Windchill

Switches Creo debug mode on. This mode processes the files logger.cfg.debug and

logger.cfg.bat. Settings for this are made by the administrator, see chapter Freely

configurable debug mode.

Help

Help (F1): Software help for GENIUS TOOLS Starter, which corresponds to this document.

Support: Contact details for the technical support of INNEO or a company-specific link

which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be

reached by email, telephone and with Teamviewer. 

Info (F12): Current GENIUS TOOLS Starter version. 

Open home

Opens the user directory in the file manager.

Open log file (F2)

Opens the log file that is written on each project start. The log file gts-starter-INNEO.log is

saved in the user directory of the client.

Please note: Please always find and check your log file before opening a call with the

support hotline. The log file is required for troubleshooting any issues.

Open sync log file (F3)

Opens the log file that is written by GENIUS TOOLS Starter App and  GENIUS TOOLS

Project Configurator at each synchronization. The log file gts-starter-INNEO-sync.log is

saved in the user directory of the client.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can

be adjusted to all sizes. 
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Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.

Project Configurator (F8)

Opens GENIUS TOOLS Project Configurator.

Please note: Your administrator defines whether you can access GENIUS TOOLS Project

Configurator via the access rights. If you are denied access, the item GENIUS TOOLS

Project Configurator is not displayed in the menu.

6.9  Footer

The footer contains the following information.

Data base mode

The state of the database is displayed in the footer:

 Database requires a subscription license. Projects cannot be started when working

with a permanent license.

 Database has been created with a permanent license. It can be accessed by both

permanent and subscription license.

License mode

The GENIUS TOOLS Starter App footer shows the current license mode by displaying an

icon.

 Full version 

 Full version. No free subscription license available, i. e. projects cannot be started.

 Borrowed license 

 Educational or home use 
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 Fail-safe mode (Fallback license, if license server is not available)

Please note:  A fail-safe license is available only after GENIUS TOOLS Starter has found

valid licenses on a license server during project validation. Projects are validated by the

command Refresh Projects  in the sidebar.

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization.

 Synchronization is active 

Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

 Synchronization inactive

The synchronization of toolkit applications is paused as long as Creo is running 

 Local operating environment

There is no synchronization; you work on a local directory 

License borrowed until:

This icon appears when licenses have been borrowed.

The synchronization status with the date and time of the last synchronization is displayed

in the middle area of the footer.

Running applications

If a supported desktop application is running, the application icon will be displayed in the

footer.

 Creo Parametric

 Creo Elements/Direct Modeling
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6.10  GENIUS TOOLS Starter App Config Analyzer

GENIUS TOOLS Starter Config Analyzer is a tool that allows you to view and edit

configuration files (in the Project information page) as well as to directly compare

configuration settings of two projects (in the Compare projects page)

You can access the Config Analyzer by clicking the Analyze button in the Config tab of

GENIUS TOOLS Starter App.

This button can be hidden by the administrator in GENIUS TOOLS Project Configurator

under User Rights > Function access > Can analyze project.

6.10.1  Project information

In the Project Information section  of the GENIUS TOOLS Starter App Config Analyzer,

you will see a list of all configuration and batch files used for the project, as well as their

location (column: Location). Configuration files can be located in the Standard, Unit or

Project  directories.

You can edit configuration files with GENIUS TOOLS Config Editor by clicking on the Edit

symbol (3). 

The analysis of the configuration files refers to the found weekly version of Creo.

User interface for project information

Search and sort configuration files
Search (1): Search for a file (at least three letters)
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Sort (2): Click on the following areas to sort the files by the size of the value (ascending or

descending)

– Lines (number of lines)

– Unknown: Config option not found in the Creo weekly version (i.e. does not exist or is

hidden) or value not found

– Default: Default value of the configuration option in the Creo weekly version

– Mapkeys: Number of mapkey definitions 

– Toolkit: Number of Toolkit applications

– Edit: opens GENIUS TOOLS Config Editor

6.10.2  Compare projects

The dialog Compare Projects  allows you to directly compare the configuration settings

of two projects. 

Select the projects from the drop-down menu (3). The projects available for selection are

those that you are allowed to open in GENIUS TOOLS Starter App.

Search (1) for a configuration option (at least three letters) or use the All, Equals and Not

Equals buttons to compare configuration options (2).

User interface for comparing projects
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7  GENIUS TOOLS Config Editor

7.1  Introduction

GENIUS TOOLS Config Editor allows you to analyze and edit Creo configuration files. 

The following functions are available:

– Display of config.pro files and config.sup files for each Creo Parametric version.

– Color coding for duplicate, hidden and unknown configuration options as well as

variables.

– Easy editing of configuration options through auto-completion on entry and display of

the possible values.

– Easy editing of GTS-Config.pro variables for creating company-specific project options

in GENIUS TOOLS Starter App.

– Batch mode for editing multiple files.

GENIUS TOOLS Config Editor is delivered with GENIUS TOOLS Starter and is available with

a subscription license. 

GENIUS TOOLS Starter has been an independent module of GENIUS TOOLS Startup

TOOLS since version 6.

7.2  Starting the program

You can open GENIUS TOOLS Config Editor from any user computer where GENIUS

TOOLS Starter is installed. The program can be started as follows:

1. in the Windows context menu,

2. with the EXE file,

3. in the project display of GENIUS TOOLS Starter App.

GENIUS TOOLS Config Editor behaves like other editing programs in that all open files are

opened the next time the program is started. A file can be dragged into the dialog

window of the editor by clicking on it.

1. Starting with Windows context menu
The line Open with GT Config Editor is added to the context menu by default during setup

and will be available after the first start via the EXE file or GENIUS TOOLS Starter App.
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The entry Register in Windows context menu can be disabled in the Config Editor user

menu.

2. Starting the EXE file
The file GTConfigEditor.exe is located in the tools folder, which is located in the caddepot

of the installation computer as well as in the cadpool of the user computer. Path:

cadpool/<working environment name>/tools/config-editor

3. Starting with GENIUS TOOLS Starter App
The programm GENIUS TOOLS Config Editor is included in GENIUS TOOLS Starter App

where it can be opened 

– by double-clicking on a configuration file in the Config tab (1) or

– via the edit function within the analysis program Config Analyzer (2).

Please note: Config Analyzer and Config Editor are features that require a

subscriptions license. Without a subscription license you can open a configuration file

with other editing programs.

1. Open in Config Tab 

– Open the Config Tab using the Config files button  in the info area of a project.

– Double-click on a configuration file in the Config tab.

2. Open in Config Analyzer analysis program

– In GENIUS TOOLS Starter App, open the Config Analyzer via the Analysis  button in

the Info area of a project.

Please note: The Analysis button can be hidden by the administrator in GENIUS

TOOLS Project Configurator under User Rights > Function Access > Can Analyze

Project.

– Click the Edit button in the last column of a configuration file.
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7.3  User interface

Select the Creo Parametric version and open the configuration file you want to edit. You

can compare multiple files by arranging them side by side in the window. (See Display of

files.)

The user interface of GENIUS TOOLS Config Editor is divided into the following sections. 

1. Sidebar with start dialog and batch mode and compare versions dialog

2. User menu

3. Selection of version

4. Command bar

5. Display of Confi.pro files with context menu

6. Information area
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7. Status bar

Select version (3)
The weekly versions start with a letter up to Creo main version 4. After that, the weekly

versions are digits of the main version.

  versus  

Command bar (4)
The command bar contains the following functions

– New file: Creates a new configuration file with the extension .pro.

– Open file: A file can also be dragged into the dialog window using its icon.

– Save: Saves the current file. (Strg + S).

– Save all files: Saves all files. (Strg + Shift + S).

– Save as: Opens the Windows file manager.

– Reload file and revert changes: Deletes the unsaved changes.

– Copy: Copies the selected text.

– Cut: Deletes the selected text and keeps it on the clipboard.

– Paste: Pastes the text from the clipboard.

– Delete: Deletes the selected text.

– Undo / Redo: Deletes or restores the last action.

– Increase / decrease font size: Decreases or increases the font size.

– Show / hide tabs: Shows or hides spaces, tabs and line breaks.

– Replace SUT variables: Replaces the GENIUS TOOLS Startup TOOLS (SUT) variables

with the new GENIUS TOOLS Starter (GTS) variables that came into use as of version 6

of Startup TOOLS. (Since then GENIUS TOOLS Starter is an independent module of

Startup TOOLS.)

Context menu
Open the context menu by right-clicking on the file name to get the following options:

– Close all

– Close all but this file

– Copy file path to the clipboard

– Open directory in Explorer
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Information area (6)
In the lower part of the main window configuration options with a note or a warning, i. e.

those colored in orange or red, are listed. You can thus get a quick overview of the

content of a config.pro file. 

Info area of the Config Editor

1. Duplicates / duplicates

Configuration options that are set two or more times. Here: in line: 13 and 14.

2. Default value

Configuration options in which the default value is set.

3. Unknown configuration options

Options will not be recognised as such

– if they do not exist, e. g. in case of incorrect spelling notation, or 

– if they are not known in the selected Creo version, e. g. the smooth_lines option exists

only since Creo version 5.
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4. Hidden configuration options

Options which are not officially supported by makers of Creo Parametric.

Status bar (7)
The status line contains the following information: 

– Number of configuration options with a warning. (Click on the red symbol to jump to

the next option.)

– Number of configuration options with a note. (Click on the orange symbol to jump to

the next option.)

– Line: Indicates the line in which the cursor is located.

– Column: Indicates the position in the line where the cursor is located.

– Length: Displays the number of all characters.

– Lines: Displays the number of all lines.

7.4  User menu

The user menu opens in the header bar with the gear button.

1. Language 

The language setting of the user interface can be changed between German and

English while the program is running. The setting is saved for the next start.

If the country setting of the operating system is German, GENIUS TOOLS Config Editor

will start in German. All other country settings will start in English.

2. Theme

The user interface of the software is offered in the color schemes light and dark. The

setting is saved for the next start.
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3. Search (Ctrl + F) 

Opens the input field for the search

4. License server

Opens the input dialog for the license server. 

Change here the license server that provides the license for GENIUS TOOLS Config

Editor in the notation 7766@localhost.

5. Creo versions

Opens the input window for selecting the Creo versions for which you want to view

configuration files. 

Please note: The databases for configuration options are available for all Creo

versions, meaning you can edit configuration files regardless of whether the Creo

version is installed on your computer. 

The databases of the enabled versions are loaded into the user directory

AppData\Roaming\INNEO\GENIUS_TOOLS\GENIUS TOOLS Config Editor.

During setup, the activated checkboxes show the Creo versions that are installed on

your computer. If no Creo version is found on the computer, all checkboxes are

activated.

6. Register in Windows context menu

Adds the command Open with GT Config Editor to the Windows context menu. This

entry is activated by default.

7. Help

Help (F1): Opens the help for GENIUS TOOLS Config Editor. The help corresponds to

this document.

Support: Opens the website of the technical support of Inneo Solutions GmbH.

Info (F12): Displays the license agreement of the current version of GENIUS TOOLS

Config Editor.

8. Reset Window Size

Restores the default size for the GENIUS TOOLS Config Editor dialog window. The

dialog window can be resized to any size.

9. Exit
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7.5  Display of configuration options

A configuration option defines a setting in Creo Parametric. 

Configuration options that are highlighted in color contain notes (orange) or warnings

(red) that are shown in the information area. 

For better readability GENIUS TOOLS Config Editor displays configuration options as

follows. 

Color code Description

accuracy_lower_bound Configuration option

1.0e-6 Numerical value

 yes Nonnumerical value (e. g. yes, medium)

$GTS_DATA Variable

– e. g. variable of Startup TOOLS (SUT) and GENIUS

TOOLS Starter (GTS)

! gts_display_name GTS-Config.pro variable

– contains information to create a company-specific

project option for GENIUS TOOLS Starter App

Configuration option with the default value

– is listed in the info area

Duplicates (multiple entries of a configuration

option)

– are listed in the information bar

– Please note: Duplicate options that can regularly

be entered several times in a config.pro file – such

as mapkey or search_path – are not marked in

orange.

Hidden configuration option

– are not officially supported by the Creo

manufacturer

– is listed in the info area

Unknown configuration option
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Color code Description

– due to incorrect spelling or because it is not

known in the selected Creo version

– is listed in the info area

Mapkey line is too long

– up to Creo version 4: max. 81 characters allowed

– from Creo version 4: max. 260 characters allowed

!changed 01/02/22 Comment

7.6  Display of files

You can display multiple files both one below the other and side by side, e. g. to compare

two configuration files.

Display of two files next to each other 

Procedure: Setting up the file display

– Change the position of a single file by clicking and dragging the file to the desired

location using the split star. 
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7.7  Editing config.pro files

Autocomplete

When entering a new configuration option, a list of the possible configuration options

opens.

Options when entering "dis".

Suggest function

When entering a value for a the configuration option, a list of all possible values opens.

Tooltip

Each configuration option is explained in a tooltip which contains

– the possible input values, 

– the default value and
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– a description of the option.

Edited file

Changes to a file are indicated with an asterisk.

7.8  Batch mode

In batch or batch mode , you can revise any number of Config.pro files. You can: 

– find files with hidden config options,

– find files that contain fixed paths,

– search and replace words,

– replace SUT variables with GTS variables. (This actions assigns the corresponding GTS

variables automatically.)

Batchmode dialog: Finding files with hidden options

Procedure

1. Drag the action (1) you want to perform to the processing list (2).

2. In the processing list click on the action and fill in the details.
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3. Under Settings (3) specify the folder where the Config.pro files are located. Activate

Recursive search to include files in all contained subfolders in the search. 

4. Click the arrow icon (4).

Result: You will see the executed actions and the found options and paths in the log area.

Show preview

For the actions Search and replace and Replace SUT variables, you can get a preview in an

extra window which shows all hits. You can disable individual hits and choose to apply or

cancel the replacement. With the option Next change you can jump to the next hit within a

file.

Preview for searching and replacing a value of a configuration option

7.9  Compare versions

In the menu item Compare versions  you can view the configuration options and the

default values that have changed from one version to another. 

Select a version (main plus subversion) on the left (1) and another version on the right (2)

and press the Compare button (3).

The following results are displayed:

– Configuration options whose default values have changed (4): The default values are

listed first for the older version and then for the newer version, regardless of how the

versions have been selected in the command bar.
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– Added options with default values (5).

– Removed options (6).

The information (hidden) refers to hidden configuration options.
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8.1  Start parameters

You can start GENIUS TOOLS Starter App with the following parameters.

Start parameter Description

-gts:admin Starts GENIUS TOOLS Project Configurator

-gts:appdata Redefines the path to the Appdata directory

-gts:debug Activates debug logging

-gts:expcfg Defines the location of the expcfg.bat file of the worker

-gts:debug Activates debug logging

-gts:home Sets the home directory. Example: D:

\gtstarter\cadpool\inneo\software\GTS.exe -gts:home=

%SystemDrive%\home\%USERDOMAIN%.%USERNAME%

\pro.creo3

-gts:lang Starts GENIUS TOOLS Starter App in a defined language

(de/en/it/fr)

-gts:L Sets Creo language

-gts:CL Set language for GENIUS TOOLS Starter

-gts:licDebug Activates debug logging for the license server (loud

alarm when license problems occur)

-gts:licServer Sets the license server 

-gts:licTimeout Defines the maximum waiting time to receive a license, in

milliseconds. Entries from 1000 to 60000. Default: 10000.

Setting is passed on to Creo by environment variable

GT_LIC_TIMEOUT .

-gts:networkTimeout Redefines the network timeout. Entries in milliseconds.

-gts:noChecksum Deactivates checksum tests during synchronization
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Start parameter Description

-gts:noProjectAutostart Prevents the project (gts:p) from being started

immediately

-gts:noSync Deactivates synchronization

-gts:p Starts a project and filters the project list

-gts:pui Filters the project list to a list of projects specified

separated by commas (-

gts:pui=pname1,pname2,pname3)

-gts:temp Redefines path to the Temp directory

-gts:worker Starts in Worker setting 

8.2  Environment variables

Created environment variables

GTS environment

variable

Description / example Old SUT

variable

GT_LIC_SERVER

GT_LIC_TIMEOUT

GTFC_ADMIN TBXADMIN

GTS_APPS_DIR Finds the selected, application-specific

directory for add-on applications. 

<Caddepot>\<operatingenvironment>\<a

pplication>\apps

(GTS_CFG_LW)

recommended instead:

GTS_ROOT_DIR

GTS:<Cadpool>\<operatingenvironment>

GTS: D:\gtstarter\cadpool\2017_latest

SUT: <DriveLetter>

SUT: P:

STOOLS_CFG_L

W

GTS_*_ESCAPED Variant of a variable that prevents the

variable from being erroneously being
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GTS environment

variable

Description / example Old SUT

variable

resolved, e.g. in mapkeys. (See explanation

in section below.)

GTS_CONFIGURATION_D

IR

Finds the selected, application specific

configuration directory.

<Caddepot>\<operatingenvironment>\<a

pplication>\configuration

GTS_COMPUTER_GROUP Name of computer group

GTS_DATA Finds the selected data package directory,

is from version 9.0 application specific: i. e.

in Creo Parametric it has been changed

from

<Caddepot>\<operatingenvironment>\dat

a\<companydata>

to 

<Caddepot>\<operatingenvironment>\<a

pplication>\data\<companydata>

SUTDATA

GTS_DATA_LIB

GTS_ENV_NAME         Name of operating environment.

GTS_EXECUTION_DIR Points to the directory which contains the

executed file (*.exe, *.bat, *.pdf).

GTS_MC SUTMC

GTS_NET_LW Name of the first network drive.

GTS_PLOT_CONFIG_DIR PLOT_CONFIG_

DIR

GTS_PLOT_FILE_DIR PLOT_FILE_DIR

GTS_PROEDATECODE SUT_PROEDATE

CODE

GTS_PROERELEASE SUT_PROERELEA

SE
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GTS environment

variable

Description / example Old SUT

variable

GTS_PROJECT_DIR Finds the selected project directory, from

version 9.0 application-specific. Path:

<Caddepot>\<operatingenvironment>\<a

pplication>\configuration\projects\<projec

tname> 

APPL_PROJECT_

DIR

GTS_PROJECT_DIR_NAME Name of project directory (until version 9.0

in GTS_PROJECT_DIR.)

GTS_PROJECT_NAME Name of current project SUT_PROJECT_N

AME

GTS_ROOT_DIR SUT_ROOT_DIR

GTS_SERVERONLY_DIR

GTS_SERVER_DIR

GTS_SYNC_LAST

GTS_SYNC_MODE

GTS_TEMP Points to the temp directory.

GTS_TRAIL_DIR TRAIL_DIR

GTS_UNIT_DIR

GTS_UNIT_DIR_NAME Name of the unit directory 

GTS_UNIT_NAME Name of unit

GTS_USER STOOLS_USER

GTS_USER_CONFIG_DIR USER_CONFIG_

DIR

GTS_USER_GROUP Name of user group

GTS_USER_LW Letter of user drive STOOLS_USER_L

W

GTS_USERLONG STOOLS_USER_L

ONG
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GTS environment

variable

Description / example Old SUT

variable

GTS_USERSHORT STOOLS_USER_S

HORT

GTS_VERSION

GTS_WCSRVNAME Windchill server name STOOLS_WCSRV

NAME

GTS_WCSRVURL Url of windchill server STOOLS_WCSRV

URL

GTS_WORKING_DIR Points to the working directory.

LANG LANG

Created environment variables: _ESCAPED variant
Since version 6.0.2.0 variables are resolved in configuration files. This means that mapkeys,

in which environment variables with path specifications are used, no longer worked.

Therefore new variants of environment variables were introduced, in which the variable is

extended with the extension _ESCAPED. This makes it possible to continue using variables

in mapkeys and other places where resolution is undesirable.  

All variables can be extended with _ESCAPED. In particular, the following variables are

required for use in Mapkeys: GTS_PLOT_CONFIG_DIR_ESCAPED,

GTS_SERVERONLY_DIR_ESCAPED, GTS_SERVER_DIR_ESCAPED, GTS_TRAIL_DIR_ESCAPED,

GTS_UNIT_DIR_ESCAPED, GTS_USER_CONFIG_DIR_ESCAPED.

Affected environment variables
PTC_WF_ROOT

Environment variable that overwrites the default location of the Creo directory. (WF

comes from “Wildfire”, name of the predecessor product of Creo.)

PTC_WF_CACHE

Environment variable that refers to additional cache space.

PTC_SESSION_LOG_PATH

PTC_SESSION_TRACEBACK_PATH

PTC_SESSION_TRAIL_PATH
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8.3  Regular expressions

Regular expressions can be used for names that create users and computers.

Character Description

\ Indicates the following character as a special or verbatim character. For

example “n” is corresponds to the character “n”. “\n” corresponds to a

line-break character. The sequence “\\” corresponds to “\”, “\(”

corresponds to “(”. 

^ Corresponds to the beginning of the input.

$ Corresponds to the end of the input.

* Corresponds to the proceeding character zero or multiple times. For

example “zo*” matches either “z” or “zoo”. 

+ Corresponds to the proceeding character one or multiple times. “zo+”

for example matches “zoo”, but does not match “z”.

? Corresponds to the proceeding character zero or one time. For

example “a?ve?“ matches the “ve” in “never”.

. Corresponds to all single characters except for a line-break character.

(Pattern) Matches Pattern and saves the equivalent. The compared substring

can be retrieved from the resulting matches listing using the elements

[0]...[n]. For comparing of characters put in parentheses ( ) use “\(” or

“\)”.

x|y Corresponds to either x or y. For example matches “l|red” either “l” or

“red”. “(l|r)ed” matches “led” or “red”.

{n} n is a positive integer. Corresponds to exactly n times. “o{2}” for

example does not match the “o” in “Robert” but the first two “o”s in

“Booooat”. 

{n,} n is a positive integer. Corresponds to at least n times. “o{2}” for

example does not match the “o” in “Robert” but all “o”s in “Booooat”.

“o{1,}” is equivalent to “o+”. “o{0,}” is equivalent to “o*”.
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Character Description

{n,m} m and n are positive integers. Corresponds to at least n and maximum

m times. For example “o{1,3}” matches the first three “o”s in

“Boooooat”. “o{0,1,}” is equivalent to “o?”.

[xyz] A group of characters. Corresponds to any of the included characters.

“[abc]” for example matches the “a” in “falling”.

[^xyz] A group of excluded characters. Corresponds to any character not

included. “[^abc]” for example matches the “f” in “falling”.

[a-z] A character range. Corresponds to any character in the specified range.

For example, “[a-z]” matches any lowercase alphabetic character in the

range from “a” to “z”.

[^m-z] An excluded range of characters. Corresponds to any character not

included in the specified range. “[m-z]” for example matches all

characters not included in the range from “m” to “z”.
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8.4  Startup TOOLS product development

Development of Startup TOOLS from an integrated to a modular product.
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Administration computer

Computer on which the administrative user has full write access to the Caddepot

directory in order to manage all data on the file system level.

Application computer, workstation

Computer on which the (Creo) user works. The application computer houses the

Cadpool directory, which contains the local operating environment.

Creo

Name of CAD software by PTC with the applications Creo Parametric (formerly

Pro/Engineer) ans Creo Elements/Direct (formerly CoCreate).

Creo startkey (also: PSF key, start command) 

Configured start command that opens Creo with one or several defined licenses or

license extensions. Stored as PSF file in PTC bin directory.

Cadpool

Directory on the application computer that contains the local operating environments.

The Cadpool directory is synchronized from the Caddepot.

Caddepot

Directory on the administration computer that contains the central operating

environment.

Client

Term for application computers for Startup TOOLS versions up to 2018.

Computer group

A defined group of configured Windows computers. Contains settings in which the

computers' configuration differs from the general system-wide configuration.

Conditional config.pro block

Config.pro block whose validity is restricted to condition(s) by one or more tag ID(s).

Notation: config_*.TAGID.pro

Configuration file

File which determines settings for a Creo application. There are four types of

configuration file: config.pro, customization.ui, config.sup and config.val.

Config.pro block

Configuration file which is read by GENIUS TOOLS Starter and assembled to form a

config.pro file for Creo. Contains Creo configuration options. Notation: config_*.pro, e. g.

config_sut_de_c5p_mapkeys.pro.
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Config.pro file (short: config.pro)

Most important Creo configuration file, defines user settings.

Config_*.pro file

See config.pro block

Config.sup file

Creo configuration file which contains settings that cannot be changed by the users, e.g.,

to ensure drawing standards.

Config.val file

Creo configuration file which contains validation settings for data import.

Customization.ui file

Creo configuration file which contains user interface customizations for a user.

Data directory

Main directory for all data related to an operating environment at <GTS-

OperatingEnv>\data.

Educational license

License for academic institutions.

Free tag ID

Textual marking in a config.pro block which restricts the file to the selection of a

combined project option.

GENIUS TOOLS

Family of software products by INNEO Solutions GmbH, including Startup TOOLS, Model

Processor, and freeware tools such as Purge.

GENIUS TOOLS for Creo

Component of the Startup TOOLS software product which contains functional

enhancements for Creo.

GENIUS TOOLS Environment Administrator

Stand-alone administrative tool. It is used to create and update work environments, edit

work environment properties and migrate from older versions of Startup TOOLS to

version 6 and later. GENIUS TOOLS Environment Administrator is located at ...

\installdepot\gtsa-latest\gtsa-exe.

GENIUS TOOLS License Manager

Administrative tools for managing Startup TOOLS licenses.

GENIUS TOOLS Project Configurator 

Administrative component of GENIUS TOOLS Starter for managing project

configurations and other properties of an operating environment. Open GENIUS TOOLS
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Project Configurator from the user menu of GENIUS TOOLS Starter App.

GENIUS TOOLS Starter

Software product consisting of the three components GENIUS TOOLS Project

Configurator, GENIUS TOOLS Starter App and GENIUS TOOLS Environment

Administrator.

GENIUS TOOLS Starter App 

Stand-alone component of GENIUS TOOLS Starter which lets users start configured Creo

projects. GENIUS TOOLS Starter app is located in each operating environment under 

...\caddepot\lokal\software\GTS.exe. 

GENIUS TOOLS Starter App Config Analyzer

Dialog box in GENIUS TOOLS Starter App, in which configuration settings of projects can

be analyzed and edited.

GENIUS TOOLS Starter Service

Method in GENIUS TOOLS Starter for faster data synchronization.

GTS

Abbreviation for GENIUS TOOLS Starter.

GTS.exe

Name of the executable file for GENIUS TOOLS Starter App.

GTSA.exe

Name of the executable file for GENIUS TOOLS Environment Administrator.

GTS Alias

User alias in GENIUS TOOLS Starter, for use in additional applications for Creo. The GTS

alias is available as an environment variable (%GTS_USER%) in Creo. If you do not specify

an alias, the Windows user name will be used.

GTS Alias Long

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

GTS-Config.pro variable

Variable that defines settings in a config.pro block to create a company-specific project

option for GENIUS TOOLS Starter App, e. g. ! gts_display_name

Home Use license

License for private use.
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Initial synchronization, initialization

First synchronization run which creates the Cadpool directory on the application

computer and synchronizes it with the Caddepot.

Installdepot

Subdirectory of the installation directory that contains the release and version setups

without settings and customizations. All setup programs unpack their data to this

directory.

Installation computer

Computer on which the setup programs are run. Typically, this is also the administration

computer.

LDAP (Lightweight Directory Access Protocol)

Network protocol for accessing a distributed directory service, e.g. the Windows user

management.

Mapkey

Macro defining a sequence of commands and functions which can be created in Creo to

simplify often-used procedures.

Mediadepot

Subdirectory of the installation directory. It contains setup files for different releases and

versions. All setup files will install or unpack to the Installdepot directory.

NAS (Network Attached Storage)

File server providing independent storage capacity in a network of computers.

NC (Numerical Control)

Computer-based applications for controlling machine tools and production lines.

Operating environment

Directory that contains all the data required for working with the desktop application.

This includes configuration data, libraries, templates and additional applications. The

operating environment also contains a database with all configured projects.

Operating environment, local

Operating environment on the application computer.

Organization tree

Structure of all units and subunits that specifies the call hierarchy. Created in GENIUS

TOOLS Project Configurator.

Perpetual license, permanent license

License that allows using a defined version of a software for an unlimited period of time.
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PDMLink

Component of the Windchill software product family that is used for product data

management.

Power Extensions

Application from INNEO for central administration of an operating environment for Creo

Elements/Direct projects.

PTC

The software company that develops Creo.

Project

See Starter project.

Project, blocked

Project that a user can neither access nor see in GENIUS TOOLS Starter App.

Projekt, hidden

Project that a user cannot see in GENIUS TOOLS Starter App, but is able to access it with

a transfer parameter.

Project, invalid

Project, for which a user has no valid license or required license extensions. Access to it

an display in GENIUS TOOLS Starter App can be configured.

Project directory

Directory for project data at <GTS-OperatingEnv>\configuration\projects\%

GTS_PROJECT_DIR%

Project option

Option to select on one or more projects in GENIUS TOOLS Starter App the Creo

language, Creo startkey as well as license extensions and add-on programs.

Role

Group of users or computers that are assigned access rights to projects and GENIUS

TOOLS Starter App functionality.

Satellite (also: synchronization or mirror server)

Computer or shared folder on a computer to which the state of one or more operating

environments of a central main server is mirrored. 

Searchmode directory

Subdirectory of the directory Standard, Units, Projects or Users which is included into the

call hierarchy for configuration files and batch files if Windchill is active.

Starter project

Project created in GENIUS TOOLS Project Configurator which contains company-specific
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data and additional applications and whose settings, such as license and project

specifications, can be made in different configuration levels.

Startup TOOLS

Software package that comprises the products GENIUS TOOLS Starter, GENIUS TOOLS

Library, GENIUS TOOLS Parameter, as well as Creo data packages and the GENIUS

TOOLS License Manager.

Startup TOOLS Server

Term for the administration computer for Startup TOOLS versions up to 2018.

STOOLS

Root directory name for Startup TOOLS versions up to 2018.

Subscription license

License that allows using a software for a limited period of time.

Subunit

Subordinate unit created by attaching a unit to another unit in the organization tree.

SUT

Abbreviation for Startup TOOLS.

Synchronization

Functionality that copies the data of an operating environment in the Caddepot

directory to the Cadpool directory on an application computer.

Tag ID

Textual marking in a config.pro block that is recognized by GENIUS TOOLS Starter. There

are tag IDs for units (unit tag ID) and for project options (free tag ID).

TeamViewer

Third-party software used by INNEO Solutions GmbH to provide remote support.

UDF (User-defined feature)

Template for repeatedly required Creo features.

Unit

Group of users who belong to a company department defined either geographically or

organizationally. Created in GENIUS TOOLS Project Configurator.

Unit directory

Directory in the units system directory that contains config.pro blocks and other files for a

unit.

Unit tag ID

Tag ID that is assigned to a unit in GENIUS TOOLS Project Configurator.
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Unit type

Individually defined category for units, for better representation in GENIUS TOOLS

Project Configurator.

User group

A defined group of configured Windows users. Contains settings in which the users'

configuration differs from the general system-wide configuration.

Windchill

Software product by PTC for managing product data over the entire product life cycle.
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10  Copyright

Copyright 2022 by:

INNEO Solutions GmbH

Rindelbacher Str. 42

73479 Ellwangen

Germany

This documentation is protected by copyright. All rights reserved.

Without prior written consent of an authorized representative of INNEO Solutions GmbH

it must not be copied, photocopied, reproduced, translated, communicated or converted

to electronic or machine readable form in whole or in part.

The unauthorized use of the documentation can lead to a claim for liquidated damages or

legal prosecution. INNEO Solutions GmbH does not accept liability for possible faulty
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